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Chapter 1

Settings Options

The Settings scroll list is displayed when you click the Settings tab of the 
Project window. If you select a setting in the Settings scroll list and make 
changes, the parameters remain the default settings until you they are 
changed again. To view or modify the parameters, double-click the setting.

This chapter describes the parameters for the following settings:

Audio Settings

Table 1  Audio Settings

Setting Description

Source Monitor Scrub Select the number of outgoing and incoming 
frames you hear as you scrub.

Record Monitor Scrub Select the number of outgoing and incoming 
frames you hear as you scrub.

Default Pan Select the way you want sound to pan between 
speakers.

Audio Tools Response To adjust the audio latency of your system, select a 
response speed that corresponds to the speed of 
your system.



 Appendix 1 Settings Options
Audio Project Settings

The following topics apply to adjusting audio project settings:

• Audio Projects Settings - Main Tab

• Audio Project Settings - Input Tab

• Audio Project Settings - Output Tab

• Audio Project Settings - Hardware Tab

Audio Projects Settings - Main Tab

Table 2 Audio Project Settings (Main Tab)

Setting Options Description

Sample Rate 32 kHz
44.1 kHz
48 kHz

Allows you to select audio rate settings for the entire 
system for playing and recording. The default sample 
rate for DV is 48 kHz.

The broadcast standard for most high-end video 
postproduction houses is 48 kHz. Select the rate based 
on the requirements of your facility.

For information on changing the sample rate for 
individual sequences and audio clips, see “Changing 
the Sample Rate for Sequences and Audio Clips” in 
the Help.

Audio File Format OMF (WAVE)
OMF (AIFF-C)

Select the file format for the audio: 

• OMF (WAVE) is compatible with Windows 
applications.

• OMF (AIFF-C) is compatible with many third-
party applications, including Pro Tools.

Select the AIFF-C format for all audio media when 
you need to transfer audio media files directly to a 
Pro Tools or an AudioVision® system for audio 
sweetening.
14



Audio Project Settings
Audio File Sample 
Size

16 Bit
24 Bit

Select this option to set the sample size used when 
you work with audio files:

• 16 Bit is for CD-quality audio.

• 24 Bit is for work with higher resolution audio.

DV Audio Pattern Unlocked Audio
Locked Audio

DV Audio Pattern works with all devices. However, 
because some devices check the DV Audio Pattern 
setting before transferring or recording, you should 
select the DV Audio Pattern setting expected by your 
device.

• Unlocked Audio allows some imprecision in the 
audio sample rate, with a variation of up to +/– 25 
audio samples per frame.

• Locked Audio keeps the audio clock locked 
precisely to the video clock, so exactly the same 
number of audio samples and video frames are 
recorded or transmitted in each cycle of the phase 
relationship.

Render Sample Rate 
Conversion Quality

High and Slow
Balanced 
Low and Fast

Allows you to set the conversion quality of all non-
real-time sample rate conversions.

Convert Sample 
Rates When Playing

Always
Never

Allows you to choose whether or not to perform the 
conversion rate:

• Never plays the segments not set at the sample 
rate as silence.

• Always makes the system attempt to perform a 
sample rate conversion on-the-fly. Although the 
resulting audio quality might not be useful for a 
finished project, it can be useful during an editing 
session since it prevents audio from playing back 
with silence.

For information on changing the sample rate for 
individual sequences and audio clips, see “Changing 
the Sample Rate” in the Help.

Table 2 Audio Project Settings (Main Tab) (Continued)

Setting Options Description
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 Appendix 1 Settings Options
Audio Project Settings - Input Tab

n The options that appear in this tab depend on your audio configuration 
and the audio hardware installed on your system. Your options might differ 
from those listed here.

Show Mismatched 
Sample Rates as 
Different Color

Yes
No

Allows you to identify a specific sample rate by color 
if you have a sequence with several different sample 
rates.

Real-Time Audio 
Dissolves

Disabled
Enabled

Allows you to play audio dissolves (also called 
crossfades) as real-time effects. Select Disable if you 
experience an audio performance delay on your 
system.

Dissolve Midpoint 
Attenuation

Const Power –3dB
Linear –6dB

Sets the method used for audio dissolves:

• Const Power –3dB uses constant power to 
maintain a consistent sound level through the 
midpoint of the dissolve.

• Linear –6dB uses a linear gradient to maintain a 
consistent amplitude through the midpoint of the 
dissolve.

Optical Connection ADAT
TOSLINK

Allows you to select an output for use with an optical 
connection.

Table 2 Audio Project Settings (Main Tab) (Continued)

Setting Options Description

Table 3 Audio Project Settings (Input Tab)

Setting Options Description

Input Gain Allows you to calibrate the volume of global audio 
input.
16



Audio Project Settings
Input Source ADAT
AES/EBU
DV
OHCI
RCA (–10dBu)
S/PDIF
TOSLINK
XLR (+4dBu)

Allows you to select the type of input. 

Passthrough Mix Tool Opens the Passthrough Mix tool, which allows you to 
adjust the mix of tracks for monitoring audio input.

Table 3 Audio Project Settings (Input Tab) (Continued)

Setting Options Description
17



 Appendix 1 Settings Options
Audio Project Settings - Output Tab

n The options that appear in this tab depend on your audio configuration 
and the audio hardware installed on your system. Your options might differ 
from those listed here.

Table 4 Audio Project Settings (Output Tab)

Setting Options Description

Output Gain Allows you to calibrate the volume of global audio 
output.

Master Volume Allows you to make global level adjustments for 
output. These adjustments affect levels for all output 
tracks to the speakers and to the record devices. 

Bypass panel Clip Gain
RT EQ
Auto Gain

Allows you to have the system ignore the volume 
settings established with the audio tools when playing 
back or recording a sequence:

• Clip Gain bypasses the volume settings in the 
Audio Mix tool.

• RT EQ bypasses all EQ effects set in the Audio 
EQ tool.

• Auto Gain bypasses all Automation Gain effects 
set in the Automation Gain tool.

These buttons function the same as the Bypass buttons 
in the audio tools.
18



Audio Project Settings
Mix Mode Selection 
Menu button

Stereo
Mono
Direct Out

Modifies the way that the system interprets audio 
values during playback:

• Stereo mixes the currently monitored audio tracks 
into a stereo pair.

• Mono pans all the currently monitored tracks to 
center. This mode also ignores pan effects.

• Direct Out maps tracks directly to up to eight 
channels of output. By default, Direct Out maps all 
audio tracks in numerical sequence to existing 
output channels. You can remap a track to any 
channel by clicking the Channel Assignment 
pop-up menu and selecting another channel.

Stereo Mix Tracks Mix To 1 & 2
Mix To 3 & 4
Mix To 5 & 6
Mix To 7 & 8

Allows you to customize the mix of tracks with Stereo 
selected in the Mix Mode Selection Menu button.

The system sends a stereo mix to the two channels you 
select. Material panned to the left will be sent to the 
odd channel, and material panned to the right will be 
sent to the even channel. The number of channels 
available depends on the audio output you select.

All or Timeline Track 
Maps

All
Timeline

Allows you to map the track and output channels:

• All allows you to choose between all available 
tracks.

• Timeline allows you to assign output channels to 
the tracks monitored in the Timeline.

Which Set of Track 
Maps

Grp 1
Grp 2
Grp 3

Allows you to select which set of output tracks to map 
to audio channels. Groups of tracks display in 
multiples of 8, up to the maximum of 24 available 
audio tracks.

Table 4 Audio Project Settings (Output Tab) (Continued)

Setting Options Description
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 Appendix 1 Settings Options
Audio Project Settings - Hardware Tab

The settings in this tab are for informational purposes only and list defaults 
set by the system, depending on your audio hardware and configuration.

Table 5 Audio Project Settings (Hardware Tab)

Setting Options Description

Card The type of audio card installed.

Peripheral The type of peripheral audio device (audio interface) 
attached to the system.

Slot # The slot where the audio card is located.

Sync Mode Sync is used for audio input and output to ensure the 
audio sample clock is always in sync with the video 
clock. This prevents long-term drift between audio and 
video. 

When you are working with video and digital audio 
simultaneously, set your digital audio equipment to the 
same video reference signal as your video equipment.

n Changing the audio input selection 
automatically selects the correct audio clock 
source for audio sync.

HW Calibration -14dBFS

-18dBFS

-20dBFS
20



Bin Settings
Bin Settings

Table 6 Bin Settings Options

Option Description

Auto-Save interval n minutes Specifies the length of time between attempts to auto-save project 
files. The default is 15 minutes.

To avoid interrupting an edit, the Avid system waits until the system is 
inactive before auto-saving. Use the option “Force Auto-Save at” to 
specify an interval at which the system interrupts an edit to make the 
auto-save.

Inactivity period n seconds Specifies the length of time the Avid system waits when the system is 
inactive before automatically saving the project files. The default is 0 
seconds.

Force Auto-Save at n minutes Specifies the maximum length of time between auto-saves. When the 
system reaches this time, it auto-saves the project files even if it must 
interrupt an edit to do so. The default is 30 minutes.

Maximum files in a project’s 
attic

Specifies the total number of files stored in the Avid Attic folder. 
When a bin is saved, the Avid system copies the current version of the 
bin to a special folder called the Avid Attic. The default is 30 files.

Keep more files if there are many editors working on the system. This 
ensures that all the bins are backed up.

Max versions of a file in the 
attic

Specifies the total number of single-bin copies stored in the Avid Attic 
folder. This setting prevents filling the Avid Attic with too many 
copies of one bin, at the risk of losing the others. The default is five 
copies.

Double-click loads object in Determines what happens when you double-click an object in the bin.

New Pop-up 
Monitor

Creates a new Source pop-up monitor and automatically loads the clip 
when you double-click an object in the bin.
21



 Appendix 1 Settings Options
Source or Record 
Monitor

• When you have the Composer monitor stretched into two 
monitors, loads the clip into the Source monitor or the sequence 
into the Record monitor.

• When you are using the single Composer monitor, loads the clip or 
sequence into the existing Source pop-up monitor.

Enable edit from bin (Splice, 
Overwrite)

Allows you to edit clips directly from a bin by selecting a clip and 
clicking the Splice-in or the Overwrite button.

Enable 
SuperBin

Enables the SuperBin and its functions. See”Conserving Screen Real 
Estate with the SuperBin” in the Help.

Table 6 Bin Settings Options (Continued)

Option Description
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Capture Settings
Capture Settings

Capture Settings: General Tab

Table 7 Capture Settings Options (General Tab)  

Option Description

Stop deck after capture Select this option if you want to stop the deck when the capture 
operation is complete.

Pause deck after capture Select this option if you want to pause the deck when the 
capture operation is complete.

Preroll Method Select one of four methods from the pop-up menu. For more 
information, see ”Selecting the Preroll Method” in the Help.

Force unique clip names Select this option if you want the Avid system to automatically 
assign a clip name based on the bin’s name and to make sure 
this name, or another name you select, is not already used by 
any other object in the bin.

Activate bin window after 
capture or logging

Select this option if you want the Avid system to change the 
focus from the Capture Tool window to a bin window after 
capturing or logging is complete. This allows you to 
immediately start working in the bin.

Space bar stops capture Select this option if you want to use the space bar to create clip 
names during the capturing process. When you press the space 
bar during a capture operation, the system stops capturing, 
creates a clip from the capture material, and places the clip in 
the active bin.

Capture across timecode breaks When this option is selected, the system captures sections of 
discontinuous timecode on a tape as separate clips.

Deselect this option to make the system stop capturing and 
report an error when it encounters a timecode break.
23



 Appendix 1 Settings Options
Capture Settings: Batch Tab

Latency for external timecode 
mode n frames

Use this setting to compensate for problems that could occur 
when capturing with external timecode, as described in 
”Capturing with External Timecode” in the Help.

If you notice that your captured media consistently starts on the 
wrong frame (usually one or two frames off), use this option to 
ensure that capturing starts on the correct frame. The option is 
deselected by default.

Capture a single video frame 
only

Select this option if you want the Avid editing application to 
capture a single frame of video from your clip. When you click 
the Record button, the Avid editing application captures the 
currently displayed frame.

Ask before discarding a 
canceled clip

Select this option if you want the Avid editing application to 
query whether to discard the canceled clip, keep it, or try again.

Ask for name when a new tape 
is seen

Select this option if you want the Avid editing application to 
query you for a name when it detects a new tape.

Pause deck while logging When this option is selected, the deck pauses after you set an 
OUT point while you log clips; this allows you time to type the 
name of the clip. See ”Logging Directly into a Bin” in the Help. 
Deselect this option to allow the camera or deck to continue 
playing after you set an OUT point.

Table 7 Capture Settings Options (General Tab) 

Option Description

Table 8 Capture Settings Options (Batch Tab)

Option Description

Optimize for disk space When this option is selected, the system captures only the 
exact amount of material in the master clips plus any 
additional handles. The tape pauses and prerolls 
independently for each master clip that is batch captured.
24



Capture Settings
Optimize for batch speed When this option is selected, the system speeds up batch 
capturing by allowing the deck to continue to roll forward 
between adjoining clips. To qualify for this operation, the 
two adjoining clips must meet the following criteria:

• There must be 5 seconds or less between the OUT point 
of the first clip and the IN point of the second clip.

• The two clips must have the same video resolution and 
the same audio rate.

n If you select this option, the system might occasionally 
capture more than is required.

Switch to emptiest drive if current 
drive is full

When this option is selected, the system switches to the 
target media storage drive with the most available space 
when the current target drive becomes full during batch 
capturing. The system switches before starting to capture the 
clip, based on the number of minutes in the clip. For 
complete instructions, see ”Batch Capturing Clips” in the 
Help.

If you do not select this option, capturing stops when a drive 
becomes full.

Rewind tape when finished When this option is selected, the system automatically 
rewinds tapes after batch capturing is finished.

Eject tape when finished When this option is selected, the tape ejects as soon as the 
last shot from that tape has been used. This adds to efficiency 
since you can do other tasks while the tape is being used and 
yet still be alerted at the moment the tape is no longer 
needed.

Log errors to the console and continue 
capturing

Select this option if you want the Avid editing application to 
continue capturing if an error occurs during the capture 
process.

Capture the tracks logged for each clip Select this option if you want the Avid editing application to 
capture the tracks logged for each clip.

Table 8 Capture Settings Options (Batch Tab) (Continued)

Option Description
25



 Appendix 1 Settings Options
Capture Settings: Edit Tab

Use the audio sample rate logged for 
each clip

Select this option if you want the Avid editing application to 
use the audio sample rate logged for each clip.

Use the audio sample size logged for 
each clip

Select this option if you want the Avid editing application to 
use the audio sample size logged for each clip.

Use the video compression logged for 
each clip

Select this option if you want the Avid editing application to 
use the video compression logged for each clip.

Table 8 Capture Settings Options (Batch Tab) (Continued)

Option Description

Table 9 Capture Settings Options (Edit Tab)

Option Description

Enable edit to timeline (splice, 
overwrite)

Select this option to display the Splice-in Edit and Overwrite 
Edit buttons in the Capture tool.

Handles Indicate the amount of footage you want to capture before and 
after the IN and OUT points of the clips (when capturing to 
the Timeline only).
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Capture Settings
Capture Settings: Media Files Tab

Table 10 Capture Settings Options (Media Files Tab)

Option Description

Capture to a single file, 2 GB limit When this option is selected, capturing stops when the media 
captured has taken up 2 gigabytes (GB) of storage space on the 
media drive.

Capture to multiple files When this option is selected, the system writes captured video or 
audio to multiple files across multiple drive partitions. Select this 
option for clips that might exceed the 2-GB file-size limit.

Maximum (default) capture time n 
minutes

When this option is selected, the system preallocates space on the 
drive partitions to accommodate the specified number of 
minutes. (The preallocation can take a long time.)

The system captures for only the specified number of minutes; be 
careful not to underestimate. The default is 30 minutes.

During capture, clip is updated in 
MediaManager

(Windows Only) When this option, also known as “chunking,” is 
selected, the media is sent in segments so that workgroup users 
can begin accessing and using the media as soon as possible. For 
more information, see the Avid Unity MediaManager Setup and 
User’s Guide.

n Do not select this option unless you are part of a 
workgroup environment.

Segment length n Select a segment size in minutes or select the maximum (2 GB).

Switch to emptiest drive 
when n minutes left

When this option is selected, the system switches to another 
storage drive when the specified amount of time remains.
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Correction Settings

Table 11 Capture Settings Options (DV Options Tab)

Option Suboption Description

DV Scene Extraction When this option is selected, you can automatically 
generate subclips and locators based on time-of-day 
(TOD) information contained in the DV video format. 
See ”DV Scene Extraction” in the Help.

Add Locators Creates locator marks where the TOD information 
breaks occur while capturing.

Create Subclips Creates subclips where the TOD information breaks 
occur while capturing.

Both Creates locators and subclips where the TOD 
information breaks occur while capturing.

Table 12 Correction Settings Options

Option Description

Saved Color Labels Select an item from the pop-up menu to control how custom colors are named 
in bins. For information on saving custom colors, see  “Assigning Colors to 
Bins” in the Help.

• None When selected, the system does not supply a name.

• RGB When selected, the system uses the 8-bit values for the red, green, and blue 
components as the name.

• Name When selected, the system uses the name from the standard HTML color 
scheme that most closely matches the color you are saving.
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• Name and RGB When selected, the system uses both the Name and the RGB information as the 
name. This is the default option.

Real Time Image 
Updating

When this option is selected, the image in the active monitor updates on-the-fly 
as you move controls in the Color Correction tool. This provides instant 
feedback on your adjustments, but the updating process might not always be 
smooth due to system processing limitations. This is the default option.

n You can switch the current setting for Real Time Image Updating on and 
off by pressing and holding the Alt key (Windows) or Option key 
(Macintosh). If Real Time Image Updating is on, pressing and holding 
the Alt key (Windows) or Option key (Macintosh) will turn updating off 
temporarily. If Real Time Image Updating is off, pressing and holding 
the Alt key (Windows) or Option key (Macintosh) will turn updating on 
temporarily.

Eyedropper 3 x 3 
Averaging

When this option is selected, the system calculates the color value to pick by 
averaging the values of a 3 x 3 sample of pixels centered on the eyedropper’s 
position. This is often useful for picking up a color accurately by sight because 
it compensates for shifts in color value from one pixel to another. When this 
option is deselected, the system selects the color value of the exact pixel at the 
eyedropper’s position.

Show Eyedropper Info When this option is selected, the numerical RGB values appear on the color 
swatches in the Color Match controls.

Table 12 Correction Settings Options (Continued)

Option Description

Table 13 Deck Configuration Options

Option Description

Configuration name Type a name for the configuration.

Add channel Click to add a new channel box. Opens the Channel dialog box.
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Deck Settings

Add deck Click to add a deck or DV device. Opens the Deck Settings dialog 
box.

Auto-configure With a deck or DV device already connected to the system, you can 
click Auto-configure to bypass the Deck Settings dialog box and 
automatically configure a deck or DV device with the default 
settings.

n Not all DV devices respond to the Auto-configure command. 
Due to this limitation, Auto-configure selects only the generic 
devices.

Verify configuration against 
actual decks

Select if you want the system to check the deck configuration 
against the devices physically connected to the system.

Table 13 Deck Configuration Options (Continued)

Option Description

Table 14 Deck Settings Options

Option Suboption Description

Name Type your custom name for the tape deck. The default name 
matches the deck type.

Description Enter notes about the deck.

Notes Displays configuration information, supplied by Avid, about the 
deck or DV device you have selected. Not all decks or devices 
include this information. You can supply your own information in 
the Description field, and then save the configuration.
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Device Click the Manufacturer pop-up menu, and select your device 
manufacturer. Click the Model pop-up menu, and select your 
device model. 

If your device does not appear in the list, click the Manufacturer 
pop-up menu, and select Generic, and click the Model pop-up 
menu, and select the type of device.

While you are capturing, if you continually see a message box that 
reads “Fail to find preroll,” click the Model pop-up menu, and 
select GenericDVBasicDevice-NTSC or GenericDVBasicDevice-
PAL

Address For VLXi use only (see your VLXi documentation). If you are 
using direct serial port deck control, this option is unavailable.

Preroll Specifies how many seconds the tape rolls before capturing or 
digital cut starts. The default is based on the type of videotape 
recorder (VTR).

Fast Cue Speeds up long searches if your decks can read timecode in fast 
forward or rewind mode. 

Switch to ff/rew  
(seconds): n

When this option is selected, the system switches to fast forward 
or rewind if the target timecode is beyond the specified number of 
seconds from your current location on the tape. 

By default, the deck switches to fast forward or rewind to reach a 
target timecode that is more than 60 seconds away.

If your deck shuttles very quickly, you can increase this number so 
that the system uses fast cue only for long searches.

Switch to 
Search 
(seconds): n

When this option is selected, the system switches out of fast 
forward or rewind when it is within the specified number of 
seconds of the target timecode. By default, the system switches to 
search mode when it is 60 seconds from the target timecode.

Table 14 Deck Settings Options (Continued)

Option Suboption Description
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Deck Preferences Settings

Table 15 Deck Preferences Options

Option Description

When the deck contains 
no tape Log as

Select the timecode format (Drop Frame or Non-drop Frame) for logging 
clips when no tape is in the deck. When a tape is in the deck, the system 
automatically uses the existing timecode format on the tape.

Allow assemble edit for 
digital cut

When this option is selected, you can use the assemble-edit features in the 
Digital Cut tool along with the assemble-editing capabilities of your 
record deck. Select this option to record frame-accurate digital cuts 
quickly and without striping entire tapes in advance. For more information 
about digital cuts and assemble editing, see  “Generating Output” in the 
Help.

Stop key pauses deck This option defines the function of the Stop key (space bar) on the 
keyboard. Select this option to map the space bar to the Pause button on 
the deck. Deselect this option to map the space bar to the Stop button. 

If the videotape heads are down in “Stop key pauses deck” mode, pressing 
the space bar brings up the heads and pauses the deck.

The Stop button in the Capture tool always stops the decks.

Shuttle holds speed When this option is selected, the Shuttle button continues shuttling at a 
constant speed instead of stopping when you release it. 

Stop any paused decks 
when quitting

When this option is selected, any paused decks are stopped when you quit 
the Avidapplication. Selecting this option saves wear on the deck heads.

Poll deck during digital 
cut

This option is selected by default. When it is selected, the Avid system 
checks the deck for the current timecode and displays it in the timecode 
window of the deck controller. If you see degraded image quality on your 
digital cut (particularly visible as noise during black), deselect this option 
and record the digital cut again. With the option deselected, the Record 
button does not flash and the timecode display in the deck controller is not 
updated for the duration of the digital cut.
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Export Settings

See the following topics:

• Export Settings Dialog Box Options

• Export Settings: Quick Time Reference Options

• Export Settings: Quick Time Movie Export Options

• Export Settings: QuickTime Movie Settings

• Export Settings: QuickTime Compression Settings

• Export Settings: DV Stream Options

• Export Settings: OMFI and AAF Options

• Export Settings: AVI Settings (Windows Only)

• Export Settings: AVI Video Compression Options (Windows Only)

• Export Settings: Audio Options

• Export Settings: Graphic Options

• Export Settings: Graphic Format Options

DV Capture Offset 
(frames) & Digital Cut 
Delay

Type the number of frames by which you want to offset while you record 
(capture). 

Override Recommended 
Digital Cut Delay

Select this option to set a digital cut delay. See ”Using DV Digital Cut 
Delay” in the Help.

Digital Cut Offset 
(frames)

Type the number of frames by which you want to delay the digital cut.

Table 15 Deck Preferences Options (Continued)

Option Description
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Export Settings Dialog Box Options

Table 16 Export Settings Dialog Box Options

Export As 
Option Description

OMFI 1.0
OMFI 2.0

Select one of these options to export a standard OMFI composition for transfer to a 
third-party workstation that supports OMFI. You can choose to export composition 
only, or embed the video and audio, or both. See ”Exporting Through OMF 
Interchange” in the Help.

AAF Select this option to create an Advanced Authoring Format (AAF) file.You can 
choose to export composition only, or embed the video and audio, or both. See 
”Exporting OMFI and AAF Files” in the Help.

QuickTime 
Reference

Select this option to create a QuickTime reference movie. A QuickTime reference 
movie contains pointers (links) to movie files. This is similar to exporting as 
composition only. See ”Exporting As a QuickTime Reference Movie” in the Help.

DV Stream Select this option to create a standard DV stream. The DV Stream format is often 
used for distribution on a CD-ROM or over the Web. Use this option when 
exporting video that will be combined or processed with other DV-formatted media. 
Requires a video track. See ”Exporting Video in DV Stream Format” in the Help.

QuickTime 
Movie

Select this option to create a self-contained QuickTime movie. See ”Exporting 
QuickTime Movies” in the Help.

n If you installed additional QuickTime Export formats, they appear in the pop-
up menu with tildes (~) before their names. This indicates they have not been 
qualified and are not supported by Avid.

AVI (Windows 
only)

Select this option to export an AVI file through the Avid Codec for AVI or other 
compression tool. For more information, see Table 23 on page 51.

Audio Select this option to export audio tracks in the WAVE format, SD2 (Macintosh 
only), or AIFF-C audio format. See ”Exporting Tracks As Audio Files” in the Help.
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Export Settings: Quick Time Reference Options

Graphic Select this option to export a single frame, a series of frames, or a file type that 
supports multiple frames as a graphic file. Select a file type from the pop-up menu. 
See “Exporting As a Graphic File” in the Help. For information about supported file 
types, see “File Format Specifications” in the Help.

Avid Log 
Exchange

Select this option to export the selected bin as a shot log file that complies with 
Avid Log Exchange (ALE) specifications. For information about Avid Log 
Exchange, see ”Converting Log Files with Avid Log Exchange (Macintosh)” in the 
Help.

n ALE and tab-delimited files include information for master clips and subclips 
only. Information for other objects, such as group clips, sequences, and 
precomputes, is not included.

Tab Delimited Select this option to export the selected bin as a shot log file in the form of a tab-
delimited ASCII text file.

Table 16 Export Settings Dialog Box Options (Continued)

Export As 
Option Description

Table 17 Export Settings Dialog Box 
(QuickTime Reference Options)

Option Description

Use Marks When this option is selected, the system uses current IN and OUT points 
in the selected clip or sequence to determine starting and ending frames 
for the export. To export the entire clip or sequence, deselect this option 
or mark the entire clip or sequence.

Use Enabled Tracks When this option is selected (default), the system uses tracks that are 
enabled in the Timeline. To export all the tracks in the sequence, deselect 
this option.
35



 Appendix 1 Settings Options
Flatten Video Tracks When this option is selected, the composition is exported as one video 
track. When this option is deselected, one QuickTime video track is 
generated for each video track in the composition, and you cannot select 
Fill Spaces with Black. Because most third-party applications do not 
understand multiple QuickTime video tracks, it is a good idea to select 
this option. This option is automatically selected if you selected the Fast 
Draft Defaults and the Digital Mastering Defaults options.

Fill Spaces with Black When this option is selected, blank spaces in video tracks are filled with 
black in the QuickTime reference movie. Because QuickTime reference 
movies do not recognize blank spaces, it is a good idea to select this 
option. When this option is deselected, a QuickTime reference movie 
might interpret spaces in the video track as gray or as the background of 
the player. This option is automatically selected if you selected the Fast 
Draft Defaults and Digital Mastering Defaults options.

Render All Video 
Effects

When this option is selected, all unrendered video effects, including 
matte keys and titles, are rendered before export. When this option is 
deselected, any unrendered effects are ignored. This option is 
automatically selected if you selected the Digital Mastering Defaults 
option.

Table 17 Export Settings Dialog Box 
(QuickTime Reference Options) (Continued)

Option Description
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Mixdown Audio Tracks When this option is selected, the audio tracks in the composition are 
mixed to stereo files created at the same location as the movie. When this 
option is deselected, the Quick Time Reference movie references the 
original audio media. This option is selected automatically if you select 
the Digital Mastering Defaults option.

If you select the Premix Audio Track option, you can also select an audio 
format. Select the format that is supported by the application into which 
you will be importing the QuickTime reference movie.

• WAVE: Select this option to export audio tracks in the WAVE format 
(.WAV file name extension). Nearly all Windows applications that 
support sound use WAVE files. QuickTime also supports the WAVE 
format.

• AIFF-C: Select this option to export audio tracks in the industry-
standard AIFF-C format, which is compatible with many third-party 
sound editing and multimedia applications.

• You can also select an Audio sample rate and Audio sample size.

Fast Draft Defaults Select this option for a faster export. This option automatically selects 
Flatten Video Tracks and Fill Spaces with Black. It automatically 
deselects Render All Video Effects and Premix Audio Tracks.

Digital Mastering 
Defaults

Select this option to render all video effects and to premix audio tracks 
before exporting the file. This option automatically selects Flatten Video 
Tracks, Fill Spaces with Black, Render All Video Effects, and Premix 
Audio Tracks.

Use Network Media 
References

When this option is selected, the exported movie uses the machine and 
drive share name of the media drive in the QuickTime reference movie 
instead of a drive letter. Select this option when the media files 
referenced by the movie are accessed remotely over the network. If the 
media files are stored on the same drive as the QuickTime reference 
movie, you do not need to select this option. When this option is 
deselected, you cannot select Add Shares for Media Drives.

Table 17 Export Settings Dialog Box 
(QuickTime Reference Options) (Continued)

Option Description
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Add Shares for Media 
Drives

When this option is selected, the system creates a new drive share for 
referenced media files stored on unshared network drives. The drive 
share is hidden; that is, other users do not see the shared drive when 
browsing your computer. You do not need to select this option when 
media is stored on the same drive as the QuickTime reference movie.

Use Avid DV Codec Deselect this option when you are working in a cooperative environment 
where one or more non-Avid systems also have access to the media. This 
option is selected by default. Select this option if the non-Avid systems 
have the Avid DV Codec.

Pixel Aspect Ratio The pixel aspect ratio allows you to apply a scaling to the video: square, 
4:3 non-square, or 16:9 non-square. The pixel aspect ratio allows you to 
control the display format without modifying the source file. 

This feature creates metadata — additional data that is stored with the 
QuickTime movie. Some applications, such as the QuickTime Player and 
Avid ePublisher, can interpret this metadata and scale the image at 
display time.

Pixel aspect ratio is useful for QuickTime reference movies because you 
do not modify the source files of referenced movies. For example, if your 
source movies are stored at the standard 720 x 486 for NTSC (720 x 576 
for PAL), you can create two different QuickTime reference movies that 
use the same referenced source files — one that uses 4:3 and another that 
uses 16:9.

Table 17 Export Settings Dialog Box 
(QuickTime Reference Options) (Continued)

Option Description
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Export Settings: Quick Time Movie Export Options

Table 18 QuickTime Movie Export Options

Option Suboption Description

Use Marks When you select this option, the system uses current IN and 
OUT points in the selected clip or sequence to determine 
starting and ending frames for the export. To export the 
entire clip or sequence, deselect this option.

Use Enabled 
Tracks

When you select this option, the system exports only the 
currently enabled tracks for a selected sequence or clip. To 
export all tracks in the sequence, deselect this option.

Same as Source When you select this option, the system copies the media 
files directly with no resolution change. This method is fast 
and creates output that uses the same quality as your source 
files. Selecting Same as Source is the best method to use if 
you plan to process the video on another system, using a 
third-party application like After Effects® or media cleaner®.

Use Avid DV 
Codec

Deselect this option when you are working in a cooperative 
environment where one or more non-Avid systems also have 
access to the media. This option is selected by default.

Custom When you select this option, the system decompresses the 
files, processes them, and compresses the files at the 
requested resolution. This method is slower and often loses 
quality. You should only use the Custom option if you have 
to directly export a clip or sequence in a particular file 
format.

Format Options Click the Format Options button to open the Movie Settings 
dialog box. For more information, see ”Selecting QuickTime 
Movie Format Options” in the Help.

Video and Audio Select this option if you want to export both the audio and 
video. 
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Video Only Select this option if you want to export only the video. For 
example, use this option if you want to add effects in a third-
party application or to use only the video in a multimedia 
project.

Audio Only Select this option to export only the audio. For example, use 
this option if you want to use or enhance audio in a third-
party application or you want to use the audio in a 
multimedia project.

Video Format Width x Height Select this option to set the width of the clip.

• Size to Fit: This option sizes to fit the specified width 
and height. You can type in values or select from the 
predefined values in the Fast menu.

n The values in the Fast menu suggest a typical use for 
each size. For example, 320 x 240 (Internet video, 
large).

• Crop/Pad: This option instructs the system not to scale 
or resize the frames. If necessary, it adds black lines to 
the top and bottom of the frame to achieve the correct 
size.

Color Levels Select this option to set the color to RGB or ITU-R 601.

Table 18 QuickTime Movie Export Options (Continued)

Option Suboption Description
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File Field Order These options allow you to select the field that is the upper 
field during export. For 24p or 25p projects, these options do 
not appear; all fields are automatically exported as 
progressive (still) frames.

• Odd (Upper Field First): Select this option if you are in 
a PAL project. In forming the export frame, Field 1 
becomes the upper field, that is, Field 1's lines become 
the odd-numbered lines in the frame (counted starting 
from 1). Field 2's lines become the even-numbered lines.

• Even (Lower Field First): Select this option if you are in 
an NTSC project. In forming the export frame, Field 1 
becomes the lower field, that is, Field 1's lines become 
the even-numbered lines in the frame. Field 2's lines 
become the odd-numbered lines.

• Single Field: Select this option if you want the output file 
to consist of only Field 1. In this case, the single field of 
243 lines for NTSC (288 lines for PAL) is resized to fit 
the frame as specified in the width and height selection.

Create Preview Select this option if you want to create a preview of the 
QuickTime movie.

Pixel Aspect Ratio The pixel aspect ratio allows you to apply a scaling to the 
video: square, 4:3 non-square, or 16:9 non-square. The pixel 
aspect ratio allows you to control the display format without 
modifying the source file. 

This feature creates metadata — additional data that is stored 
with the QuickTime movie. Some applications, such as the 
QuickTime Player, can interpret this metadata and scale the 
image at display time.

Pixel aspect ratio is useful for the Same as Source option 
because that option also preserves the original format.

Table 18 QuickTime Movie Export Options (Continued)

Option Suboption Description
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Export Settings: QuickTime Movie Settings

Table 19 QuickTime Movie Settings

Option Suboption Description

Video 

Settings Compression Settings See ”Selecting QuickTime Movie Format Options” in 
the Help.

Filter Choose Video Filter Allows you to apply a single effect filter during an 
export.

Size Export Size Settings QuickTime allows you to set a size, but Avid 
recommends you set the size in the Width and Height 
text boxes of the Export Settings dialog box. Both 
settings have the same effect, and the QuickTime size 
setting overrides the Avid size setting.

Sound

Settings Compressor Allows you to select a sound compression setting for 
your export, along with other options.

Prepare for 
Internet 
Streaming

Fast Start Allows a movie to begin playing over the Internet 
without downloading the entire movie first. This method 
of playing movies over the Internet is referred to as 
progressive download or HTTP streaming. It does not 
require a streaming video server.

Fast Start - 
Compressed header

A better choice for progressive downloading. This 
option works the same as Fast Start (see previous entry), 
but compresses the header information. The header is the 
portion of the file that allows the movie to start playing 
before the entire movie is downloaded. Compressing the 
header allows it to download faster. This is important for 
large movies (movies that are longer than several 
minutes).
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Hinted Streaming Select this option if you are putting the exported file on a 
streaming video server. The file does not stream without 
a hint track for each track in the movie. The hint tracks 
allow the streaming video server to split the file into 
packets for the streaming.

A file with hinted streaming also plays as a progressive 
download. However, it will probably play more slowly 
than a Fast Start movie because it contains additional 
information and is therefore larger.

For additional options, click Track Hinter Settings. The 
RTP (Real Time Protocol) Track Settings dialog box 
opens. For more information, see QuickTime Help at:

www.apple.com/quicktime/tools_tips/tutorials/
hinttracks.html

Table 19 QuickTime Movie Settings (Continued)

Option Suboption Description

Table 20 QuickTime Compression Settings

Format 
Options Suboption Description

Compressor Animation For high-quality, lossless compression (in which no picture 
information is lost). 

Uses a run-length-encoded (RLE) scheme to encode each pixel, 
resulting in a file that is 70% to 95% the size of the 
uncompressed file. 

At maximum quality, this is a lossless compression (in which 
no picture information is lost). See the description of the 
Quality option in this table.
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Avid DV For compression compatible with Avid Xpress DV and Avid 
NewsCutter® products or with Avid Meridien products with the 
DV/MPEG option. Allows fast import.

Avid Meridien 
Compressed 

For compression compatible with Avid Meridien products. 
Allows fast import. See ”Using Avid Codecs for QuickTime” in 
the Help.

Avid Meridien 
Uncompressed

For 1:1 resolution used in Avid Meridien products. Allows fast 
import. See ”Using Avid Codecs for QuickTime” in the Help.

n For export at the same resolution as your current clips, 
select Same as Source instead of Custom. See ”Exporting 
QuickTime Movies” in the Help.

Avid ABVB 
NuVista 
(Windows only)

For backward compatibility with systems using AVRs.

BMP For internal encoding of individual frames as BMP (Windows 
native bitmap format) files.

Cinepak For export at low resolution where high quality is not an issue, 
such as presentations or educational uses, or for small-screen-
size playback from CD-ROM or hard drive. Uses compression 
algorithm optimized for CD-ROM playback.

Component 
Video

For high-quality, lossless compression (in which no picture 
information is lost). Uses the same algorithm as the Animation 
method but saves the file in YUV RLE format, which separates 
the luminance from the chrominance. All QuickTime 
applications can read this format, but only some can write to 
this format.

DV-NTSC
DVC PRO-PAL
DV-PAL

For storing original or edited DV (digital video) footage in 
QuickTime files. DV-NTSC and DVC PRO-PAL do 4:1:1 
chroma sampling; DV-PAL does 4:2:0 chroma sampling.

Table 20 QuickTime Compression Settings (Continued)

Format 
Options Suboption Description
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Graphics For export at low resolution where high quality is not an issue, 
such as presentations or educational uses, or for small-screen-
size playback from CD-ROM or hard drive. Uses a limited 
color palette version (16 colors) of Animation compression.

H.261 For low-quality video conferencing.

H.263 For video conferencing. Optimized for low data rates and low 
motion.

Intel Indeo 
Video 4.4 
(Windows only)

For export at low resolution where high quality is not an issue, 
such as presentations or educational uses, or for small-screen-
size playback from CD-ROM or hard drive. Files do not export 
at 720 x 540 and 720 x 486 frame sizes, even though these sizes 
are listed.

Motion JPEG A For medium-quality, lossy compression (in which some picture 
information is lost) requiring much storage space and 
additional hardware support for real-time playback.

Motion JPEG (M-JPEG) is a variant of the ISO JPEG 
specification for use in digital video. Considered the standard 
for Motion JPEG, format A is supported by chips from Zoran 
Corporation and C-Cubed, Inc.

Motion JPEG B For medium-quality, lossy compression (in which some picture 
information is lost) requiring much storage space and 
additional hardware support for real-time playback.

Motion JPEG (M-JPEG) is a variant of the ISO JPEG 
specification for use in digital video. Format B cannot use the 
markers that ISO JPEG and format A do; supported by chips 
from LSI Logic Corporation.

None Does not compress the file; results in very large files.

Table 20 QuickTime Compression Settings (Continued)

Format 
Options Suboption Description
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Photo - JPEG For medium-quality, lossy compression (in which some picture 
information is lost) requiring moderate storage space and data 
throughput on playback. 

Uses the Joint Photographic Experts Group (JPEG) algorithm 
for image compression; results in files that are 20% to 30% the 
size of the uncompressed files. Some data is lost during 
compression, and the export process takes longer to complete 
(typically six times longer than the Animation compression, for 
example).

Planar RGB For high-quality, lossless compression (in which no picture 
information is lost). Results in large files. 

Encodes each image plane separately, using a run-length-
encoded (RLE) scheme. Used primarily to support Photoshop 
files, which are usually stored using a planar run-length 
algorithm.

PNG Portable Network Graphics, used to replace GIFSM as a bitmap 
still-image format for newer Internet browsers.

Sorenson Video For medium-quality, lossy compression (in which some picture 
information is lost) at a low data rate and low storage 
requirements. This codec is particularly suited for Web or CD-
ROM delivery.

Sorenson 
Video 3

An improved version of the Sorenson Video codec. Movies 
created with this codec require the QuickTime 5 viewer.

TGA Saves exported file in TARGA® format.

TIFF Tagged Image Format, a cross-platform bitmap still-image 
format, used often in pre-press production.

Video For export at low resolution where high quality is not an issue, 
such as presentations or educational uses, or for small-screen-
size playback from CD-ROM or hard drive.

Table 20 QuickTime Compression Settings (Continued)

Format 
Options Suboption Description
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Colors Select the colors that you want included in the exported file. 
The selections vary according to the codec you select. Some 
codecs have only one color setting.

If you select the Sorenson codec, Millions of Colors is selected 
automatically.

Do not select the option Millions of Colors +. This option 
creates an alpha channel that is not used for export from your 
Avid system. 

If you use one of the Avid Codecs for QuickTime with other 
applications that support alpha channels, you can select the 
Millions of Colors + option to create an alpha channel that can 
be imported into your Avid system.

Quality Drag this slider to adjust the image quality for the exported file. 
The selections vary according to the codec you select. Some 
codecs have only one Quality setting. 

This slider does not adjust quality for the Avid Codecs for 
QuickTime.

If you select Avid Meridien Compressed or Uncompressed, a 
dialog box opens, allowing you to select a resolution.

Motion Frames per 
second

Select a frame rate from the pop-up menu. Select 30 to 
maintain full-motion video/animation. A frame rate of 29.97 
conforms to NTSC video frame-rate standards. Select 25 
for PAL.

Key frame every 
n frames

Use this option to have the system use keyframes as a reference 
for subsequent frames. Enter a numeric value to specify the 
frequency of the keyframes.

Limit data rate to 
n KBytes/sec

Allows you to specify the target data rate for the compressed 
movie.

Table 20 QuickTime Compression Settings (Continued)

Format 
Options Suboption Description
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 Appendix 1 Settings Options
Export Settings: DV Stream Options

Table 21 Export Settings Dialog Box 
(DV Stream Options)

Option Description

Use Marks When you select this option, the system uses current IN and OUT points in the 
selected clip or sequence to determine starting and ending frames for the export. 
To export the entire clip or sequence, deselect this option.

Use Enabled 
Tracks

When this option is selected (default), the system uses tracks that are enabled in 
the Timeline. To export the entire clip or sequence, deselect this option.

Format Options Click this button to select a video format and an audio format for export. 

Color Levels Select this option to set color to RGB or ITU-R 601.

File Field Order These options allow you to select the field that is the upper field during export. 
For 24p or 25p projects, these options do not appear; all fields are automatically 
exported as progressive (still) frames.

• Odd (Upper Field First): Select this option if you are in a PAL project. In 
forming the export frame, Field 1 becomes the upper field, that is, Field 1's 
lines become the odd-numbered lines in the frame (counted starting from 1). 
Field 2's lines become the even-numbered lines.

• Even (Lower Field First): Select this option if you are in an NTSC project. 
In forming the export frame, Field 1 becomes the lower field, that is, Field 1's 
lines become the even-numbered lines in the frame. Field 2's lines become 
the odd-numbered lines.

• Single Field: Select this option if you want the output file to consist of only 
Field 1. In this case, the single field of 243 lines for NTSC (288 lines for 
PAL) is resized to fit the frame as specified in the width and height selection.
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Export Settings: OMFI and AAF Options

Table 22 Export Settings Dialog Box 
(OMFI and AAF Settings Options)

Option Suboption Description

Export As: OMF 1.0 Select this option if the application to which you are exporting 
does not support OMFI Version 2.0.

OMF 2.0 Select this option if the application to which you are exporting 
supports OMFI Version 2.0. If you are not sure, select 
OMF 1.0.

AAF Select this option if the application to which you are exporting 
supports AAF.

Include All Video 
Tracks in 
Sequence

Select this option to include all video tracks from the 
sequence in the OMFI or the AAF file. The Video Details tab 
appears.

Include All Audio 
Tracks in 
Sequence

Select this option to include all audio tracks from the 
sequence in the OMFI or the AAF file. The Audio Details tab 
appears.

The following options appear in both the Video Details tab and the Audio Details tab:

Export Method: Link to Current 
Media

Select this option when you want to export an OMFI or an 
AAF composition with links to the media in its current 
location. Media is not embedded in the file.

n This may also be referred to as Composition Only.

Copy Media and 
Link to Copied 
Media

Select this option when you want to copy media to another 
drive and export an OMFI or an AAF composition with links 
to the copied media. 

Consolidate and 
Link to 
Consolidated 
Media

Select this option when you want to export an OMFI or an 
AAF composition with links to media that you have 
consolidated. For more information about consolidating, see 
”Consolidating Media” in the Help.
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Embed Media Select this option to include (embed) video or audio media in 
the OMFI or the AAF file.

Consolidate and 
Embed Media 

Select this option to first consolidate, then embed media in the 
OMFI or the AAF file. Select the drive from the Target Drives 
list. The default handle length is 60 frames. If you want to 
change the default, type the length of the handles, in frames. 
For more information about consolidating, see ”Consolidating 
Media” in the Help.

Destination 
Folder:

Set Click Set to select the drive and folder to which you want to 
copy the media files.

Target Drive for 
Consolidate:

Select the drive where you want to create the consolidated 
media files. 

Handle Length: nn 
Frames

Enter the number of frames you want to use as handles for 
consolidated clips. Handles refer to material outside the IN 
and OUT points and are used for dissolves and trims with the 
new, shorter master clips. The default is 60. 

The following options appear in the Audio Details tab only:

Include Rendered 
Audio Effects

Select this option to render audio effects during export.

Convert Audio 
File Format to:

Project rate, 
32 kHz, 44.1 kHz, 
or 48 kHz

Select this option if your sequence has a mix of sample rates 
and you need to create a single sample rate. (You set the 
project rate in the Audio Project Settings window. For more 
information see ”Adjusting Audio Project Settings” in the 
Help.) You can also use this option to change the sample rate 
if the application to which you are exporting does not support 
the current sample rate.

Table 22 Export Settings Dialog Box 
(OMFI and AAF Settings Options) (Continued)

Option Suboption Description
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Export Settings
Export Settings: AVI Settings (Windows Only)

Convert Audio 
File Format to:

WAVE

If your sequence has a mix of audio file formats, and you want 
to embed media, you must choose a single audio file format. 
Audio files are converted to this format during export. This 
choice is optional if you want to consolidate and link media. 

Select WAVE (.WAV file name extension) to link to or 
embed audio tracks in the WAVE format. Nearly all Windows 
applications that support sound use WAVE files. QuickTime 
also supports the WAVE format.

AIFF-C Select AIFF-C to link to or embed audio tracks in the 
industry-standard AIFF-C format. Note that your Avid system 
does not compress audio media. 

SD II 
(Macintosh only)

Select SD II to link to audio tracks in the SD II 
(Sound Designer II) format, for export to AudioVision or 
another product that supports the SD II format. SD II audio 
media cannot be embedded in an OMFI or an AAF file. The 
converted files are located in a folder labeled Exported Audio 
Media at the top level of the drive with the most 
available space. 

Table 22 Export Settings Dialog Box 
(OMFI and AAF Settings Options) (Continued)

Option Suboption Description

Table 23 Export Settings Dialog Box 
(AVI Settings Options)

Option Suboption Description

Use Marks When this option is selected, the system uses current IN and 
OUT points in the selected clip or sequence to determine 
starting and ending frames for the export. To export the entire 
clip or sequence, deselect this option.
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Use Enabled 
Tracks

When this option is selected, the system exports only the 
currently enabled tracks for a selected sequence or clip. To 
export all tracks in the sequence, deselect this option.

Video and Audio Select this option if you want to export both the audio and the 
video.

Video Only Select this option if you want to export only the video.

Audio Only Select this option if you want to export only the audio. For 
example, use this option if you want to use or enhance audio in 
a third-party application or use the audio in a multimedia 
project.

Video 
Format

Codec Options When you click this button, the Video Compression dialog box 
opens. For more information, see Table 24 on page 54.

Width x Height This option allows you to set the width and height of the clip. 
Click the Fast Menu button, and select from a list of standard 
dimensions.

• Scale to Fit: This option sizes to fit the specified width and 
height.

• Crop/Pad: Crop/Pad never scales or resizes frames. If 
necessary, the system adds black lines to the top and bottom 
to achieve the correct size. 

Color Levels This option allows you to set color to RGB or ITU-R 601.

FPS This option sets the frame-per-second (fps) rate for AVI export.

Table 23 Export Settings Dialog Box 
(AVI Settings Options) (Continued)

Option Suboption Description
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File Field Order These options allow you to choose the field that will be the 
upper field during export. For 24p or 25p projects, these options 
do not appear; all fields are automatically exported as 
progressive (still) frames.

• Odd (Upper Field First): Select this option if you are in a 
PAL project. In forming the export frame, Field 1 becomes 
the upper field, that is, Field 1's lines become the odd-
numbered lines in the frame (counted starting from 1). 
Field 2's lines become the even-numbered lines.

• Even (Lower Field First): Select this option if you are in 
an NTSC project. In forming the export frame, Field 1 
becomes the lower field, that is, Field 1's lines become the 
even-numbered lines in the frame. Field 2's lines become 
the odd-numbered lines.

• Single Field: Select this option if you want the output file to 
consist of only Field 1. In this case, the single field of 243 
lines for NTSC (288 lines for PAL) is resized to fit the 
frame as specified in the width and height selection.

Audio 
Format 

Mono

Stereo

Exports audio to a single channel.

Exports audio to two channels.

Sample Rate Select this option to select the sample rate.

• Project Rate: The native rate of the chosen audio media 
(44.1 kHz or 48 kHz).

• 22.050 kHz: Half the sample rate of 44.1-kHz media.

• 11.025 kHz: One quarter the sample rate of 44.1-kHz 
media.

Table 23 Export Settings Dialog Box 
(AVI Settings Options) (Continued)

Option Suboption Description
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 Appendix 1 Settings Options
Export Settings: AVI Video Compression Options (Windows 
Only)

Sample Size Select this option to select the sample size.

• 16 bit: When this option is selected, the system exports a 
16-bit audio sample size (currently the industry-standard bit 
rate for audio).

• 8 bit: When this option is selected, the system exports an 8-
bit audio sample size for use in third-party systems that do 
not support 16-bit. This option is also used to minimize the 
data throughput requirements (for example, to improve 
playback in multimedia projects).

Table 23 Export Settings Dialog Box 
(AVI Settings Options) (Continued)

Option Suboption Description

Table 24 AVI Video Compression Dialog Box 
Options

Option Suboption Description

Compressor Cinepak Codec 
by Radius

For export at low resolution where high quality is not an issue, 
such as presentations or educational uses, or for small-screen-
size playback from CD-ROM or hard drive. This codec uses a 
compression algorithm optimized for CD-ROM playback.

Click Configure to open the Cinepak for Windows 32 
configuration dialog box. You can then choose to compress to 
color or to black and white.

Microsoft Video 1 Use this option when you create files that will play with Video 
for Windows.

Click Configure to open the Configure dialog box. You can then 
adjust the quality of the compressed file using the Temporal 
Quality Rate slider.
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Export Settings: Audio Options

Full Frames 
(Uncompressed)

For high-quality export in which no picture information is lost. 
This option does not compress the file and can result in very 
large files. To export an uncompressed file at 1:1, use the Avid 
Codec for AVI.

Compression 
Quality Slider

Use this option to adjust compression quality for certain codecs. 
This slider does not adjust quality for the Avid AVI codec.

Key Frame 
Every n frames

Use this option to have the system use keyframes as a reference 
for subsequent frames. Enter a numeric value to specify the 
frequency of the keyframes. This option is not available for the 
Avid Codec for AVI or for uncompressed files.

Data Rate 
n KB/sec 

Use this option to set a specific data rate for the compressed file, 
in kilobytes per second. This option is not available for the Avid 
Codec for AVI or for uncompressed files.

Table 24 AVI Video Compression Dialog Box 
Options (Continued)

Option Suboption Description

Table 25 Export Settings Dialog Box 
(Audio Options)

Option Description

Mono
Stereo

Select this option to export audio tracks in either mono or stereo.

WAVE Select this option to export audio tracks in the WAVE format (.wav file name 
extension). Nearly all Windows applications that support sound use WAVE files. 
QuickTime also supports the WAVE format.
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AIFF-C Select this option to export audio tracks in the industry-standard AIFF-C format, 
which is compatible with many third-party sound editing and multimedia 
applications.

Sample Size Select one of the following:

• 16 bit

• 24 bit

Sample Rate Select one of the following:

• Project Rate

• 32 kHz

• 44.1 kHz

• 48 kHz

You can use this option if your sequence has a mix of sample rates and you need to 
create a single sample rate. (You set the project rate in the Audio Project Settings 
dialog box. For more information, see ”Adjusting Audio Project Settings” in the 
Help.) You can also use this option to change the sample rate if the application to 
which you are exporting does not support the current sample rate.

Table 25 Export Settings Dialog Box 
(Audio Options) (Continued)

Option Description
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Export Settings: Graphic Options

Table 26 Export Settings Dialog Box 
(Graphic Options)

Option Suboption Description

Use Marks When this option is selected, the system uses current IN and 
OUT points in the selected clip or sequence to determine 
starting and ending frames for the export. To export the entire 
clip or sequence, deselect this option.

Use Enabled 
Tracks

When this option is selected, the system exports only the 
currently enabled tracks for a selected sequence or clip. To 
export all tracks in the sequence, deselect this option.

Graphic Format Format 
Options

This option allows you to select a graphic format for export. 
The Format Options button allows you to set export 
parameters.

Width x Height This option allows you to set the width and height of the clip. 
Click the Fast Menu button, and select from a list of standard 
dimensions.

• Scale to Fit: This option sizes to fit the specified width 
and height.

• Crop/Pad: Crop/Pad never scales or resizes frames. If 
necessary, the system adds black lines to the top and 
bottom to achieve the correct size. 

Color Levels This option allows you to set color to RGB or ITU-R 601.

Sequential Files This option produces a series of still images, numbered 
sequentially. The fps rate of the source file determines the 
number of still image files that are produced.
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 Appendix 1 Settings Options
Export Settings: Graphic Format Options

File Field Order This option allows you to choose the field that will be the 
upper field during export. For 24p or 25p projects, these 
options do not appear; all fields are automatically exported as 
progressive (still) frames.

• Odd (Upper Field First): Select this option if you are in a 
PAL project. In forming the export frame, Field 1 
becomes the upper field, that is, Field 1's lines become the 
odd-numbered lines in the frame (counted starting from 
1). Field 2's lines become the even-numbered lines.

• Even (Lower Field First): Select this option if you are in 
an NTSC project. In forming the export frame, Field 1 
becomes the lower field, that is, Field 1's lines become the 
even-numbered lines in the frame. Field 2's lines become 
the odd-numbered lines.

• Single Field: Select this option if you want the output file 
to consist of only Field 1. In this case, the single field of 
243 lines for NTSC (288 lines for PAL) is resized to fit the 
frame as specified in the width and height selection.

Table 26 Export Settings Dialog Box 
(Graphic Options) (Continued)

Option Suboption Description

Table 27 Graphic Format Options Settings

File Type Parameters Description

Alias This option creates files that are compatible with 
Alias™/Wavefront™ systems.

BMP Windows This option creates files that are compatible with systems 
running the Microsoft Windows operating system.

OS/2 This option creates files that are compatible with systems 
running the IBM® OS/2® operating system.
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Chyron Developed by Chyron Corporation for use with video 
frame buffers of Chyron® character generator titles.

Cineon Blackpoint 
(Windows) 
Black Point 
(Macintosh)

This option allows you to adjust a film exposure value 
that corresponds to filming a 2% black card. Values can 
be between 0 and 1022. The default value of 0 is adequate 
for most uses.

Whitepoint 
(Windows) 
White Point 
(Macintosh)

This option allows you to adjust a film exposure value 
that corresponds to filming a 90% white card. Values can 
be between 1 and 1023.

If the files came from and will be transferred back to a 
Cineon™ system, use a white point of 1023. The default 
value of 685 is appropriate if the final destination is not a 
Cineon system — for example, a video display.

Gamma This option specifies an adjustment to correct for any 
gamma inconsistencies in the output display. Values can 
be between 0.01 and 100.0.

Use a value of 1.0 (the default) for images displayed on a 
PC monitor. Use a value of 0.59 for a Silicon Graphics® 
or a Macintosh monitor.

Use a value of 0.45 for ITU-R 601 (CCIR 601) video.

ERIMovie Pack 24 bits This option controls whether the image data is packed 
into 24-bit color depth (compressed) or is saved as 32-bit 
(raw) color depth.

Framestore The Framestore format is a 16-bit video image format 
used on the Amiga® in conjunction with Newtek's 
Video Toaster™ hardware. HIIP supports both 
compressed and uncompressed Framestore formats.

IFF Developed by Electronic Arts. IFF (Interchange File 
Format), or more specifically IFF-ILBM (InterLeaved 
BitMap), is the standard file format by which applications 
on the Amiga platform transfer image files.

Table 27 Graphic Format Options Settings (Continued)

File Type Parameters Description
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JPEG Quality This option controls the output file size and quality. 
Higher values produce better images but larger file sizes. 
Conversely, lower values reduce the image quality but 
result in smaller file sizes.

Baseline This option is selected by default. To see if this option is 
required, see the documentation that came with your 
JPEG-supported applications. 

Progressive This option allows you to save progressive JPEG files, 
which divide the file into a series of scans of the image 
that increase in quality. Each scan progressively 
improves the recognizability of the image.

Progressive JPEG files can be recognized only by 
applications with progressive JPEG support, such as 
some Web browsers.

 OMF Compression This option controls the compression ratio and, therefore, 
the size of the file. You can choose from all the 
compression ratio options used by the Avid system when 
recapturing. For more information on Avid compression 
ratios, see ”Main Topics: Resolutions and Storage 
Requirements” in the Help.

Frame Rate

NTSC/PAL

These options appear when you select a compression 
ratio that allows you to select either NTSC or PAL. When 
you select an option, the system displays the required 
image size and the default frame rate.

PCX Developed by Zsoft Corporation for use with their 
PC PaintBrush™ paint software.

Photoshop Compression This option controls the size of the file on disk. Disabling 
compression creates larger files on disk.

Table 27 Graphic Format Options Settings (Continued)

File Type Parameters Description
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Export Settings
PICT (Windows 
only)

Create 
MacBinary 
header

This option creates a file with a MacBinary header.

MacBinary is a file format for representing all the 
information in a Macintosh file in one binary file. It is a 
compact file format, useful for storing a Macintosh file 
on a non-Macintosh system for later retrieval. Use a file 
expander utility to decode a MacBinary file once it is 
back on a Macintosh system.

Pixar This option allows you to save the file in the Pixar® 
format.

PNG Color Depth The 8 bits option saves 8-bit files. The 16 bits option 
saves 16-bit files. The Automatic option saves the image 
in the same depth as the original loaded image.

Interlaced This option allows you to save the file for progressive 
display, similar to progressive JPEG files. As the file is 
transmitted, the recognizability of the image improves.

Interlaced PNG files can be recognized only by 
applications with interlaced PNG support, such as some 
Web browsers.

QRT Developed on the Amiga personal computer to run on 
several operating systems. Used by many ray tracing 
programs, such as DKB Ray Trace and the QRT ray 
tracer.

Rendition Developed by Numerical Design, Ltd.

SGI Color Depth The 8 bits option saves 8-bit files. The 16 bits option 
saves 16-bit files. The Automatic option saves the image 
in the same depth as the original loaded image.

Softimage Developed by Softimage®, Inc. for use in their Softimage 
software.

Sun Raster™ Developed by Sun Microsystems, Inc. and supported 
mainly in Sun applications.

Table 27 Graphic Format Options Settings (Continued)

File Type Parameters Description
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TARGA Color Depth This option controls how images are saved. The 5-bit 
option saves data in Targa 16 format. The 8-bit option 
saves data in Targa 24/32 format.

Compression This setting controls the size of the file on disk. Disabling 
compression creates larger files on disk.

TIFF Color Depth The 8 bits option saves 8-bit files. The 16 bits option 
saves 16-bit files. The Automatic option saves the image 
in the same depth as the original loaded image.

Compression This setting controls the size of the file on disk. With 
None, image data is not compressed and can produce 
large file sizes. RLE (run length encoded) produces 
relatively small and fairly portable files. JPEG produces 
files that can vary in size, depending on the quality you 
have set using the JPEG quality slider. The higher the 
quality setting, the larger the file size.

JPEG Quality This option adjusts the image quality of the JPEG file on 
a sliding scale from 0 to 100. The higher the number you 
set, the higher the image quality of the JPEG file.

Wavefront Format Type This option specifies one of two output file formats 
supported by Wavefront (either RLA or RLB).

Color Depth The 8 bits option saves 8-bit files. The 16 bits option 
saves 16-bit files. The Automatic option saves the image 
in the same depth as the original loaded image.

Gamma This option specifies an adjustment to correct for gamma 
differences between Macintosh and Windows PC output 
display. This option is intended for cross-platform 
applications that require adjustment. 

n To see if you need to adjust this value, check the 
documentation that came with your Wavefront 
application. Usually, you can use the default 
setting.

Table 27 Graphic Format Options Settings (Continued)

File Type Parameters Description
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Film and 24p Settings
Film and 24p Settings

XWindows Developed by the MIT X Consortium, and is supported 
by many X Window System™ applications on 
workstations and some personal computers.

YUV Format This option controls the video format of saved images. If 
set to NTSC, NTSC video format (720 x 486) is used. If 
set to PAL, PAL video format (720 x 576) is used. 
Images are either padded with black or cropped.

Smooth YUV This option enhances the fidelity of images saved in YUV 
color space (if originating in RGB color space).

Table 27 Graphic Format Options Settings (Continued)

File Type Parameters Description

Table 28 Film and 24p Setting Dialog Box Options

Option Description

Edit Play Rate Selects the play rate for Timeline play. See “Film 
Settings - Edit Play Rate Options” on page 64.

n For a 23.976p project the Edit Play Rate is 
automatically set at 23.976 fps.

Ink Number Format Select one of these industry-standard ink number 
formats to meet your production lab standards and your 
film format.

Ink Number 
displayed as

Select the format for the ink number display in bins and 
cut lists.

Auxiliary Ink 
Format

Select the format for the auxiliary ink number (this is 
useful for tracking additional information for different 
film gauges). The choices are the same as for Ink 
Number Format.
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Film Settings - Edit Play Rate Options

Auxiliary Ink 
displayed as

Select the format for the auxiliary ink number display. 
The choices are the same as for Ink Number 
displayed as.

Table 28 Film and 24p Setting Dialog Box Options 

Option Description

Table 29 Edit Play Rate Options

Project Type Option Description

24p PAL 24 fps Selects playback at 24 fps of all output except for digital cut

25 fps Selects playback at 25 fps of all output except for digital cut

24p NTSC 23.976 fps Selects playback at 23.976 fps of all output except for digital cut

24.000 fps Selects playback at 24 fps of all output except for digital cut
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General Settings
General Settings

 

Table 30 General Settings Options

Option Description

Project Format This option displays the format currently selected for the project (NTSC or 
PAL). It cannot be changed.

Temporary File Directory When you use the Drag and Drop Export or an export that creates an 
intermediate movie file, application must store the intermediate file, which 
can be as large as the final export. By default, the Temporary File 
Directory is located in the same directory as application.

To improve efficiency or to avoid DISK_FULL errors when exporting, you 
can type in a different directory for these temporary files. The ideal setting 
for this field is to type in a directory on the drive to which you are 
exporting, or simply one with plenty of free space.

Default Starting TC This option specifies the timecode value you want the system to use as the 
default starting timecode for each new sequence. 

NTSC Has Setup This option allows systems using NTSC-EIAJ to use the correct color 
mapping. NTSC-EIAJ users should not select this option. All other users 
should select this option.

Use Windows compatible 
file names 
(Macintosh only)

Prevents you from using the characters /\:*?”<>| and adding leading 
spaces, trailing spaces, or a trailing period in bin, project, or user names. 
These characters are not allowed in Windows file names. This option is 
useful for moving bins and projects from Macintosh to Windows 
platforms.

Allow file names to exceed 
27 characters 
(Macintosh only)

Lets you override the Windows file name limit of 27 characters (not 
including the four characters reserved for the file type extension). Set this 
option if you do not plan to move your bins or projects to a Windows 
system, and if you want to use file names longer than 27 characters.
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Grid Settings

Table 31 describes the options available in the Grid Settings dialog box.

Table 31 Grid Settings Options

Tab Option Description

Coordinates Scale Mode

• Normal

• 4:3 Inside 16:9 Monitor

• 4:3 Outside 16:9 Monitor

• 1.66 Inside 4:3

• 1.77 Inside 4:3

• 1.85 Inside 4:3

This setting allows you to work with a grid that indicates 
boundaries for a format other than the one in which you are 
working. This is useful when you are creating graphics (like 
titles) that must remain safe in other formats. Select the 
appropriate option for the current and target formats you need. 
When you do not specifically need a grid that represents 
another format, use the Normal option, which is the default.

Coordinates Increments

• Fields Sets the number of tick marks along the grid axes as well as the 
number of visible grid points. The default value is 12.

• Sub Fields Sets the number of divisions between visible grid points for the 
snap-to-grid feature. Setting Sub Fields to 1 snaps objects to 
visible points only. A value of 2 provides 1/2-field jumps. A 
value of 4 (the default value) provides 1/4-field jumps, and so 
on. Setting Sub Fields to 0 turns off the snap-to-grid feature.

Coordinates Source Scan Size For film projects, where an optical house scans film for the 
addition of visual effects.

• Hor. Size

• Vert. Size

The default values are 720 x 486 pixels.

Coordinates Source Grid Adjustments

• Hor. Offset

• Vert. Offset

Moves the grid on the image. These values are intended mainly 
for film projects.

• Inset Shrinks the grid proportionally.
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Display Type

• Square

• Standard Film

• Academy

• Super 35

• Anamorphic

Selects a different grid for each standard film type. For video 
projects, use the Square grid type. The grid for the Academy 
option includes a safety margin on the left that is used for 
adding the optical sound track.

Display Color Sets a color for the grid axes and the grid points.

Display Show Safe Title Displays the safe title area. Create video titles within this area 
to ensure that they are viewable on a regular television screen.

Display Show Safe Action Displays the safe action area for video display. This box is self-
adjusting for PAL and NTSC projects.

Display Show 14x9 Zone 
Show 1.66 Aspect 
Show 1.85 Aspect 
Show 1.77 Aspect

Select one or more of these options to display the grid you 
want.

Display Show Axes Displays the grid axes.

Display Show Tick Marks Shows tick marks along the axes. Use the Fields parameter to 
set the number of tick marks.

Display Show Thirds Divides the screen into three sections. This is especially useful 
if you are creating titles for the lower third of the screen.

Display Show Points Shows the grid points. Use the Fields parameter to set the 
number of grid points.

Table 31 Grid Settings Options (Continued)

Tab Option Description
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Import Settings

See the following topics:

• Import Settings: Image Tab

• Import Settings: OMFI Tab

• Import Settings: Shot Log Tab

Display Show Position Info Displays the position coordinates of any point in the Effect 
Preview, or Record monitor. The application uses compass 
coordinates and X, Y coordinates. For compass coordinates, 
the point (0, 0) is the center of the axes. For X, Y coordinates, 
the point (0, 0) is the top left corner of the monitor. X values 
increase to the right, and Y values increase as you move down. 
For more information, see “Displaying Position Coordinates” 
in the Help.

Table 31 Grid Settings Options (Continued)

Tab Option Description
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Import Settings
Import Settings: Image Tab

Table 32 Import Settings Options (Image Tab)

Option Suboption Description

Aspect Ratio, 
Pixel Aspect

601, non-square Select this option to import images with the dimensions used 
by the Avid system: 720 x 48 (NTSC) or 720 x 576 (PAL). 
Also use this option for 720 x 540 images, or for other images 
that fit the 4:3 aspect ratio. You can use this option to maintain 
field data when you import two-field media that follows exact 
NTSC or PAL dimensions.

The system converts the existing pixel dimensions, if 
necessary, so that the image fills the screen.

If the aspect ratio of the original frames does not match the
4:3 aspect ratio used by the Avid system, the imported frames 
might appear distorted.

For best full-screen resolution of files created in a square-pixel 
environment, use 648 x 48 (NTSC) or 768 x 576 (PAL). To 
create a single resolution for both NTSC and PAL, use 
720 x 540. 

n This option is selected by default.

Maintain, non-
square

Select this option for an image that was created in a non-
square-pixel environment, but does not match exact NTSC or 
PAL dimensions. Maintain, non-square preserves up to 48 
(NTSC) or 576 (PAL) lines, and either removes additional lines 
or pads with video black if there are fewer lines.

Maintain, non-square never scales or resizes.
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Maintain, square Select this option for an image that was created in a square-
pixel environment, such as a graphics application. Use this 
option primarily for icons, logos, and other graphics that 
cannot be resized and are not intended to fill the entire screen.

The system fills the rest of the screen with video black. If the 
image has an alpha channel, this black is keyed out in the alpha 
channel.

Do not use this option if you are importing:

• Images in the 720 x 48 (NTSC) or 720 x 576 (PAL) non-
square-pixel dimensions

• A full-screen square-pixel image that has already been 
stretched to non-square-pixel dimensions

Maintain and 
Resize, square

Select this option for an image that was created in square-pixel 
terms.

The system fits the longest dimension to the screen size and 
fills in the missing pixels in the shorter dimension with video 
black, creating a border. If the image has an alpha channel, this 
black is keyed out in the alpha channel.

For example, a 540 x 300 image would have its longer 
dimension resized to 720, and the shorter dimension resized in 
proportion (to 400). The remaining “short side” pixels are 
replaced with black.

For best full-screen resolution of files created in a square-pixel 
environment, use 648 x 48 (NTSC) or 768 x 576 (PAL). To 
create a single resolution for both NTSC and PAL, use 
720 x 540.

Do not use this option if you are importing:

• Images in the 720 x 48 (NTSC) or 720 x 576 (PAL) non-
square-pixel dimensions

• A full-screen square-pixel image that has already been 
stretched to non-square-pixel dimensions

Table 32 Import Settings Options (Image Tab) (Continued)

Option Suboption Description
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File Field 
Order

This section allows you to select the temporal field ordering 
(sometimes referred to as field dominance) of the media you 
are importing.

When the field dominance of the imported media matches the 
field dominance of the project format, no special processing is 
required. For more information, see “Field Ordering in Graphic 
Imports and Exports” in the Help.

This setting does not apply to OMFI imports when the import 
resolution matches the OMFI file.

Non-interlaced This option allows you to import still images to all formats 
without concern for the temporal ordering of the fields. 

n This is the default value.

Odd (Upper Field 
First)

Select this option for the odd field to occur temporally first 
during import. The first line in the image belongs to the odd 
field.

Even (Lower 
Field First)

Select this option for the even field to occur temporally first 
during import. The first line in the image belongs to the even 
field.

Color Levels RGB Select this option if the imported graphics file uses RGB 
graphics levels. Most computer-generated graphics use RGB 
graphics levels. The RGB color values are remapped to ITU-R 
601 (formerly CCIR 601) video color values appropriate for 
the Avid system.

RGB, dithered Select this option if the imported graphics file uses complex 
color effects, such as a gradation, and you are importing at a 
high resolution (2:1). Do not use this option to reimport an 
image that has already been imported with dithering.

601 Select this option if the imported graphics file uses video levels 
based on the ITU-R 601 (formerly CCIR 601) standard. These 
graphics include Avid color bars or images that include 
superblack (zero black) for keying purposes.

Table 32 Import Settings Options (Image Tab) (Continued)

Option Suboption Description
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Alpha Use Existing Select this option to import the image, using the existing alpha 
channel information.

Invert Existing Select this option to reverse the black and white elements of the 
alpha channel if they differ from the matte key requirements of 
the system: a white background, a black foreground, and a gray 
transparency blend between the two.

Ignore Select this option to import an image that contains alpha 
channel transparency information as one opaque graphic. The 
imported graphic appears as a single master clip in the bin.

n If an image contains an embedded alpha channel but the 
system does not support alpha channel import for the file 
type, select this option to import the image successfully. 
For information on alpha channel support, see “Graphic 
File Import Specifications” in the Help.

Single Frame 
Import

Duration n 
seconds

Select this option to specify the duration of the single frame 
created from the import. The default is 10 seconds. This option 
does not apply to importing sequential image files because 
each file represents one frame of the clip; therefore, the total 
number of files determines the total duration.

Importing an image with alpha channel creates a matte key 
effect as a single frame, with no associated media file.

Importing as a single frame takes less time and requires less 
storage than importing as a media file. However, a single frame 
has limited real-time playback capabilities, particularly at high 
resolutions. This occurs because the system loads the frame 
into memory and handles it in real time, rather than playing it 
back from a disk.

Table 32 Import Settings Options (Image Tab) (Continued)

Option Suboption Description
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Autodetect
Sequential Files

Select this option if you are importing sequential files and you 
want the system to recognize that a sequence of connected files 
is present and to automatically import the whole sequence.

When this option is deselected, the system does not 
automatically import a whole sequence of files that have 
sequential extensions. You can then select any single file for 
import.

You can import sequential files for any of the supported still-
image formats. For information on preparing a sequence of 
image files, see “Animation Files” in the Help.

Table 32 Import Settings Options (Image Tab) (Continued)

Option Suboption Description

Table 33 Import Setting Options (OMFI Tab)

Option Description

Use the source file’s resolution. Select this option to maintain the source file’s 
resolution. The system disregards the resolution 
setting in the Select Files to Import dialog box as 
well as resolution set in the Import tab of the 
Media Creation dialog box.

Use the current import resolution. Select this option to use the current import 
resolution setting. The system disregards the 
source file resolution.

Ask me to set the resolution for each file that is 
different from the current import resolution 
setting.

Select this option to have the system display a 
query about resolution selection for each imported 
file when the resolution of the source file is 
different from the current import resolution 
setting.
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Import Settings: Shot Log Tab

Table 34 Import Setting Options (Shot Log Tab)

Option Description

Maintain events as logged. Select this option to maintain all events as 
originally logged.

Combine events based on scene and automatically 
create subclips.

Select this option to combine all the events for a 
scene into a single master clip and then link the 
master clip to subclips that represent the original 
events for that scene. To use this option, you 
must have scene numbers logged in a scene 
column in the bin.

Combine events based on camera roll and 
automatically create subclips.

Select this option to combine all the events from 
a camera roll into a single master clip and then 
link the master clip to subclips that represent the 
original events for that camera roll. To use this 
option, you must have camera roll numbers 
logged in a camera roll column in the bin for a 
film project.

Merge events with known sources and 
automatically create subclips.

Select this option to create subclips for events 
that are merged or relinked to their source clips 
upon import. Use this option if you have already 
entered master clips in a bin for each camera roll 
or master scene, and have subsequently logged 
all the events related to those clips for import.

n You must select the clips that you want to 
merge before selecting this option.
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Interface Settings

See the following topics:

• Interface Settings: General Tab

• Interface Settings: Appearance Tab

Interface Settings: General Tab

Merge events with known master clips. Select this option to merge information in the 
shot log onto selected master clips based on the 
matching tape name. Use this option if you have 
already logged (or captured) master clips in a bin 
for each take. 

n You must select the clips that you want to 
merge before selecting this option.

Table 34 Import Setting Options (Shot Log Tab) (Continued)

Option Description

Table 35 Interface Settings Options 
(General Tab)

Option Description

Show Labels in Tool Palette When you select this option, the system displays text labels 
with the icons on the Tool palette. This is the default option.

To tear off the Tool palette, click anywhere on the palette, 
press and hold the mouse button, and drag the palette to the 
location you want.
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Show ToolTips When you select this option, the system displays labels for 
buttons and icons when you position the mouse pointer over 
them. This is the default option.

You can also turn ToolTips on and off from the Help menu.

Delay n seconds before showing If you select Show ToolTips, you can delay the label display 
by entering a value in this text box. A delay allows you to 
move the mouse pointer across the interface without displaying 
the labels on items between the starting point and the 
destination of the mouse pointer.

Windows® Standard Alt Key 
Behavior (Windows Only)

This option switches between standard Windows Alt key 
behavior and Avid system Alt key behavior. When you select 
this option, pressing and holding the Alt key together with 
another key works as a keyboard shortcut for certain Windows 
actions (for example, opening menus).

When you deselect this option, pressing and releasing the Alt 
key and then pressing another key works as the Windows 
keyboard shortcut, while pressing and holding the Alt key 
together with another key works as a keyboard shortcut for 
certain Avid functions. This is the default option.

For more information on Windows shortcuts, see the Windows 
documentation.

For more information on Avid shortcuts, see the Avid Xpress 
Quick Reference for the Windows  Operating System, or select 
Help > Shortcuts.

Automatic Num Lock Activation 
(Windows Only)

When you select this option, the Avid application 
automatically sets the numeric keypad in numeric mode the 
next time you start the application. If you deselect this option, 
the Num Lock key on the keyboard controls the mode of the 
numeric keypad. 

With either selection, you can use the Num Lock key to change 
the mode of the numeric keypad.

Table 35 Interface Settings Options 
(General Tab) (Continued)

Option Description
76



Interface Settings
Interface Settings: Appearance Tab

Automatically Launch Last Project at 
Startup

Opens your last project when the application starts.

Table 35 Interface Settings Options 
(General Tab) (Continued)

Option Description

Table 36 Interface Settings Options 
(Appearance Tab)

Option Selection Description

Color Background 

Button 

Button Contents 

Button Highlight 

Button Spotlight 

Text 

Timeline Background

Timeline V Tracks

Timeline A Tracks

Timeline TC Tracks

Project Background

Bin Default 
Background

Controls the color of the given interface 
component. See ”Changing Interface 
Component Colors” in the Help.
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Shading Style Convex

Dim Radial

Convex Radial

Bright Radial

Controls the shading of buttons and toolbars. 
See ”Changing Shading Style” in the Help.

Shading Depth 5% – 50%, in 5% 
increments

Controls the three-dimensional “rounding” of 
buttons and toolbars. See ”Changing Shading 
Depth” in the Help.

Monitor Button Separation Maximum

Moderate

None

Controls the spacing of the Monitor buttons. 
See ”Changing Button Separation” in the 
Help.

Timeline Button Separation Maximum

Moderate

None

Controls the spacing of the Timeline buttons. 
See ”Changing Button Separation” in the 
Help.

Button Style Oval

Octagonal

Rounded

Square

Swoosh

Antique

Controls the shape of the buttons. See 
”Changing Button Style” in the Help.

Table 36 Interface Settings Options 
(Appearance Tab) (Continued)

Option Selection Description
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Keyboard Settings

The following illustration displays the default keyboard settings.

For more information, see Help > Keyboard Shortcuts in the Avid editing 
application.

When you open the Keyboard palette from the Settings scroll list and select 
Map Foreign Keyboard, you can map user-selectable buttons to the 
keyboard. If the Windows operating system is set to French or German 
regional settings, and you click the center of the Enter key in the Keyboard 
palette, a message box opens that says foreign keyboard mapping mode 
has been turned off. Select Standard, and then select Map Foreign 
Keyboard again to return to foreign keyboard mapping mode. 
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Marquee Title Settings

Table 37 Marquee Title Settings

Setting Description

Create New Title using

Marquee The system always opens Marquee when you select Clip > New 
Title or Tools > Title Tool.

Title Tool The system always opens the Title Tool when you select Clip > 
New Title or Tools > Title Tool.

Ask me The system displays the New Title dialog box when you select Clip 
> New Title or Tools > Title Tool. You can then select either 
Marquee or the Title Tool. This is the default setting.

Promote Title Tool 
titles to Marquee

Yes The system always promotes a Title Tool title to a Marquee title 
when you open the title for editing from a bin or from within a 
sequence. For more information, see “Promoting Title Tool Titles 
to Marquee” in the Marquee Help.

No The system never promotes a Title Tool title to a Marquee title 
when you open the title for editing from a bin or from within a 
sequence.

Ask me The system displays the Edit Title dialog box when you open a title 
for editing from a bin or from within a sequence. You can then 
choose whether to promote the title to Marquee. This is the default 
setting.

Backup Title on Promote When this option is selected, the system creates a backup Title Tool 
version of any title that it promotes to Marquee. The backup copy is 
a fast-saved (unrendered) title. The system adds [TT] to the name of 
the backup copy to differentiate it from the newly created Marquee 
version.
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Media Creation Settings

Table 38 Media Creation Settings (Drive Filtering Tab)

Setting Description

Filter Based on Resolution Removes as a storage choice the drives that 
cannot support the selected resolution. This 
option causes the Avid editing system to utilize 
only Avid MediaDrives

Filter Out System Drive Removes as a storage choice the drive on 
which the operating system resides.

Filter Out Launch Drive Removes as a storage choice the drive on 
which the Avid application resides.

Table 39 Media Creation Settings (Other Tabs)

Setting Description

Video Resolution Select a resolution.

OMF/MXF Select a file format: Open Media Format 
(OMF) or Material Exchange Format (MXF). 
For more information, see ”File Format 
Specifications” in the Help.

Apply to All This sets your chosen resolution for all the 
Media Creation dialog box tabs. It also sets it 
for any place in the application where you 
select a resolution.

Video/Audio Drive Select a drive or drives

Apply to All This sets your chosen video and audio drives 
for all the Media Creation dialog box tabs. It 
also sets them for any place in the application 
where you select drives.
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MM Host

You need to configure your Avid application before you can interact with 
MediaManager. Specifies the location of MediaManager by listing the 
computer name of the MediaManager server. See the Avid Unity 
MediaManager Setup and User’s Guide.

MM User

You need to configure your Avid application before you can interact with 
MediaManager. Defines user and login preferences for using 
MediaManager. See the Avid Unity MediaManager Setup and User’s 
Guide.

PortServer Settings

Table 40 PortServer Settings

Setting Description

Auto-connect to LANshare at 
Launch

LANshare workspaces are recognized when 
you start the Avid application.

Connect Starts the connection.
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Render Settings

Table 41 Render Settings Options

Option Description

Render Completion 
Sound

Sets a sound for Avid Xpress to activate once the rendering process is complete. 
This is useful when you are rendering multiple effects.

• None Disables the rendering completion sound. This is the default.

• Render Sound Sets the rendering completion sound to a customized sound.

• System Beep Sets the rendering completion sound to match the sound set for your operating 
system.

Motion Effects Render 
Using

Determines the processing method when existing motion effects are rendered or 
rerendered.

• Original Preference Causes effects to be rendered as whatever type they were when originally 
created.

• Duplicated Field Displays a single field in the effect. For two-field media, this reduces the 
information stored by half because it drops one field of the image, resulting in a 
lower quality image. For single-field media, this is usually the best choice 
because of its speed (the other options do not improve effect quality for single-
field media). 

With JFIF resolutions, selecting this option causes the effect to render in the 
shortest amount of time. With DV and MPEG resolutions, the effect renders 
approximately as quickly as it would if you selected Both Fields as the rendering 
option.

• Both Fields Displays both fields in the effect. For example, the first two frames of a half-
speed (50%) slow-motion effect repeat the original Frame 1 (both fields) twice. 
This option is good for shots without inter-field motion, NTSC or PAL film-to-
tape transfers, and still shots. With footage that includes inter-field motion, this 
method might result in minor shifting or bumping of the image because it 
disturbs the original order of fields: a Field 1 will appear both before and after 
the corresponding Field 2. 

The effect renders relatively quickly. For best results, you should use evenly 
divisible frame rates with this option.
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Safe Color Settings

• VTR-Style Creates a second field for the effect by shifting selected video fields of the 
original media by a full scan line. This technique is similar to that used by high-
quality professional video decks when playing footage at less than normal speed. 
This option also creates the motion effect at the field level rather than the frame 
level; however, because pixels are not filtered, the final image is sharper than 
that created by the Interpolated Field option. The image might display some 
slight jitter at certain speeds. 

The time needed to render effects created with this option is longer than the time 
for effects created using either Duplicated Field or Both Fields but similar to the 
time needed for Interpolated Field.

• Interpolated Field Creates a second field for the effect by combining scan line pairs from the first 
field in the original media. This option calculates the motion effect at the field 
level rather than the frame level. Because Avid Xpress considers all fields and 
does not disturb the original order of fields, the smoothest effect results. 

Effects created using this option take the longest amount of time to render.

Table 41 Render Settings Options (Continued)

Option Description

Table 42 Safe Color Settings Options

Option Description

Composite Sets safe color values for the composite video signal.

Luminance Sets safe color values based on brightness.

RGB Gamut Sets safe color values based on color range.
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Units buttons Define the units of measurement for the three types of safe color values.

The Composite Units pop-up menu allows you to select either IRE or mVolts 
(millivolts).

The Luminance and RGB Gamut pop-up menus allow you to select from the 
following options:

8 Bit — Measures the adjustment on a scale from 0 to 255.

n The RGB value for a color in the Color Correction tool will not be 
identical to the RGB value for the same color in a graphics application 
such as Adobe® Photoshop®. For example, the 8-bit RGB values for 
reference black and reference white are 16 and 235 respectively.

Percent — Measures the adjustment on a percentage scale from 0 to 100.

IRE — Measures the adjustment in IRE units.

mVolts — Measures the adjustment in millivolts.

Actions buttons Define how the system implements the safe color settings. The top menu controls 
both the Composite and the Luminance limit types; the bottom menu controls the 
RGB Gamut limit type. Each Actions menu allows you to select from the 
following options:

Ignore — The system does not limit based on these settings. This is the default 
setting.

Warn — The system provides warnings when these limits are exceeded. For 
more information on safe color warnings, see ”Understanding Safe Color 
Warnings” in the Help.

Table 42 Safe Color Settings Options (Continued)

Option Description
85



 Appendix 1 Settings Options
Script Settings

 

Table 43 Script Settings Options 

Option Description

Font This option selects the font for imported scripts.

Size This option selects the font size. The default is 12 points.

Left Margin (pixels) This option specifies the left margin size. The default is 
40 pixels.

Take Coloring This option specifies the color that the Avid system will apply 
to takes.

Show Frames When this option is selected, the system shows frames in take 
slates.

Show All Takes When this option is selected, the system shows all takes in each 
slate. If you deselect this option, the Avid system displays only 
one take per slate.

Interpolate Position When this option is selected, you can click in a take line within 
a script, and the image in the Source pop-up monitor updates to 
the approximate position in the take where you have clicked. If 
you deselect this option, the Source pop-up monitor does not 
respond when you click in a take line.

Hold Slates Onscreen Set this option to keep the slates on the screen when you scroll 
through a script in the Script window. Each slate remains on 
the screen as long as the take lines to which it is linked remain 
on the screen.
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Timeline Settings

See the following topics:

• Timeline Settings: Display Tab

• Timeline Settings: Edit Tab

Timeline Settings: Display Tab

Timeline Settings: Edit Tab

Table 44 Timeline Settings Options 
(Display Tab)

Option Description

Show Toolbar Displays the Timeline top toolbar.

Show Marked Region Highlights the region from the IN point to the OUT point.

Show Marked 
Waveforms

Shows waveforms drawn between an IN point and an OUT point instead of 
over the entire composition. 

Show Four-Frame 
Display

Table 45 Timeline Settings Options (Edit Tab)

Option Description

Start Filler Duration Type the amount of filler you want to appear by default when you select Clip 
> Add Filler at Start.

Find Flash Frames 
Shorter Than n frames

Type the maximum number of flash frames you want the system to detect. 
The default is 10, which tells the system to detect clips with 9 frames or fewer. 
See ”Finding Black Holes and Flash Frames” in the Help.
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Trim Settings

Auto-Patching When this option is selected, the system automatically patches the enabled 
source tracks to the tracks enabled in the Timeline sequence.

Auto-Monitoring When this option is selected, the track you patch to is monitored. This option 
is selected by default.

Segment Drag Sync 
Locks

When this option is selected and sync locks are enabled, you can move 
segments in the Timeline and maintain sync between audio and video. After 
moving a segment in the Timeline, this option maintains sync by adding filler 
to the location from which the segment was moved, and to the location on all 
other sync-locked tracks that corresponds to the new location of the segment 
you moved. You can move either an audio clip or a video clip.

Default Snap-To Edit Allows a clip, when dragged from a bin to the Timeline, to either snap to a 
transition point or move freely on the track. If the option is selected, the clip 
snaps to an existing transition endpoint. If the option is deselected, the clip 
moves freely to any position on the track. 

Dupe Detection Handles Select the size of the handles, in frames, to use for dupe checking. The chosen 
number of frames is added at the beginning and the end of each clip before 
checking for overlap. The handles are used only for internal calculations.

Table 45 Timeline Settings Options (Edit Tab) (Continued)

Option Description

Table 46 Trim Settings

Setting Description

Play Loop Preroll Click the text box and type the value you want.

Play Loop Postroll Click the text box and type the value you want.

Play Loop Intermission Click the text box and type the value you want.
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Video Display Settings

Table 47 Video Display Settings Options

Option Sub-option Description

DV device supports digital 
video input

Send video to DV device 
(client monitor enabled)

Select this option and sub-option to send 
video to the client monitor.

Don’t send video to DV 
device (client monitor 
disabled)

Seconds of Video to Pre-Fill: n seconds Type the number of seconds by which to 
delay playback. By accepting a delay at the 
beginning of playback, you increase the 
likelihood that the system will play the 
material successfully. The maximum delay 
is 10 seconds.

Open GL Hardware: Preview 
DVE effects with:

Video boards installed on 
your system

Select the Open GL board for your video 
display

Software Open GL Select if you do not have an Open GL 
video board

Enable Confidence View
(also called passthrough)

— Enable confidence view if you want to 
view incoming or outgoing media in the 
Record monitor as you are capturing media 
or creating a digital cut.

Maximum Real Time Streams Stream Limit n Select the number of video streams you 
want to display in the Record monitor at a 
time. 

n More streams uses more processing 
cycles and might cause the video to 
play choppy.
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Workspace Settings

Table 48 Workspace Settings

Setting Description

Activate Settings Linked By 
Name

Select this option to link other settings to the 
workspace.

Continually Update This 
Workspace

Select this option to automatically preserve the 
workspace in its most recent arrangement. 
Future changes to the arrangement of the tool 
windows are saved.

Manually Update This 
Workspace

Select this option to save the workspace in its 
current arrangement when you click Save 
Workspace Now (which appears only after you 
select Manually Update This Workspace). 
Future changes to the arrangement of the tool 
windows are disregarded unless you return to 
the Workspace Settings dialog box and click 
Save Workspace Now again.
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Chapter 2

Using AudioSuite Plug-Ins

This appendix describes how to access and use the AudioSuite plug-ins, 
including the set of core plug-ins that comes with your Avid system. It also 
provides a list of other plug-ins that are supported by this version. 

These topics are covered in the following sections:

• Accessing the AudioSuite Plug-Ins

• Core AudioSuite Plug-Ins

• Description of Core AudioSuite Plug-Ins

• Additional Supported Plug-Ins



 Chapter 2 Using AudioSuite Plug-Ins
Accessing the AudioSuite Plug-Ins

To access the plug-ins:

t Select Tools > AudioSuite. 

The following illustration shows the AudioSuite window.

For details on installing and accessing the plug-ins, see “Understanding 
Digidesign Audio Suite Plug-Ins” in the Help.

Core AudioSuite Plug-Ins

The following basic plug-ins are installed automatically as part of the Avid 
system software installation:

• Invert — Inverts the polarity (phase of the audio file).

• Duplicate — Creates a new master clip from a selected audio clip. The 
plug-in uses the IN and OUT points on the selected clip to define the 
boundaries of the new clip.

• Normalize — Finds the peak value in the source audio file and scales 
the entire file proportionally to that maximum value.

• Gain — Same as Normalize, but allows positive or negative gain 
adjustment.

• Reverse — Rewrites the selected audio in reverse.

Drive Selection 
pop-up menu

Plug-in Selection 
pop-up menu

Status display
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Core AudioSuite Plug-Ins
• Signal Generator — Produces audio test tones in a variety of 
frequencies, waveforms, and amplitudes. 

• DC Offset Removal — Removes an audio artifact that is common in 
digital audio files. A DC offset is caused by poorly calibrated analog-
to-digital converters (A/Ds), and can produce clicks and pops on clip 
edit transitions if not removed.

• Time Compression Expansion — Allows you to adjust the duration of 
a selected clip by creating a new master clip. This increases or 
decreases the selection’s length without changing pitch.

• Pitch Shift — Changes pitch with or without changing length.

• EQ — Allows you to adjust frequency equalization on individual audio 
clips.

• Compressor — Reduces the dynamic range of signals that exceed a 
selected threshold by a specific amount.

• Limiter — Prevents signal peaks from exceeding a chosen level so that 
they don’t overload amplifiers or recording devices. 

• Gate — Reduces noise by decreasing the gain of signals that fall below 
a user-selectable threshold.

• Expander/Gate — Performs the same function as the Gate plug-in with 
the addition of expander features. Expanders are particularly useful for 
reducing noise or signal leakage that creeps into recorded material as 
the signal level falls, which often occurs with headphone leakage.

• Mod Delay — Provides time-delay-based effects. Effects obtained 
through the use of Mod Delay include slap echo, doubling, chorusing, 
and flanging.

For a brief overview of each plug-in and, where appropriate, a description 
of how to use the plug-in, see “Description of Core AudioSuite Plug-Ins” 
on page 94.
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Description of Core AudioSuite Plug-Ins

The following sections give a brief overview of each plug-in and, where 
appropriate, describe how to use the plug-in.

Invert

The Invert plug-in reverses the polarity of the selected audio. All positive 
sample amplitude values are made negative, and all negative amplitudes 
are made positive. This process is useful for permanently altering the phase 
(polarity) relationship of tracks. Inverting can be useful when mixing 
because it alters frequency response between source tracks recorded with 
multiple microphones and also allows you to correct for audio that was 
recorded out of phase.

Duplicate

The Duplicate plug-in creates a new master clip from a selected audio 
master clip. The plug-in uses the IN and OUT points on the selected clip to 
define the boundaries of the new clip. This plug-in applies only if you are 
using the Create New Master Clips feature of the AudioSuite plug-ins.

Normalize

In cases where a sound file has been recorded with too little amplitude, the 
Normalize plug-in ensures that the inherent dynamics of the performance 
remain unchanged while the overall volume level of the passage is raised.

In addition to the standard AudioSuite parameters, the Max Peak At 
controls let you specify how close to maximum level (the clipping 
threshold) the peak level of your selection or file will be boosted. 

To enter this information, do one of the following:

t Enter a numeric decibel value below the clipping threshold.

t Enter a percentage of the threshold.

t Adjust the on-screen slider.
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Editing any of these controls automatically calculates the equivalent value 
in the others. 

To configure the Normalize parameters:

1. Type the amount of boost you want applied during the Normalize 
process.

2. To set a specific decibel amount below maximum, double-click and 
type that value in the Max Peak at (dB) text box.

3. To set the amount of normalization as a percentage of maximum, type 
the percentage you want in the Max Peak at (%) text box. To manually 
set the amount, click and adjust the Max Peak slider [press and hold 
the Ctrl key (Windows) or the k key (Macintosh), and then click the 
slider and drag it to fine-adjust]. 

Gain

Gain allows you to boost or lower amplitudes in a file or selection by a 
specified amount. The Change Gain command is ideal for smoothing out 
undesirable peaks and other dynamic inconsistencies.

To configure the Gain parameters, do one of the following:

t Enter the new level as a decibel amount (dB) or percentage (%) by 
double-clicking in the respective text box and typing a new value. 

t Use the slider to adjust the gain manually [press and hold the Ctrl key 
(Windows) or the k key (Macintosh), and then click the slider and 
drag it to fine-adjust]. 

Reverse

Reversed sounds are useful effects in many music and film and video 
projects. The Reverse plug-in lets you perform this type of processing very 
easily.
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Signal Generator

The Signal Generator plug-in produces audio test tones in a variety of 
frequencies, waveforms, and amplitudes. The plug-in has the following 
options:

• Frequency: This option sets the frequency of the signal in hertz. 
Values range from a low of 20 Hz to a high of 20 kHz.

• Level: This option sets the amplitude of the signal in decibels. Values 
range from a low of –95 dB to a high of 0.0 dB.

• Signal: These buttons allow you to select the waveform. The 
waveform choices are sine, square, sawtooth, triangle, white noise, and 
pink noise.

n The Signal Generator produces a tone as soon as it is inserted on a track. 
To mute the tone, use the Bypass button.

DC Offset Removal

The DC Offset Removal plug-in removes DC offset from your audio files. 
The term “DC offset” describes a specific type of audio artifact that might 
appears in digital audio signals.

The DC Offset Removal plug-in can be identified in a waveform overview 
because it appears to have a near-vertical fade-in with a constant or 
“steady-state” offset from zero when the file is actually “silent” (it contains 
no audible audio). The DC Offset Removal plug-in can help remove (or at 
least reduce) the DC offset from your source audio files. 

Time Compression Expansion

The Time Compression Expansion plug-in allows you to adjust the 
duration of any selected regions by increasing or decreasing the selection’s 
length without changing pitch. This function is particularly important in 
audio postproduction applications because it allows you to adjust sounds to 
specific time lengths or timecode durations for synchronization.
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n To change duration (length) and pitch simultaneously, use the Pitch Shift 
plug-in.

Master Clip Mode Parallel Processing

The Time Compression Expansion plug-in allows two tracks to be time-
compressed or expanded as a “stereo pair,” so that the two sides of the 
stereo signal are processed relative to each other.

The Time Compression Expansion plug-in has special parameters that let 
you enter time compression or expansion values in different formats, as 
explained below. They are located in the Source and Destination columns 
and also include the Ratio slider. Additional controls for fine-tuning the 
compression and expansion process are also included.
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To use the special control features:

• Press and hold the Ctrl key (Windows) or the k key (Macintosh) to 
engage slider fine-tune mode. 

• Alt+click (Windows) or Option+click (Macintosh) a field or slider to 
reset its default value.

Time Compression Expansion Parameters

The Time Compression Expansion plug-in has the following parameters:

Source and Destination

The Source text boxes display the length of the current selection before 
processing in each of the listed formats. All the text boxes in both columns 
are constantly active, and a change made to one value is immediately 
reflected in the values displayed in the other text boxes.

The text boxes in the Destination column display and control the length of 
the selection after processing by using the current settings. You can enter 
the length of the Destination file by double-clicking the appropriate text 
box in the Destination column. Type the number of samples in 
min:secs:msec format or type timecode values as start and end locations. 
All the Destination text boxes are constantly updated, and a change made 
to one value is immediately reflected in the values displayed in the other 
text boxes.

You can also enter a new tempo, bars:beats:ticks length, or time signature 
for regions that have tempo or Bars & Beats settings. This can be any 
region associated with a MIDI Metronome value (such as an overdub 
recorded to a MIDI click) or regions that have been processed with the Pro 
Tools Identify Beat command.

The Ratio slider lets you set the destination length in relation to the source 
length. Dragging the slider to the right increases the length of the 
destination file, and dragging the slider to the left decreases its length.

The controls below the bar line allow you to fine-tune the time 
compression and expansion process. They include the Crossfade, Min 
Pitch, and Accuracy sliders.
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Crossfade

The Crossfade slider allows you to manually adjust the crossfade length in 
milliseconds to optimize performance of the Time Compression Expansion 
plug-in according to the type of audio material you are processing. The 
Time Compression Expansion plug-in achieves length modification by 
replicating or subtracting very small portions of audio material and very 
quickly crossfading between these alterations in the waveform of the audio 
material.

Crossfade length essentially affects the amount of smoothing performed on 
audio material to prevent audio artifacts such as clicks. In general, small 
narrow-range time (length) changes require longer crossfades while larger 
changes in length require shorter crossfades. The disadvantage of long 
crossfade times is that they smooth the signal, including any transients. 
While this can be desirable for audio material such as vocals, it is not 
appropriate for material with sharp transients such as drums or percussion.

The default setting for this parameter is Auto (leftmost position), in which 
crossfade times are set automatically according to the percentage of 
change in length for the current process. This setting should be sufficient 
for most applications; however, you can use this slider to manually adjust 
and optimize crossfade times, if necessary. For audio material with sharper 
attack transients, use shorter crossfade times. For audio material with 
softer attack transients, use longer crossfade times. The slider has a range 
of 0 ms to 200 ms.

Min Pitch

The Min Pitch slider lets you select the minimum (lowest) pitch that will 
be used in the plug-in’s calculations during the time compression 
expansion process. The slider has a range of 40 Hz to 1000 Hz. By 
controlling the minimum pitch, you can focus the time compression and 
expansion process for maximum efficiency — it all depends on the audio’s 
spectral shape.
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This slider should be set lower when you process bass guitar or another 
instrument with a similarly low range. Set the min pitch higher when 
processing instruments such as snare drums, violins, and other higher 
range instruments and sounds. Experiment with combinations of the other 
fine-tune controls in relation to the Min Pitch slider.

Accuracy

Use the Accuracy slider to prioritize the processing resources allocated to 
audio quality (sound) or timing (rhythm). Dragging the slider toward 
sound generally results in better sonic quality and fewer audio artifacts. 
Dragging the slider toward rhythm puts the emphasis on keeping the tempo 
consistent. When working with loops, listen carefully and adjust accuracy 
until you find the setting that keeps timing solid within the region. Start 
and end times will be precise, but the perception of beats may be 
“shuffled” if the Accuracy slider’s rhythm setting is too low.

c The smallest time ratio allowed for time compression and expansion 
is 0.25. The largest time ratio allowed is 4.0.

n Normalizing a selection before applying time compression and expansion 
can sometimes produce better-sounding results.

Pitch Shift

The Pitch Shift plug-in allows you to adjust the pitch of any source audio 
file with or without a change in its duration. This powerful function allows 
sounds to be transposed a maximum of a full octave up or down in pitch 
with or without altering playback speed.
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Edit the Pitch Shift parameters by double-clicking and typing in any 
parameter text box or by clicking and dragging the sliders. All Pitch Shift 
plug-in controls are linked, so that changing one changes the others.

Pitch Shift Parameters

The Pitch Shift plug-in has the following parameters:

Gain

The Gain controls set the input level, in tenths of a decibel. The input level 
should be set so that the plug-in can adequately handle amplitude peaks in 
the selection. Dragging the slider to the right increases gain, and dragging 
the slider to the left decreases gain. 
101



 Chapter 2 Using AudioSuite Plug-Ins
Coarse and Fine

Adjust the pitch by dragging either of the two faders, or by typing values in 
the Coarse and Fine text boxes. The Coarse slider transposes in semitones 
(half steps); the Fine slider transposes in cents (hundredths of a semitone).

Time Correction

Clicking the Time Correction check box allows you to enable or disable 
time correction. 

c You can deselect the Time Correction check box if you are using the 
Create New Master Clips feature of the AudioSuite plug-ins. The Time 
Correction check box must be selected, however, when you are 
applying AudioSuite plug-ins to audio clips in the Timeline. 

If the Time Correction check box is deselected, it will have the effect of 
“permanently varispeeding” your audio file. Like working with tape, the 
file’s duration will be compressed or extended according to the settings of 
the Coarse and Fine controls. Playback speed will increase proportionally 
as the sound file is transposed up in pitch and decrease proportionally as it 
is transposed down in pitch, just like a tape recorder that is varispeeding.

Keep in mind that altering a file in this way has little detrimental effect on 
the fidelity of audio files, whereas time correction can affect fidelity in a 
pronounced way.

Ratio

The Ratio slider lets you set the amount of transposition (pitch change). 
Moving the slider to the right raises the pitch of the processed file, and 
moving the slider to the left decreases its pitch. Press and hold the Ctrl key 
(Windows) or the k key (Macintosh), and then click the slider and drag it 
to fine-adjust. 

n For a description of the Crossfade, Min Pitch, and Accuracy sliders, see 
“Crossfade” on page 99.
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Reference Pitch

The Reference Pitch feature generates a sine wave tone that you can adjust 
to match a selected portion of audio material and then use as an audible 
reference when pitch-shifting other audio material in your session. 

To use the Reference Pitch feature:

1. Select the audio material you want to use as a pitch reference. Click 
the Preview button to begin playback of the selected audio. 

2. Click the Reference Pitch button to activate the reference sine wave 
tone.

3. Adjust the note and detune settings to match the reference tone to the 
pitch of the audio playback. Adjust the level setting to change the 
relative volume of the reference tone. It might also be helpful to switch 
the Reference Pitch on and off to compare pitch.

4. Select the audio material to be pitch shifted. 

5. Adjust the Coarse and Fine sliders to match the pitch of the audio 
playback to the reference pitch.

EQ

There are two EQ plug-ins:

• 1-Band EQ II

• 4-Band EQ II

The EQ II plug-ins provide an enhanced “British EQ” sound that is favored 
by contemporary audio engineers and producers. 

EQ II Parameters

The EQ II plug-ins have the following parameters:

Input

Allows you to control the input gain of the EQ to prevent the possibility of 
clipping. 
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Phase Invert

Allows you to invert the phase (polarity) of the input signal to change 
frequency response between multi-miked sources (a common technique for 
miking a guitar amplifier) or to correct for miswired microphone cables.

Type

Allows you to select an EQ type (High-Pass, Low-Shelf, Peak, High-Shelf, 
or Low-Pass).

Gain

(Peak, High-Shelf, and Low-Shelf only) Allows you to control the amount 
that the selected frequencies are cut or boosted.

Freq

Allows you to designate the center of the frequency region to be cut or 
boosted.

Q

(Peak only) Allows you to set the bandwidth of the Peak filter. Higher 
values represent narrower bandwidths. Lower values represent wider 
bandwidths.

Bypass

Bypasses the EQ. The 4-Band EQ II has individual Bypass buttons for each 
band (black buttons with EQ curve icons).

High-Pass

Attenuates all frequencies below the selected cutoff frequency setting at a 
rate of 12 dB per octave while allowing all others above the frequency to 
pass through. For this reason, no gain control is available for this filter. 
High-pass filters can be useful for removing low-frequency rumble or 
thinning out the lower end of a sound for special effects, such as a 
“telephone simulation” effect.
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Low-Shelf

Produces a lift or a cut below the specified frequency.

Peak

Boosts or cuts only those frequencies around the selected center frequency. 
The Q button sets the bandwidth of the Peak filter, which determines the 
width of the filter’s overall slope — from a broad “bell” shape to a narrow 
notch. Broad curves tend to be most useful for musical applications. 
Narrow curves are useful for special-purpose processing such as hum 
removal. Higher values represent narrower bandwidths. Lower values 
represent wider bandwidths.

High-Shelf

Produces a lift or a cut at the specified frequency and above it.

Low-Pass

Attenuates all frequencies above the selected cutoff frequency setting at a 
rate of 12 dB per octave while allowing all others below the frequency to 
pass through. For this reason, no gain control is available for this filter.

Compressor

The Compressor plug-in reduces the dynamic range of signals that exceed 
a selected threshold by a specific amount. The increase of input signal 
needed to cause a 1-dB increase in the output signal of the compressor is 
called the compression ratio. With a ratio of 4:1, for example, an 8-dB 
increase of input produces a 2-dB increase in the output.

Audio material often varies in loudness, and can be above the threshold at 
one moment and below it the next. The Attack slider sets the Compressor’s 
response time, or attack. The Release slider sets the amount of time that it 
takes for the Compressor’s gain to return to its original level.
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Using Compression Effectively

To use compression most effectively, the attack time should be set so that 
signals exceed the threshold level long enough to cause an increase in the 
average level. This helps to ensure that gain reduction doesn’t decrease the 
overall volume. 

Release times should be set long enough so that if signal levels repeatedly 
rise above the threshold, they cause gain reduction only once. If the release 
time is too long, a loud section of the audio material could cause gain 
reduction that persists through a soft section. Of course, compression has 
many creative uses that break these rules.

The Compressor has built-in metering that allows you to monitor the 
amount of gain reduction taking place. The Gain Reduction meter usually 
remains at 0 level when the input signal is below the threshold, and falls to 
the left to show the amount of gain reduction in decibels when the input 
signal exceeds the threshold. 

Compressor Parameters

The Compressor plug-in has the following parameters:

Input Meter

Indicates the level of the unprocessed input signal to the Compressor.

Output Meter

Indicates the output level of the Compressor, including any gain 
compensation added via the Gain parameter.

Reduction

Indicates the amount of gain reduction in dB.
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Phase Invert

Allows you to invert the phase (polarity) of the input signal to change 
frequency response between multi-miked sources or to correct for 
miswired microphone cables.

Gain

Provides overall output gain adjustment. It allows you to compensate for 
heavily compressed signals. 

Threshold

Allows you to set the threshold level. Signals that exceed this level will be 
compressed. Signals that are below it will be unaffected. A level setting of 
0 dB is equivalent to no compression. Unlike scales on analog 
compressors, metering scales on a digital device reflect a 0-dB value, 
which indicates full scale (fs) — the full-code signal level. There is no 
headroom above 0 dB.

Ratio

Allows you to set the compression ratio. The range is based on decibels 
above the threshold. If this parameter is set to 2:1, for example, it will 
compress changes in signals above the threshold by one half. 

Attack

Allows you to set the Compressor’s attack time. The smaller the value, the 
faster the attack. The faster the attack, the faster the Compressor applies 
attenuation to the signal. In general, if you use fast attack times and heavy 
limiting, you should use a proportionally longer release time, particularly 
with material that contains many peaks in close proximity.

Release

Allows you to control how long it takes for the Compressor to be fully 
deactivated after the input signal drops below the threshold level. In 
general, if you use heavy compression, you should use proportionally 
longer release times. This will prevent pumping, which may occur when 
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the Compressor is forced to jump back and forth between compressed and 
uncompressed signal levels. Lengthening the release time will help smooth 
these changes in level by introducing a lag in the ramp-up and ramp-down 
times of attenuation. Use shorter release times on material with few peaks 
that do not occur in close proximity to each other.

Knee

Allows you to set the rate at which the compressor reaches full 
compression once the threshold has been exceeded. This parameter ranges 
from 0 (hardest response) to 200 (softest response). 

Graph

Displays the response curve set by the Compressor’s Threshold, Ratio, and 
Knee settings. As you adjust these parameters, refer to the graph to see 
how the shape of this curve changes. It allows you to see the effect of your 
settings.

External Key

This parameter has no effect on the AudioSuite plug-ins.

Key Listen

This parameter has no effect on the AudioSuite plug-ins.

Limiter 

The Limiter plug-in is used to prevent signal peaks from exceeding a 
chosen level so that they don’t overload amplifiers or recording devices. 
Most limiters have ratios of 10:1 or 20:1, although some provide ratios of 
up to 100:1. Large ratios effectively limit the dynamic range of the signal 
to a specific value by setting an absolute ceiling for the dynamic range.
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Limiting is used to prevent short-term peaks from reaching their full 
amplitude. Used carefully, limiting allows you to achieve higher average 
levels while avoiding overload (clipping or distortion) by limiting some 
short-term transients in the source audio. To prevent the ear from hearing 
the gain changes, use extremely short attack and release times. 

Limiting is used to remove occasional peaks because gain reduction on 
successive peaks wouldn’t be noticeable. If audio material contains many 
peaks, the threshold should be raised and the gain manually reduced so that 
only occasional, extreme peaks are limited.

The Limiter’s ratio is internally set to 100:1, and the attack time is 
automatically set to 0 milliseconds. The Limiter is similar to heavy 
compression. It can be useful for reducing pops and clicks, or for hard-
limiting dynamic range for broadcast or band-limited media such as 
cassette. 

Limiter Parameters

The Limiter plug-in has the following parameters:

Input Meter

Indicates the level of the unprocessed input signal to the Limiter.

Output Meter

Indicates the output level of the Limiter, including any gain compensation 
added via the Gain parameter.

Reduction

Indicates the amount by which the signal is being attenuated.

Phase Invert

Allows you to invert the phase (polarity) of the input signal to change 
frequency response between multi-miked sources or to correct for 
miswired microphone cables.
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Gain

Provides overall output Gain adjustment. 

Threshold

Allows you to set the threshold level. Signals that exceed this level will be 
limited. Signals that are below it will be unaffected. 

Attack

Allows you to set the Limiter’s attack time. The smaller the value, the 
faster the attack. The faster the attack, the faster the Limiter applies 
attenuation to the signal. In general, if you use fast attack times and heavy 
limiting, you should use a proportionally longer release time, particularly 
with material that contains many peaks in close proximity.

Release

Allows you to control how long it takes for the Limiter to be fully 
deactivated after the input signal drops below the threshold level. In 
general, if you use heavy limiting, you should use proportionally longer 
release times.This will prevent pumping, which may occur when the 
Limiter is forced to jump back and forth between limited and unlimited 
signal levels. Lengthening the release time will help smooth these changes 
in level by introducing a lag in the ramp-up and ramp-down times of 
attenuation. Use shorter release times on material with few peaks that do 
not occur in close proximity to each other.

Graph

Displays the response curve set by the Limiter’s Threshold setting. As you 
adjust this parameter, refer to the graph to see how the shape of this curve 
changes. It allows you to see the effect of your settings.

External Key

This parameter has no effect on the AudioSuite plug-ins.
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Key Listen

This parameter has no effect on the AudioSuite plug-ins.

Gate 

The Gate plug-in reduces noise by decreasing the gain of signals that fall 
below a user-selectable threshold. 

Gate Parameters

The Gate plug-in has the following parameters:

Phase Invert

Allows you to invert the phase (polarity) of the input signal to change 
frequency response between multi-miked sources or to correct for 
miswired microphone cables.

Gating (Reduction Meter)

Indicates the amount of reduction in dB.

Threshold

Allows you to set the threshold level. Signals that exceed this level will 
pass through. Signals that are below it will be gated, depending on the 
settings of the Attack, Hold, Decay, and Range parameters (explained 
below). 

Attack

Allows you to set the attack time of the Gate.

Hold

Allows you to specify a duration (in seconds or milliseconds) that the Gate 
will stay open after the initial attack cycle. This parameter can be used as a 
one-time function to keep the Gate open for longer periods of time with a 
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single crossing of the threshold. It can also be used to prevent gate chatter, 
which may occur if varying input levels near the threshold cause the Gate 
to open and close very rapidly.

Decay

Allows you to control how long it takes for the Gate to close after the 
signal falls below the threshold level.

Range

Sets the depth of the Gate when closed. This parameter has a maximum 
depth of –80 dB. Setting the Gate to higher range levels allows more of the 
gated audio that falls below the threshold to peek through the gate at all 
times. This is useful for problems such as drum leakage, where you might 
want to suppress the overall drum kit sound by a specific amount while 
emphasizing the gated instrument such as a snare.

Graph

Displays the response curve set by the Gate’s Threshold and Range 
settings. As you adjust these parameters, refer to the graph to see how the 
shape of this curve changes. It allows you to see the effect of your settings.

External Key

This parameter has no effect on the AudioSuite plug-ins.

Key Listen

This parameter has no effect on the AudioSuite plug-ins.

Expander/Gate 

The Expander/Gate plug-in reduces noise by decreasing the gain of signals 
that fall below a user-selectable threshold. Expanders are particularly 
useful for reducing noise or signal leakage that creeps into recorded 
material as the signal level falls, which often occurs with headphone 
leakage.
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Expanders can be thought of as soft-noise gates because they provide a 
gentler way of cutting off noisy low-level signals than the typically abrupt 
cutoff of a gate. If you want, however, you can use this plug-in as Gate by 
setting the Ratio to its maximum value and using short Attack, Decay, and 
Hold settings. 

Expander/Gate Parameters

The Expander/Gate plug-in has the following parameters:

Phase Invert

Allows you to invert the phase (polarity) of the input signal to change 
frequency response between multi-miked sources or to correct for 
miswired microphone cables.

Reduction Meter

Indicates the amount of signal reduction in dB.

Threshold

Allows you to set the threshold level. Signals that fall below the threshold 
will be reduced in gain. Signals that are above it will be unaffected. (When 
adjusting the Threshold slider, be sure that audio material is playing 
through the Expander/ Gate to see changes reflected in the Reduction 
meter.)

Ratio

Allows you to set the amount of expansion. If this parameter is set to 2:1, 
for example, it will lower signals below the threshold by one half. At 
higher ratio levels (30:1 or 40:1, for example), the Expander/Gate 
functions as a gate by reducing lower level signals dramatically. As you 
adjust the Ratio parameter, refer to the built-in graph to see how the shape 
of the expansion curve changes.
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Attack

Allows you to set the Expander’s attack time. This parameter determines 
how quickly a signal’s level is reduced once it falls below the threshold. 
This setting, along with the Ratio setting, allows you to control how soft 
the Expander’s gain reduction curve is.

Hold

Allows you to specify a duration (in seconds or milliseconds) that the 
Expander/Gate will stay open after the initial attack cycle. This parameter 
can be used as a one-time function to keep the Expander/Gate open for 
longer periods of time with a single crossing of the threshold. It can also be 
used to prevent gate chatter, which may occur if varying input levels near 
the threshold cause the Gate to open and close very rapidly.

Decay

Allows you to control how long it takes for the Gate to close after the input 
signal falls below the threshold level and the hold time has passed.

Range

Sets the depth of the Gate when closed. This parameter has a maximum 
depth of –80 dB. Setting the Gate to higher range levels allows more of the 
gated audio that falls below the threshold to peek through the Gate at all 
times.

Key HPF

This parameter has no effect on the AudioSuite plug-ins.

Key LPF

This parameter has no effect on the AudioSuite plug-ins.
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Graph

Displays the response curve set by the Expander/Gate’s Threshold, Ratio, 
and Range settings. As you adjust these parameters, refer to the graph to 
see how the shape of this curve changes. It allows you to see the effect of 
your settings.

External Key

This parameter has no effect on the AudioSuite plug-ins.

Key Listen

This parameter has no effect on the AudioSuite plug-ins.

Mod Delay 

The Mod Delay plug-ins provide time-delay-based effects. Effects 
obtained through the use of Mod Delay include slap echo, doubling, 
chorusing, and flanging. 

There are four Mod Delays, each of which is capable of a different 
maximum delay time:

• Short Delay provides 1024 samples of delay (23.2 ms at 44.1 kHz or 
21.3 ms at 48 kHz).

• Slap Delay provides 7186 samples of delay (162 ms at 44.1 kHz or 
149 ms at 48 kHz).

• Medium Delay provides 16384 samples of delay (371 ms at 44.1 kHz 
or 341 ms at 48 kHz).

• Long Delay provides 162474 samples of delay (3.68 seconds at 
44.1 kHz or 3.38 seconds at 48 kHz).

Mod Delay Parameters

The Mod Delay plug-ins have the following parameters:
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Input

Allows you to control the input volume of the delay to prevent clipping.

Wet/Dry

Allows you to control the balance between the delayed signal and the 
original signal. If you are using a delay for flanging or chorusing, you can 
control the depth of the effect somewhat with the Wet/Dry setting.

LPF (Low-Pass Filter)

Controls the cutoff frequency of the low-pass filter. This parameter allows 
you to attenuate the high-frequency content of the feedback signal. The 
lower the setting, the more high frequencies are attenuated.

Delay

Allows you to set the delay time between the original signal and the 
delayed signal.

Depth

Allows you to control the depth of the modulation applied to the delayed 
signal. 

Rate

Allows you to control the rate of modulation of the delayed signal.

Feedback

Allows you to control the amount of feedback applied from the output of 
the delay back into its input. It also controls the number of repetitions of 
the delayed signal. Negative Feedback settings give a more intense 
“tunnel-like” sound to flanging effects.
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Additional Supported Plug-Ins

The following AudioSuite plug-ins can be purchased separately and have 
been qualified for this version:

• Digidesign Intelligent Noise Reduction (DINR) — Broadband Noise 
Reduction (BNR)

• Focusrite d3

• Maxim

• Digidesign D-Fi

These plug-ins come with their own documentation. For more information, 
go to www.digidesign.com.

Digidesign Intelligent Noise Reduction (DINR) — Broadband 
Noise Reduction (BNR) 

The BNR feature of the Digidesign Intelligent Noise Reduction™ (DINR™) 
plug-in provides broadband and narrow-band noise reduction for 
suppressing unwanted elements such as tape hiss, air-conditioning rumble, 
and microphone preamplifier noise.

Focusrite d3

Focusrite® d3 is a high-quality, dynamics processor plug-in that contains a 
compressor and a limiter. The d3 compressor reduces the dynamic range of 
audio signals that exceed a user-selectable threshold by a specific amount. 
The d3 does this by reducing output levels when input levels increase 
above the threshold. 

The d3 limiter operates as a fast-attack compressor with a high 
compression ratio. Like the compressor, the limiter is activated when the 
signal exceeds a user-selectable threshold. The limiter then compresses any 
signal above the selected threshold to the lower threshold limit that you 
have set.

There are two versions of the plug-in:
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• ff d3 Mono, which operates on channels (tracks) separately.

• ff d3 Stereo, which operates on a composite of the two channels of the 
stereo signal. It prevents image shift when signal levels differ between 
the two channels.

Maxim

The Maxim™ plug-in performs peak limiting and sound maximizing. 
Maxim takes advantage of the random-access nature of disk-based 
recording to anticipate peaks in audio material and preserve their transient 
attacks when performing reduction. It helps to preserve the character of the 
original audio signal without clipping peaks or introducing distortion.

Digidesign D-Fi

The set of D-Fi™ plug-ins provides analog synthesizer effects: 

• Lo-Fi™ adds noise generation, bit-rate reduction, distortion, and 
saturation to sound.

• Sci-Fi™ adds analog synthesizer-type ring modulation, frequency 
modulation, and variable frequency resonator.

• Recti-Fi™ generates new harmonics and subharmonics through 
waveform rectification.

• Vari-Fi™ adds tape and turntable “start up” and “slow down” effects.
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Using an External Fader 
Controller or Mixer

This appendix describes how your Avid system supports the following 
external fader controllers or mixer for Audio Gain Automation recording:

• JL Cooper FaderMaster Pro MIDI automation controller. This low-
cost unit allows you to make fine adjustments to audio clips. This unit 
does not support “flying faders,” which means that the faders don’t 
move automatically as you record audio gain information and they 
must be zeroed manually prior to recording. For information on setting 
the faders manually, see “Position Indicator Lights” in the Help.

• JL Cooper MCS-3000X MIDI automation controller. This unit 
supports touch-sensitive flying faders. While recording gain, the faders 
automatically move. You can grab a fader and move it during an 
automation gain recording to quickly punch in a small change in 
volume.

• Yamaha 01V digital mixing console. This unit is a full-feature digital 
mixer that also supports Audio Gain Automation with flying faders. 
The faders are not touch sensitive. The Avid system uses the MIDI 
controller portion of the Yamaha 01V mixer for automation gain 
control.

n An external fader controller or mixer is optional. It is not required to 
perform Audio Gain Automation recording.

Table 49 compares the external fader controllers and mixer.
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The following list provides additional information on touch sensitivity and 
Snap mode:

• Touch sensitivity: As soon as you touch a moving fader on the 
MCS-3000X, the unit passes control of the fader to you. For more 
information, see “MCS-3000X Buttons” on page 128. 

On the Yamaha 01V, you must press the fader’s On button to gain 
control of a moving fader. For a description of how to control the 
faders on the Yamaha 01V, see “Operational Notes for the Yamaha 
01V” on page 134.

• Snap mode: In Snap mode, the fader controller automatically stops 
recording as soon as you release the fader. In addition, the fader 
continues to display the volume information in the Timeline. For more 
information, see “Using the Snap Mode Feature on the MCS-3000X” 
on page 129.

For more information on using these external fader controllers or mixer, 
see “Recording Automation Gain Information” in the Help.

Table 49 External Fader Controller and Mixer Features

Feature FaderMaster Pro MCS-3000X Yamaha 01V

Record gain Yes Yes Yes

Flying faders No Yes Yes

Touch-sensitive faders No Yes No

Solo/mute Yes Yes Yesa

Supports audio mixing No No Yes

Snap mode No Yes No

Number of steps of 
accuracy between 
0 – max

127 1023 255

a. Solo works only if you don’t use the unit for audio mixing.
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Configuring the USB-to-MIDI Software

The setup guide for your Avid system describes how to connect a fader 
controller to your Avid system. This section describes how to complete the 
connection by installing the USB-to-MIDI software and by configuring the 
software to recognize your fader controller.

The term fader controller applies to the following controllers:

• JL Cooper FaderMaster Pro MIDI automation controller

• JL Cooper MCS-3000X MIDI automation controller

• Yamaha 01V digital mixing console

Avid supports the MIDIMAN™ MIDISPORT™ 2x2 USB-to-MIDI 
converter. 

c To reduce traffic on the USB, connect the USB-to-MIDI converter only 
if you need to use the JL Cooper FaderMaster Pro, JL Cooper 
MCS-3000X, or Yamaha 01V fader box.

Installing USB-to-MIDI Software (Windows)

To install the MIDISPORT 2x2 driver software:

1. Make sure the MIDISPORT 2x2 USB-to-MIDI converter is not 
connected to the system. When you are ready to load the drivers, you 
will use a USB connector to connect the MIDISPORT 2x2 
USB-to-MIDI converter to your Avid system.

2. Download the latest MIDISPORT 2x2 drivers from the following Web 
site: 

www.m-audio.com

The system downloads a compressed, executable file.

3. Double-click the downloaded file to uncompress the driver files to a 
floppy disk or to a folder on your Avid system.

4. Double-click the Install.txt file included with the downloaded files. 
This file contains the instructions for loading the drivers.
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5. To initiate the driver installation, use a USB connector to connect the 
MIDISPORT 2x2 USB-to-MIDI converter to the system. It is not 
necessary to connect the external fader to the MIDISPORT 2x2 device.

The system automatically detects that a new device has been connected 
and opens the Found New Hardware Wizard dialog box.

6. Follow the instructions in the Install.txt file. 

n If you uncompressed the files to a folder on your system, two drivers might 
appear in the list. Choose either one.

Installing USB-to-MIDI Software (Macintosh)

n The Mac OS X operating system contains automatic support for USB-to 
MIDI devices.

To install the MIDISport 2x2 driver software:

1. Download the latest MIDISPORT 2x2 drivers from the following Web 
site: 

www.m-audio.com

The system downloads a compressed, executable file.

2. Double-click the downloaded file to uncompress the driver files to a 
floppy disk or to a folder on your Avid system.

3. Double-click the installer file. 

4. Follow the on-screen instructions to load the software.
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Testing the Fader Connections

To test the external fader controller connections:

1. Connect all MIDI hardware devices as described in the setup guide for 
your Avid system.

n MIDI port A is the default port used by the Avid system. To change the port 
configuration, see “Switching Between MIDI Connections on the USB-to-
MIDI Converter (Windows)” on page 124 and “Switching Between MIDI 
Connections on the USB-to-MIDI Converter (Macintosh)” on page 125.

2. Move the sliders on the fader controller, and confirm that the MIDI IN 
LED indicator on the USB-to-MIDI converter turns on and off 
appropriately.

The USB LED indicator pulses — this is expected behavior.

3. Start the Avid editing application, and select Tools > Automation Gain.

4. Click the Automation Gain Tool Fast Menu button, and select 
Calibrate Hardware Sliders.

If the external fader controller is connected and the system is using the 
correct MIDI port, then the Automation Gain tool displays the 
following:

- At least one of the position indicator light is on (blue).

- The Recording Status Light changes to gold.

5. If the lights do not change to blue, see “Troubleshooting the MIDI 
Connections” on page 126.

6. To disable the hardware calibration, click the Automation Gain Tool 
Fast Menu button, and select Calibrate Hardware Sliders.

The Recording Status Light changes to black.

7. Move the sliders on the external fader controller. 

The corresponding sliders move in the Automation Gain tool.

Now you are ready to use the fader controller with the Avid application 
software. For more information on using the Automation Gain tool, see  
“Using Audio Gain Automation” in the Help.

Position 
indicator 
lights
123



 Chapter 3 Using an External Fader Controller or Mixer
Switching Between MIDI Connections on the USB-to-MIDI 
Converter (Windows)

By default, the system expects the MIDI cables to be connected to MIDI 
port A (OUT-A and IN-A) on the MIDISPORT 2x2 device. If you need to 
switch to a different port connection, create a system environment variable 
as described in this section.

To switch between MIDI port connections:

1. Make sure the cables on the MIDISPORT 2x2 USB-to-MIDI converter 
are connected to the port you want to use. For information on 
connecting the MIDISPORT device to the fader controller, see the 
setup guide for your Avid system.

2. Click the Start button, and select Settings > Control Panel.

3. Double-click System.

The System Properties dialog box opens.

4. Click the Advanced tab.

5. Click the Environment Variables button.

The Environment Variables dialog box opens.

6. Do one of the following:

t To switch from port A to port B:

a. Click New in the System Variables area.

The New System Variables dialog box opens.

b. Type OTHER_MIDI_PORT in the Variables Name text box.

c. Type 1 in the Variable Value text box.

d. Click OK.

The OTHER_MIDI_PORT entry appears in the System 
Variables list of the Environment Variables dialog box.

t To switch from port B to the default port A:

a. Select OTHER_MIDI_PORT in the System Variables list.

b. Click Delete.
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7. Click OK.

8. Click OK to close the System Properties dialog box.

9. Start the Avid application, and then select Tools > Automation Gain.

The indicator lights on the Automation Gain tool should change to 
blue. If the lights do not change to blue, see “Troubleshooting the 
MIDI Connections” on page 126.

Switching Between MIDI Connections on the USB-to-MIDI 
Converter (Macintosh)

By default, the system expects the MIDI cables to be connected to MIDI 
port A (OUT-A and IN-A) on the MIDISPORT 2x2 device. If you need to 
switch to a different port connection, use a Console command to 
reconfigure the Avid system.

To switch between MIDI port connections:

1. Select Tools > Console.

The Console window opens.

2. Type SelectMIDIPort in the text box, and press Return.

The system displays information for each port it recognizes. For 
example, with a MIDISPORT 2x2 MIDI device connected using MIDI 
connection A, the system displays the following information:

* 1: Device: MIDISport Port: Port A

2: Device: MIDISport Port: Port B

The asterisk indicates the port being used. In this example, port A is 
being used.

3. To switch to another port, type SelectMIDIPort n.

Replace n with the port number you want to use, for example, 1 for 
port A, 2 for port B, and so on.
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Troubleshooting the MIDI Connections

Perform the following procedures if the Automation Gain tool does not 
respond to the external fader controller.

1. Make sure the MIDI hardware devices are connected as described in 
the setup guide for your Avid system.

2. Make sure the MIDISport driver software is installed. See “Installing 
USB-to-MIDI Software (Windows)” on page 121 and “Installing 
USB-to-MIDI Software (Macintosh)” on page 122.

3. Check that the MIDI cable connections match the port configuration of 
the Avid system:

a. Select Tools > Console.

b. Locate the following lines in the Console window:

For Windows:

Midi In device: In-A USB MidiSPORT 2x2

Midi Out device: Out-A USB MidiSPORT 2x2

For Macintosh:

Type SelectMIDIPort in the text box and press Return.

* 1: Device: MIDISport Port: Port A 
2: Device: MIDISport Port: Port B

The asterisk indicates the port being used. In this example, port A 
is being used.

c. Check that the MIDI connections on the MIDISPORT 2x2 
USB-to-MIDI converter match the connections listed in the 
Console window (either A or B).

d. If necessary, quit the Avid application, switch the MIDI cables to 
match the output in the Console window, and then restart the Avid 
application.

e. If the position indicator lights are still not blue, recheck the 
connections according to the instructions in the setup guide.

4. (Macintosh only) Use the Apple System Profiler to check whether the 
system is recognizing the MIDI device:

Position 
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Using the FaderMaster Pro and MCS-3000X
a. Select Apple P menu > About This Mac.

b. Click More Information.

The Apple System Profiler opens.

c. Click the Devices and Volumes tab.

The USB Information portion of the display identifies the USB 
devices that the system recognizes. The system might not display 
the name of each device, but the number of USB devices should 
match the number of devices you have connected to the system.

Using the FaderMaster Pro and MCS-3000X

The setup procedure is similar for both units. To connect and initialize the 
fader controllers, see the setup guide for your system.

c For the MCS-3000X to recognize the Avid application software, you 
must set the rear DIP switch #4 down (ON).

To test the external fader controller:

1. Select Tools > Automation Gain. 

The Automation Gain tool opens.

2. Click the Automation Gain Tool Fast Menu button, and select 
Calibrate Hardware Sliders.

The box changes to blue.

3. Check the color of the position indicator lights. If the external fader 
controller is connected, at least one of the lights should be on (blue). If 
the external fader controller is not connected properly, the lights will 
probably appear gray.

4. Move the faders on the external fader controller. 

The corresponding fader should move in the Automation Gain tool.

n An external fader controller is optional. It is not required to perform Audio 
Gain Automation recording.

Position 
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lights
127



 Chapter 3 Using an External Fader Controller or Mixer
MCS-3000X Buttons

There are four rows of unlabeled buttons at the top of the MCS-3000X 
fader controller. 

The following illustration labels each row of buttons:

• Select buttons: The green light next to the Select button for a track is 
on when you are recording Audio Gain Automation on the track. The 
green light is off when you are listening to the volume level in the 
Timeline.

If the track is in Snap mode, as soon as you touch the fader, the Select 
button light turns on to indicate that you are recording. When you 
release the fader, the Select button light turns off and the fader begins 
moving with the Timeline volume.

When the track is not in Snap mode, as soon as you touch the fader, the 
Select button light turns on to indicate that you are recording. 
However, when you release the fader, the Select button light stays on, 
indicating that you are still recording. To stop recording, press the 
Select button.

• Snap Mode buttons: For information on these buttons, see “Using the 
Snap Mode Feature on the MCS-3000X” on page 129.

• Solo buttons: These buttons solo the selected tracks.

• Mute buttons: These buttons mute the selected tracks.

Select

Snap Mode

Solo

Mute
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Using the Snap Mode Feature on the MCS-3000X

The MCS-3000X has a Snap Mode button for each track that allows you to 
easily punch-in and punch-out small sections of automation gain 
information. The second row from the top contains the Snap Mode buttons. 
For more information on button locations, see “Understanding The 
Automation Gain Tool” in the Help.

In Snap mode, the fader automatically stops recording as soon as you 
release the fader. In addition, the fader continues to display the volume 
information in the Timeline.

To use Snap mode:

1. Click the Snap Mode button for the appropriate tracks on the external 
fader controller. You can click the button before or during a recording 
session.

2. Set your IN and OUT points, and click the Record button. The system 
begins playing the section and the faders move accordingly.

3. When you want to make an adjustment, grab the fader and move it to 
change the volume. The system immediately begins recording.

4. When you are finished adjusting the section, release the fader. The 
system stops recording (but keeps playing) and the fader snaps back to 
the level that is in the Timeline.

When the track is not in Snap mode, the system continues to record audio 
volume information after you release the fader. Press the Select button (top 
row) to stop recording and snap the button back to its current Timeline 
position.

The green light next to the Select button for a track is on when you are 
recording Audio Gain Automation on the track. The green light is off when 
you are listening to the volume level in the Timeline.
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Ganging Faders on the FaderMaster Pro

You can use the features available on the FaderMaster Pro to gang faders. 
When the faders for two tracks are ganged, the fader sends identical 
volume messages for both tracks when you move one fader. This can be 
useful when you have stereo tracks. 

The ganged faders do not move together physically. For information on 
ganging the faders, see the FaderMaster Pro user’s manual. 

For example, if you have two stereo tracks and want to gang faders 1 and 2 
to respond to movement on fader 1:

1. On the FaderMaster Pro, press the PROG button to light the Fader 
LED.

2. Press the Group button, and move fader 2 until 1 is displayed.

3. Press the PROG button to turn off the Fader LED.

Now, when you move fader 1, the Avid system will receive identical 
volume information for fader 2.

To turn off the group feature, repeat steps 1 to 3, but assign fader 2 to 0.

n You cannot gang faders on the MCS-3000X fader controller or Yamaha 
01V mixer.

Using the Yamaha 01V

The Avid system supports the Yamaha 01V digital mixing console. The 
Yamaha 01V is a fully functional digital audio mixer that also supports 
Automation Gain recording. 

The following illustration shows the Yamaha 01V controls. The exploded 
view shows the buttons that you use to operate the unit for Audio Gain 
Automation recording. For a comparison with external fader controllers, 
see Table 49.
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Setting Up the Yamaha 01V

This section describes how to set up the Yamaha 01V digital mixer. For 
instructions on connecting the Yamaha 01V to your Avid system, see the 
setup guide for your system.

Initializing the Yamaha 01V

This section describes how to initialize the Yamaha 01V digital mixer. 
These steps should have to be done only once and repeated only if the 
mixer’s operational parameters have been manually changed to settings 
that are incompatible with the Avid system. 
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You should perform these steps when you first set up the unit. You might 
also find it necessary to perform the steps if the unit stops working 
correctly with your Avid system. Because you can perform a wide variety 
of mixing tasks with the Yamaha 01V, it is possible that some changes you 
make to the unit might cause it to stop working with the Avid system. If 
this happens, use these steps to reinitialize the mixer to the factory defaults.

To return to factory defaults:

1. Turn on the mixer while pressing and holding the red Memory button.

The LCD panel displays a message asking if you want to reset the 
system.

2. Answer yes by pressing the +1/inc button.

Configuring the Mixer to Recognize MIDI Control Messages

After you initialize the mixer, you must configure it to receive and transmit 
MIDI messages.

To reconfigure the mixer:

1. Press the MIDI button.

The system displays the first pane of the MIDI Options window.

2. Set the following controls in the MIDI Options window:

- Set Control Change TX to ON.

- Set Control Change RX to ON.
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Starting the Avid System with the Yamaha 01V Attached

When you start your Avid system with the Yamaha 01V attached, you can 
use the faders for mixing audio channels or for performing Audio Gain 
Automation recording. You use the Home and Option I/O buttons to switch 
between the two modes. This section describes how the Yamaha 01V 
utilizes the faders.

The Yamaha 01V digital mixer allows you to work with 24 input channels 
as follows:

• 12 mono input channels (1 through 12)

• 2 stereo input channels (13/14 and 15/16)

• 8 digital inputs (17 through 24)

Channels 17 through 24 use the same physical controls as channels 1 
through 8, as shown in the following illustration. You use the Home and 
Option I/O buttons to switch the assignments from 1 through 8 to 17 
through 24.

When you start the Avid system, it automatically configures the Yamaha 
01V to use channels 17 through 24 for automation gain control. Use the 
Home and Option I/O buttons to switch between audio mixing (Home) and 
audio gain recording (Option I/O).

n The Yamaha 01V supports a digital I/O option that uses channels 17 
through 24. If you intend to use the digital I/O option, you should move the 
digital I/O option to channels 1 through 8 by using the Swap mode. You can 
access Swap mode from pane 5 of the OPTION I/O screen. For more 
information, see the Yamaha documentation.
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Operational Notes for the Yamaha 01V

Using the Yamaha 01V for Audio Mixing

To access the audio mix (channels 1–16):

t Press the Home button. When the Home button is lit, you can use the 
faders for audio mixing.

For information on audio mixing, see the Yamaha 01V documentation.

Accessing Audio Gain Automation Recording 

To record automation gain in the Automation Gain tool, you must be 
in Option I/O mode, and then do the following:

1. Press the Option I/O button.

The faders move into the correct position for recording automation 
gain.

2. When recording automation gain, use the On button on each channel to 
switch between Timeline control of audio gain to user control of audio 
gain. 

You can punch-in and punch-out of gain recording as many times as 
you want. 

The Yamaha 01V faders are not touch sensitive in the same way as the 
JL Cooper MCS-3000X MIDI fader controller. As soon as you touch a 
moving fader on the MCS-3000X, the unit passes control of the fader to 
you. On the Yamaha 01V, you must press the fader’s On button to gain 
control of a moving fader.

n If a fader is not moving, you can move the fader to take control without 
pressing the On button.

c If you attempt to catch a moving fader, the mixer will try to control the 
fader. Press the On button to take control of the fader.
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Soloing Avid System Channels

If you are not using the Yamaha 01V to mix the audio outputs of the Avid 
system, you can use the Solo button on the Yamaha 01V to solo audio 
channels during automation gain recording.

To enable Solo mode:

1. Press the MIDI button.

The mixer displays pane 1 of the MIDI Options window in the LCD 
display.

2. Set the following controls in the MIDI Options window:

- Set Param Change TX to ON.

- Set Param Change RX to ON.

If Solo mode is on when you are mixing audio, however, it interferes with 
the normal operation of the mixing board functions. If the Avid system 
audio outputs are connected to the Yamaha 01V, leave the Param Change 
TX and Param Change RX controls set to OFF. 
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Chapter 4

Working with Broadcast 
Wave Format (BWF) Files

Avid editing applications support Broadcast Wave Format (BWF), an 
industry-standard audio file format that supports metadata. This metadata 
can include the shoot date, scene, take, and other production information.

This appendix includes the following sections:

• Support for BWF Files

• BWF Information Displayed in Bins

• Preparing Custom BWF Information

• Importing and Syncing BWF Files

• Reimporting BWF Files

Support for BWF Files

Avid editing applications support any BWF files that adhere to the BWF 
specification. Some BWF information always appears in bin columns. 

You can use Avid-specific coding to add additional information. Currently, 
the following vendors have products that can provide this additional 
information:

• Aaton

• Zaxcom
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• Nagra

• Fostex 

Avid editing applications support 24-bit audio data, and up to 16 tracks in a 
single file. You can use the AutoSync™ feature to sync these tracks. You 
can also use AutoSync to sync picture and sound.

BWF Information Displayed in Bins

The following information from BWF files always appears in bin columns:

Preparing Custom BWF Information

Additional information can be displayed in bin columns, but this 
information needs to be coded in a particular format. The recording device 
must provide this information in the BWF Description field, using the 
following keyword/value pairs: 
uKEYWORD=data[CR/LF]

Bin Column BWF Source

Clip name Imported file name. If scene and take information is 
provided, the clip name is created as scene/take.

Tape ID Imported file name

Start The start timecode specified in the file.

Shoot date The origination date specified in the file.

Tape Name If there is no tape name specified in the file, a name is 
created by concatenating the origination date and the 
imported file name.
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Preparing Custom BWF Information
For example, 
uSCENE=1A[CR/LF]

after importing, displays “1A” in the Scene column of the bin into which it 
was imported.

The following table describes how to code BWF information for particular 
bin columns:

Syntax Definition

u Letter code of the manufacturer. Use the letter u unless 
otherwise instructed by Avid.

KEYWORD Designation of the bin column.

= Terminates the keyword.

data Information to include in the bin column.

[CR/LF] (carriage return/line feed) Terminates the data.

Bin Column BWF Source

Comments (editable text field 
that appears in the bin script 
view)

uNOTE=x, where x is text.

Scene uSCENE=x, where x is text.

Take uTAKE=x, where x is text.

Tape Name uTAPE=x, where x is text. If there is no tape 
name specified, a name is created by 
concatenating the origination date and the file 
name.

TRK1 through TRK8 uTRKn=x where n is the track number, and x is 
text.
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In addition, to assign a file to a particular track number, the file name needs 
to end in _n, -n, or a space followed by n (where n is the track number). For 
example, a file named Orchestra_1.bwf would create the audio on track 
A1.

To avoid display of a dialog box during import, you can specify the frame 
rate using the following syntax:
uFRAMERATE=nDF or
uFRAMERATE=nND

where nn is the frame rate (25, 29.97, or 30), DF is drop-frame, and ND is 
non-drop-frame.

Importing and Syncing BWF Files

You can import BWF files into an Avid editing application approximately 
10 to 12 times faster than capturing in real time. The files maintain pure 
digital quality for all audio post processing. For basic information on 
importing audio files, see the documentation for your Avid system.

Take uTAKE=x, where x is text.

Tape Name uTAPE=x, where x is text. If there is no tape 
name specified, a name is created by 
concatenating the origination date and the file 
name.

TRK1 through TRK8 uTRKn=x where n is the track number, and x is 
text.
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Importing and Syncing BWF Files
During import of NTSC BWF files, if no frame rate is specified in the file, 
a dialog box appears and asks if the conversion should use 29.97 fps or 
30 fps , and drop-frame or non-drop-frame. Your choices depend on how 
the audio was recorded.

After you capture video, use the AutoSync™ feature to sync picture and 
sound or multiple tracks of sound. If you are using BWF files from a 24-
fps shoot in a PAL project, you must use use the PAL Method 2 approach, 
in which picture and sound are captured separately.

If you are working in a PAL 24p project, you need to take an extra step to 
make sure the picture and sound are correctly synced.

To import and sync BWF files:

3. Create a project, based on the source footage.

4. Import the log file, and capture the video footage.

5. Import the BWF file into the same bin in which you captured the video 
footage.

6. For 24p PAL projects, you need to create a new bin column:

a. Highlight the Start timecode column.

b. Select Edit > Duplicate.

c. From the list of columns, select Aux TC 24 and click OK.

d. In the dialog box, click Convert.

e. Display the Auxiliary TC1 column.

f. Highlight the Aux TC 24 column, and copy it to the Auxiliary TC1 
column.

Use Auxiliary TC 1 only as a sync point reference for AutoSync. Do 
not use it for data tracking or EDL generation. 

Use the Aux TC24 column to generate a 24-frame EDL for audio only. 
Use the Film TC column to generate a 24-frame EDL for video only. 
This timecode field represents the video timecode of a HD 
downconvert to standard definition video. 
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7. Make sure all entries in the Shoot Date column use the same syntax. 
Currently, some BWF files use the format 2003/10/03 as the Shoot 
Date while some ALE files use 2003-10-03. This field is used as part 
of the AutoSync process to guarantee the uniqueness of the timecode. 
To fix this problem, do one of the following:

- Manually change the format of one set of clips to match the other. 

- If you do need the information, create a custom column with a 
different name, select Edit > Duplicate to copy the information 
into the custom column, and delete the Shoot Date column.

8. Highlight the picture and audio clips and select Bin > AutoSync.

9. For 24p PAL projects, use Auxiliary TC1 as a sync point. For other 
projects, use the Start timecode.

The editing application creates new subclips with synced picture and 
sound, which are ready for editing. 

Reimporting BWF Files

You can reimport BWF files in the same way as you reimport other audio 
files. You can also batch capture from a source tape, because the clips are 
associated with a tape name. For more information on reimporting and 
batch capturing, see the documentation for your Avid system.
142



Chapter 5

Film-to-Tape Transfer 
Methods

To capture and edit film-originated footage in your Avid system, you must 
transfer the footage to videotape. This chapter presents the following 
information about film-to-tape transfer methods:

• Understanding the Transfer Process

• Transferring 24-fps Film to NTSC Video

• Transferring 24-fps Film to PAL Video

• How the Avid System Stores and Displays 24p and 25p Media

To help you plan the transfer, this chapter includes the following sections:

• Film-to-Tape Transfer Guidelines

• Film-to-Tape Transfer Options

Understanding the Transfer Process

You have your film rolls from the day’s shooting, and you’re ready to edit 
on your Avid system. To capture that footage into the system, you first 
need to transfer the film to videotape. This process uses a special film 
projector called a telecine (the term loosely translates as “video-film”). 
The telecine is usually part of a production system that includes audiotape 
recorders, a controller, and other equipment.
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After you’ve decided on a telecine facility and have supplied your 
requirements (see “Film-to-Tape Transfer Guidelines” on page 154 and 
“Film-to-Tape Transfer Options” on page 155), the telecine facility 
performs the film-to-tape transfer. The steps in the process differ, 
depending on whether you include audio and whether the transfer produces 
NTSC or PAL videotapes. The following sections describe these steps.

Transferring 24-fps Film to NTSC Video

If you use an NTSC transfer, the film-to-video process takes place in two 
stages:

• Stage 1: Transferring Film to Video

• Stage 2: Digitizing at 24 fps

The following illustration shows a simplified view of the NTSC film-to-
video transfer process. For information about this workflow, see “Planning 
a 24p or 25p Project” in the Help.

Telecine 

Avid editing system at 24 fps

Betacam or
Digital Betacam

Beta-
cam

Capture and reverse
pulldown to 24 fps.

video signal 29.97 fps
Film shot at 24 fps

2:3 pulldown

Stage 1 Stage 2

23.976 fps
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Transferring 24-fps Film to NTSC Video
Stage 1: Transferring Film to Video

The NTSC film-to-video transfer occurs as a two-part process: the telecine 
adds extra frames during transfer and, at the same time, slightly reduces the 
film’s running speed.

Frames Versus Fields

To understand how the telecine transfers film to videotape, you need to 
understand the relationship between frames and fields. 

An NTSC video image consists of 525 horizontal lines of information. The 
electron gun on a video monitor displays the odd-numbered lines first and 
then the even-numbered lines. Each full scan of odd-numbered or even-
numbered lines constitutes a field. At 30 fps, each field takes 1/60th of a 
second to display; therefore, an entire frame of two fields is scanned each 
1/30th of a second. The combination of these two fields (odd and even) is 
called interlacing.

A film frame, in contrast, is one full picture; it has no fields. The telecine 
process takes each film frame and creates a two-field video frame. 

Part 1: Using a 2:3 Pulldown to Translate 24-fps Film to 30-fps Video

Film runs at 24 fps, and NTSC video runs at 30 fps. The difference in 
frame rates between film and video prevents a direct frame-to-frame 
transfer.

To compensate, the telecine process creates an extra six frames every 
second (the difference between 24 and 30). That is, it creates five video 
frames for every four film frames. But remember, each video frame is 
subdivided into two video fields. To be more precise, the telecine creates 
ten video fields (the equivalent of five video frames) for every four film 
frames. This is referred to as a 4:5 ratio.  Table 50 states this relationship 
between film and video.
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The telecine uses a method known as pulldown to create the extra frames. 
As each film frame moves through the telecine projector, it is held in place 
(pulled down) while a specific number of fields are recorded on videotape. 
To transfer four film frames to ten video fields, the telecine process 
alternates between creating two and three video fields per film frame 
(referred to as 2:3 pulldown). To transfer four film frames to ten video 
fields, the telecine pulls down the first film frame and records two video 
fields, pulls down the second film frame and records three video fields, and 
repeats the process.

The four frames in each series are referred to as A, B, C, and D. The 
standard method for identifying the resulting fields is to label them as A1, 
A2, B1, B2, and so forth. The following diagram illustrates the 2:3 
pulldown process.

Table 50 Ratio of Film to Video

Film Video

24 fps 30 fps

4 frames 5 frames (10 fields)

A

B

C

D

A1

Five NTSC video frames (ten fields)Four film frames

A2

B1

B2

B3

C1

C2

D1

D2

D3

Timecode change

Timecode change

Timecode change

Timecode change

odd

even

odd

even

odd

even

odd

even

odd

even
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Transferring 24-fps Film to NTSC Video
The telecine alternates between capturing odd-numbered and even-
numbered fields. For example, B1 and B3 both contain the odd-numbered 
scan lines of the B film frame. Later in the transfer process, when the Avid 
system captures the fields, it must capture an odd-numbered and an even-
numbered field for each frame.

When you view the resulting video, you get the impression that you are 
watching the video at 24 fps even though it is playing at 30 fps (or more 
precisely, at 29.97 fps).

Part 2: Slowing the Film Speed to 23.976 fps

NTSC video, the broadcast standard used in the United States, Japan, and 
other countries, plays at an actual rate of 29.97 fps, although it is usually 
referred to as 30 fps.

An accurate conversion requires exact adherence to the 4:5 ratio, but this 
ratio breaks down when you compare 24 fps to 29.97 fps. To achieve a true 
4:5 ratio, the film frame rate is slowed down to 23.976 fps. The telecine 
process makes this correction automatically, slowing NTSC video 0.1 
percent from the original film speed, so that the video plays at 99.9 percent 
of its original speed.

Table 51 adds this new ratio.

Table 51 Ratio of Film to Video with FPS

Film Video

24 fps 30 fps

4 frames 5 frames (10 fields)

23.976 fps (0.999 x 24) 29.97 fps (0.999 x 30)
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Maintaining Synchronized Sound

In most cases, the sound for your production has been recorded on a digital 
audio system, such as a DAT (digital audiotape), or ¼-inch tape system, 
such as a Nagra recorder. You need to synchronize the sound with the 
picture and make sure they are in sync in the Avid system. You can take 
one of three basic paths:

• Transfer the original sound recording to mag track, sync the mag track 
to the film work print, and transfer both to videotape through a telecine 
process.

• Sync the original sound recordings to picture during the telecine 
process, and transfer both to videotape.

• Transfer only the picture through the telecine process, capture picture 
and sound separately, and sync them in the Avid system.

If the telecine transfers sound along with picture (one of the first two 
paths), the sound is slowed by 0.1 percent to maintain sync with the 
picture. The reference signal slows from 60 Hz to 59.94 Hz and the rate at 
which the audio is recorded changes from 44100 Hz to 44056 Hz, or from 
48000 Hz to 47952 Hz.
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Transferring 24-fps Film to NTSC Video
Stage 2: Digitizing at 24 fps

The telecine has converted your film footage into video running at 
29.97 fps. Now you’re ready to use the digitizing process to input the 
material as a 24p NTSC project.

To capture audio 
transferred at 29.97 fps 
(video rate) you must 
set the pulldown switch 
to 0.99 in the Capture 
tool. For more 
information, see 
“Setting the Pulldown 
Switch” in the Help.

During the digitizing process, the Avid system reverses the pulldown 
procedure to capture the film footage at 24 fps. It removes the extra fields 
added by the pulldown process to create full-frame, 24p media. The 
capture process captures video and audio at the slowed-down speed 
(0.999). 

The following illustration shows each stage of the film-video-24p process.

If you have transferred sound along with picture, the Avid system captures 
audio at the slowed-down speed. Then during editing and playback, the 
system speeds up the play rate by 0.1 percent to play in sync with the 
24-fps video. Audio plays at 44100 Hz (44.1 kHz) or 48000 Hz (48 kHz).

Now you can edit the material at 24 fps on the Avid system. This approach 
ensures that all your edits correspond to true film frames so you see an 
accurate representation of the finished film.

A

B

C

D

A1

Five NTSC video frames (ten fields)Four film frames

A2

B1

B2

B3

C1

C2

D1

D2

D3

A

B

C

D

Four captured frames

Film at 24 fps Betacam or Digital Betacam
29.97 fps

24p media at 24 fps

odd

even

odd

even

odd

even

odd

even

odd

even

Skip this field.

Skip this field.
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Transferring 24-fps Film to PAL Video

If you use a PAL transfer, the film-to-video process also takes place in two 
stages:

• Stage 1: Transfer the film to videotape by speeding up the film rate 
during the telecine process.

• Stage 2: Capture the transferred videotape into the Avid system at the 
sped-up rate.

The following illustration shows a simplified view of the PAL film-to-
video transfer process. For information about this workflow, see “Planning 
a 24p or 25p Project” on page 229.

There are two approaches to synchronizing sound, which are often referred 
to as PAL Method 1 and PAL Method 2. 

PAL Method 1

With PAL Method 1, you synchronize sound with picture during the 
telecine process. 

Stage 1: Transferring Sound and Picture to Videotape

Some PAL film-to-tape 
transfers use pulldown. 
This method is not 
currently supported in 
Avid systems.

As with an NTSC film-to-tape transfer, the telecine process creates two 
video fields for each film frame. However, because the film rate of 24 fps is 
close to the PAL video rate of 25 fps, most PAL film-to-tape transfers 
involve simply speeding up the frame rate. This speedup changes the frame 
rate from 24 to 25 (an increase of 4.1 percent). There is no pulldown that 
creates extra fields.

Telecine 

Avid editing system at 24 fps

Betacam or
Digital Betacam

Beta-
cam

Capture 

video signal 25 fps
Film shot at 24 fps

transfer with
4.1% speedup

Stage 1 Stage 2
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Transferring 24-fps Film to PAL Video
With PAL Method 1, there are two ways to sync sound with picture in the 
telecine process:

• Transfer the original sound recording to mag track, sync the mag track 
to the film work print, and transfer both to videotape through a telecine 
process.

• Sync the original sound recordings to picture during the telecine 
process, and transfer both to videotape.

In either case, the telecine process speeds up sound at the same rate as 
picture: 4.1 percent.

Stage 2: Digitizing at 24 fps

After you’ve received the PAL transfer tapes, the next step is digitizing the 
footage in a 24p PAL project. During the digitizing process, the Avid 
system captures the material at the PAL rate of 25 fps, capturing every 
picture frame. It stores the two video fields as a single progressive frame, 
which you edit at 24 fps.

n You must capture audio along with video at the PAL rate of 25 fps if you 
want to use audio that was transferred along with picture during the 
telecine process. You set the Audio Transfer rate as Video Rate (100+%) in 
the New Project dialog box. For more information, see “Audio Transfer 
Options for 24p PAL Projects” in the Help.

Select this option in the 
Film Settings dialog 
box. For more 
information, see 
“Selecting Settings” in 
the Help.

You have the option of playing back the footage at 24 fps or 25 fps. If you 
select 24 fps, the system slows both the picture and the sound by 
4.1 percent for playback. This approach lets you edit at the original film 
rate, but the slowdown creates a limitation for audio. Because you capture 
the audio at a rate faster than playback, some audio samples are duplicated 
during playback, and sound quality is compromised.

If you select 25 fps, there is a different limitation with audio. Because you 
are playing back at the sped-up rate (4.1 percent), the audio pitch rises 
slightly. This is usually acceptable for broadcast, so PAL Method 1 is 
primarily used for PAL television broadcast.
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PAL Method 2

With PAL Method 2, you capture sound and picture separately.

Stage 1: Transferring Picture to Videotape

Some PAL film-to-tape 
transfers use pulldown. 
This method is not 
currently supported in 
Avid systems.

With PAL Method 2, you use the same telecine process for picture (create a 
video frame of two fields for each film frame, speed up rate by 
4.1 percent). The difference is that you do not synchronize sound as part of 
the telecine process.

Stage 2: Digitizing at 24 fps

Now that you have your picture-only videotapes (at the rate of 25 fps) and 
your source recording tapes, you need to follow a two-step process:

1. Capture the picture to create 24p media.

2. Capture the sound at the film rate of 24 fps. 

n When you created the project, you set the Audio Transfer rate as Film Rate 
(100%) in the New Project dialog box. For more information, see “Audio 
Transfer Options for 24p PAL Projects” in the Help.

In most cases, you will choose to edit at 24 fps. The sound will maintain 
source quality (44.1 kHz and 48 kHz) and will play in sync with 24-fps 
video.

PAL Method 2 is used primarily for film projects.

How the Avid System Stores and Displays 24p and 
25p Media

When the Avid system captures video that has been transferred from film 
(or video shot at 24 fps), it creates 24p media. It creates this media by 
capturing the video fields, by dropping extra pulldown fields (NTSC 
transfers only), by combining (deinterlacing) two fields for each film frame 
(A1+A2, B1+B2, and so forth), and by storing the fields together as a full 
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How the Avid System Stores and Displays 24p and 25p Media
frame. The system always stores media as a fully reconstructed, 
progressive frame. It is the construction of this full frame that gives you the 
flexibility to create multiformat output. 

You typically use 25p media when digitizing film or video shot at 25 fps. 
In this case, the system also stores the media as a fully reconstructed, 
progressive frame. The difference is that there is no need for pulldown 
fields since there is a 1:1 correspondence between the source tape and the 
captured frames.

Displaying Media While Editing

When you click the Play button while editing a clip or a sequence 
(sometimes referred to as Edit Play), the system separates (interlaces) the 
progressive frames into fields and does the following:

• On the Source, Record, Playback, or pop-up monitor, the system 
displays the footage at 23.976 fps, 24 fps, or 25 fps, depending on your 
project and editing preference.

• On an NTSC monitor, the system does one of two things:

- If playing at 23.976 fps (audio pulldown ON), the system performs 
a 2:3 pulldown that replicates the telecine pulldown, and displays 
the interlaced media at 29.97 fps. 

- If playing at 24 fps (audio pulldown OFF), the system performs a 
2:3 pulldown, drops every 1000th frame in the Client monitor, and 
displays the interlaced media at 29.97 fps.

• On a PAL monitor, the system does one of two things:

- If playing at 24 fps, the system duplicates two fields per second to 
display the interlaced media at 25 fps.

- If playing at 25 fps, the system performs a 4.1 percent speedup, 
maintains 1:1 transfer of film frames to video frames, and displays 
the interlaced media at 25 fps.

For 25p projects, 25 fps is the only playback rate. The playback 
rate is 1:1 with no speed change.
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By default, the system uses a mode called Fast Frame Display (available 
from the Special menu), which displays one field of the progressive frame. 
You can display the full frame if necessary, such as when checking for 
dropouts created during the film-to-tape transfer, and step through frame 
by frame. However, the display will be slower. 

Displaying Media During a Digital Cut

The Digital Cut tool lets you output multiple formats at various play rates, 
all from 24p and 25p media. When you click the Play Digital Cut button, 
the system displays the sequence as described in the previous section, 
depending on your selection in the Digital Cut tool. For more information, 
see “Outputting Directly to a DV Device” in the Help.

Film-to-Tape Transfer Guidelines

Observe the following general guidelines when transferring film to tape:

• Instruct the telecine facility to record timecode on the address track.

• Instruct the facility to use only a telecine transfer process when 
transferring to NTSC videotape. Do not use a film chain or any other 
transfer device.

• PAL transfers do not require pulldown, so you can use either a telecine 
or a film chain. However, quality is much better on a telecine.

• Transfer all of the project’s source film footage to disk or tape by using 
either the NTSC or PAL method. 

- For NTSC projects, you can mix footage transferred at 24 fps 
(23.976 fps) or 30 fps (29.97 fps), and mix sound transferred at 1.0 
or 0.99.
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n Do not mix 24-fps and 30-fps transfers on the same transfer tape.

- For PAL projects, you cannot mix audio that has been transferred 
at 4.1 percent speedup (PAL Method 1) with audio that has not 
been sped up (PAL Method 2).

n PAL film-to-tape transfers that use pulldown are not currently supported in 
Avid systems.

Film-to-Tape Transfer Options

This section describes options for transfer quality and various screening 
and editing aids you can request during the transfer process, based on the 
considerations of budget and available facilities.

Transfer Quality

The quality of the film-to-tape transfers depends upon several options for 
the telecine transfer. The transfer-quality options available from a telecine 
facility include:

• One-light: This transfer involves a single setting of color correction 
values, resulting in the simplest, fastest, and least-costly type of 
transfer. One-light transfers are often used during offline stages of 
editing.

• Best-light: This transfer involves optimum settings of the color-grade 
controls, but without scene-by-scene color correction. Best-light 
transfers are an intermediate level in terms of both quality and cost.

• Timed (scene-by-scene): This transfer involves color correcting each 
scene or shot during transfer. Timed transfers are the most expensive 
and time consuming. This option sets up the proper black and white 
levels so that you can perform a tape-to-tape color correction from the 
source tapes, if needed.
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For more information 
on the film-tape-film-
tape option, see 
“Relinking Clips by 
Key Number” in the 
Help.

You can use the film-tape-film-tape feature to perform two separate 
telecine processes for a project:

• Perform a one-light or best-light transfer to obtain the most material 
for the initial edits.

• After editing is complete, perform a timed, fully color-corrected 
transfer of the clips that will be used in the final cut.

After you perform the final telecine operation, you can capture at a 
finishing resolution, such as 1:1 (uncompressed).

Additional Film Transfer Aids

The transfer facility might have available one or more of the following 
production aids, which you can include in your film-to-tape transfer:

• Automatic logging: Whenever possible, you should instruct the 
facility to log tracking information directly into a computer database 
program. Logs generated automatically are more accurate than manual 
logs and can be imported easily into the Avid system (see “Preparing 
Log Files for Import” in the Help). A log file typically indicates the 
relative timecode, key numbers, and pullin (“A” frames) for each clip 
that will be captured. 

• A keypunch at the head of each camera roll: Ask the lab or transfer 
house to punch the head of each camera roll at the zero frame and give 
you a list of the corresponding key numbers. After you have captured, 
you can match this list with your captured material to check for 
potential transfer errors.

• Burn-in code: If the transfer facility is equipped with a timecode or 
film-code character generator, you can instruct the facility to display or 
“burn-in” tracking codes on the videotape transfer. Burn-in code 
provides visual feedback for logging and tracking footage.

c Burn-in code cannot be removed from the image and should be used 
only for the offline stage of a project.

• 16:9 wide-screen format: The Avid system supports the 16:9 wide-
screen display format. You can either shoot your footage by using a 
16:9 lens, or transfer the footage anamorphically to display a larger 
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area of the film aspect ratio during offline and online editing. Also, this 
aspect ratio lets you create media that takes advantage of new 16:9 
monitors that conform to SDTV and HDTV standards.
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Chapter 6

File Format Specifications

To be compatible with a variety of imaging standards, your Avid system 
can accommodate many file types and formats. For import and export 
procedures, see “Importing Files” in the Help and “Exporting Frames” in 
the Help. This appendix contains descriptions, specifications, and notes for 
importing and exporting specific file formats.

To ensure usability and high quality, the files in some formats require 
preparation before being imported to the Avid application. Consequently, 
this appendix contains many more notes for import than for export. When 
you export a file, you select a file format from the Export Settings dialog 
box and select options appropriate for the format. For descriptions of the 
dialog box options, see “Export Settings Dialog Box Options” in the Help.

Graphics (Image) Files

Media Composer uses Image Independence® to produce usable files from a 
large number of graphics formats. Once you have imported a file in a 
particular format, you can export it in the same or different format, with the 
exception of Photo CD™; you cannot export a file to a Photo CD. (You can 
only import the Photo CD format on a Macintosh).

This list briefly describes the supported graphics (image) file formats:

• Alias: Alias PIX image format, developed by Alias Research, Inc. 
(now Alias|Wavefront, a division of Silicon Graphics Limited) for use 
with their animation and visualization software.
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• BMP: Developed by Microsoft Corporation as the standard image file 
format used by Microsoft Windows.

• Chyron: Developed by Chyron Corporation for use with video frame 
buffers of Chyron character-generator titles.

• Cineon: Developed by Eastman Kodak for use in the Cineon Digital 
Film System. It is a subset of the SMPTE DPX (Digital Picture 
Exchange) format.

• Framestore: Developed by NewTek for use with their Video Toaster 
system.

• IFF: Developed by Electronic Arts. IFF (Interchange File Format), or 
more specifically IFF-ILBM (InterLeaved BitMap), is the standard file 
format by which applications on the Amiga platform transfer image 
files.

• JPEG: Developed by the Joint Photographic Experts Group (JPEG). 
This format is highly suited for image storage and transmission 
purposes because of its ability to dramatically reduce the storage 
requirements for a file. JFIF files (JPEG File Interchange Format, the 
standard for constructing JPEG files) can also be imported and 
exported.

• OMFI: (import only) Developed by Avid Technology, Inc. and many 
industry and standards partners for the interchange of digital media 
data between platforms and applications.

• PCX: Developed by Zsoft Corporation for use with its PC Paintbrush 
paint software.

• (Macintosh only) Photo CD: (import only) Developed by Kodak for 
use with the Kodak Photo CD storage medium. If you have difficulty 
importing this format directly into your Avid system, open the file in 
an application such as Photoshop, and use the Save As feature to save 
the file in a format that can be imported (such as TARGA, PICT, or 
TIFF).

• Photoshop: Developed by Adobe Systems Incorporated for use with 
its Adobe Photoshop image-editing software.

• PICT: Developed by Apple Computer, Inc. as the format for 
Macintosh QuickDraw® images.

• Pixar: Developed by Pixar for stored pictures.
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• PNG: Developed by the PNG Development Group originally as an 
alternative to the GIF image format. PNG is an acronym for Portable 
Network Graphics and is pronounced “ping.”

• QRT: Developed on the Amiga personal computer to run on several 
operating systems. Used by many ray tracing programs, such as DKB 
Ray Trace and the QRT ray tracer.

• Rendition: Developed by Numerical Design Ltd.

• SGI: Developed by Silicon Graphics, Inc. for use as the standard 
format on their line of workstations.

• Softimage: Developed by Softimage, Inc. (now a division of Avid 
Technology, Inc.) for use in their Softimage software.

• Sun Raster™: Developed by Sun Microsystems, Inc. and supported 
mainly in Sun applications.

• Targa: Developed by Truevision, Inc. (now Pinnacle Systems) and 
originally intended for support of the Truevision image-capturing 
hardware.

• TIFF: Developed by Aldus Corporation (now Adobe Systems 
Incorporated) and Microsoft Corporation. TIFF is an acronym for Tag 
Image File Format.

• Wavefront: Developed by Wavefront Technologies, Inc. (now 
Alias|Wavefront, a division of Silicon Graphics Limited) for storing 
pictures in a machine-independent manner.

• XWindows: Developed by the MIT X Consortium and supported by 
many X Window System applications on workstations and some 
personal computers.

• YUV: Defined by Abekas Video Systems (now Accom, Inc.), the YUV 
format is the raw data sent to the Abekas® machines.
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Preparing Graphics Files for Import

Before you import a graphics file to your Avid system, you can use third-
party image-editing software, such as Adobe Photoshop, to make 
adjustments such as the following: 

• Convert the file to the appropriate size, resolution, and bit depth. 

• Crop or color-correct an image.

• Eliminate jagged edges in an image by using the image-editing 
application’s anti-aliasing or high-quality option.

• Add transparency (to some formats) by setting the resolution to 32 bits 
per pixel to add an alpha channel. 

• In some cases, you can convert an image file that does not support an 
alpha channel to a format that does, in order to add transparency. 

n You can import and key the image over video by using key effects within the 
Avid application. However, importing an image with an existing alpha 
channel provides the best results.

For specific procedures and file formats, see the documentation that 
accompanies the image-editing software.

Graphics File Import Specifications

Table 52 contains graphics file import specifications. The table uses the 
following terms:

• Bit depth: These numbers refer to color-depth resolution of the image 
based on the number of bits per pixel. For example, 2-bit images are 
displayed in black and white; 8-bit images are displayed in 256 colors; 
16-bit images are displayed in thousands of colors; 24-bit images are 
displayed in millions of colors; and 32-bit images are displayed in 
millions of colors with an alpha channel.

• Alpha channel: This column states whether or not alpha channel 
import is supported. An alpha channel determines regions of 
transparency in the picture when it is keyed over a background.

• NA: This notation means Not Applicable
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For recommended image sizes, see “Screen Resolution for Imported 
Graphics and Sequences” on page 166.

Table 52 Graphics File Import Specifications

Format

Default 
File 
Name 
Exten-
sion

Bit Depth 
Support

Alpha 
Channel
Support Notes

Alias .als 24-bit color,
8-bit grayscale

No —

BMP .bmp 1-, 4-, 8-, and 24-bit No Dots-per-inch (dpi) information is preserved.

Four-bit BMP files saved with RLE (run-
length encoded) compression are not 
supported.

Photoshop does not support four-channel 
BMP files.

Chyron .chr 32-bit Yes —

Cineon .cin 10-bit (logarithmic) NA Dots-per-inch (dpi) information is preserved.

Framestore .fs 24-bit No Pixel aspect information is saved with image 
data.

When importing files generated from Video 
Toaster, select the option Force to Fit Screen. 

IFF .iff 1-bit to 24-bit color;
1-bit to 8-bit 
grayscale;
64-color EHB;
4096-color HAM;
262,144-color 
HAM8;
SHAM;
A-HAM;
A-RES

1-bit alpha 
only

Dots-per-inch (dpi) information is preserved.

Pixel aspect information is saved with image 
data.
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JPEG .jpg 24-bit color,
8-bit grayscale

No —

OMFI .omf — — See “OMFI Files” on page 174.

PCX .pcx Color-mapped and 
24-bit color

NA Dots-per-inch (dpi) information is preserved.

PCX files with 1-bit color depth or odd-
numbered pixel widths are not 
supported.

Photo CD
(Macintosh 
only)

— — NA If you are importing Photo CD files, you must 
install QuickTime software and a compatible 
QuickTime driver for Photo CD.

Most Photo CD files are high resolution. If the 
photo has a portrait orientation, the image will 
be automatically rotated upon import. Use a 
paint or image-processing program to crop or 
resize the image before importing.

Photoshop .psd Grayscale, indexed 
color, RGB, and 
duotone variations

Yes Duotone files are loaded as grayscale.

Multichannel (greater than four channels) files 
are not supported.

PICT .pic 2-, 4-, 8-, 16-, and 
32-bit

Yes Dots-per-inch (dpi) information is preserved.

If no dpi is specified, 72 dpi is used.

Pixar .pxr 24-bit, 36-bit Yes —

PNG .png 1-bit to 32-bit Yes —

QRT .dbw 24-bit No —

Rendition .6rn 32-bit Yes —

Table 52 Graphics File Import Specifications (Continued)

Format

Default 
File 
Name 
Exten-
sion

Bit Depth 
Support

Alpha 
Channel
Support Notes
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SGI .rgb 8-bit or 16-bit 
grayscale;
8-bit grayscale plus 
8-bit alpha channel;
24- and 48-bit color;
24-bit color plus 8-bit 
alpha channel;
64-bit (16 bits per 
component)

Yes —

Softimage .pic 24-bit plus 
8-bit alpha

Yes Pixel aspect information is saved with the 
image.

c (Windows only) Double-clicking a 
Softimage file will start the 
application associated with PICT files 
because they use the same file name 
extension. Avoid double-clicking 
Softimage files to view them.

Sun Raster .sun 1-, 8-, or 24-bit No —

Targa .tga 8-, 15-, 16-, or 24-bit; 
32-bit

Yes —

Table 52 Graphics File Import Specifications (Continued)

Format

Default 
File 
Name 
Exten-
sion

Bit Depth 
Support

Alpha 
Channel
Support Notes
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Screen Resolution for Imported Graphics and 
Sequences

The tables in this section show the frame sizes to use when importing 
graphics and sequences for different resolutions for NTSC and for PAL.

These numbers describe the recommended width and height, in pixels, to 
create a source image that will be displayed full-screen after import. Using 
these dimensions helps minimize distortion after conversion to the Avid 

TIFF .tif 8-bit color-mapped;
8-bit or 16-bit 
grayscale;
24- and 48-bit color;
24-bit color plus 8-bit 
alpha;
36-bit color plus 
12-bit alpha;
42-bit color plus 
14-bit alpha;
48-bit color plus 
16-bit alpha

Yes Dots-per-inch (dpi) information is preserved.

The following types of files are not supported: 
Multichannel (greater than four channels) 
files; Group 3-compressed (fax) files; CMYK 
files with extra channels; and JPEG-
compressed files.

Four-channel files from Avid Matador™ are 
imported as three-channel files.

Wavefront .rla 32-bit and 64-bit Yes —

XWindows .xwd 1-, 2-, 4-, 8-, 16-,
24-, and 32-bit

No —

YUV .yuv 24-bit No Pixel aspect information (based on the video 
format) is saved with image data.

When importing, select the option Force to Fit 
Screen.

Table 52 Graphics File Import Specifications (Continued)

Format

Default 
File 
Name 
Exten-
sion

Bit Depth 
Support

Alpha 
Channel
Support Notes
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application native resolution. An image with smaller dimensions will take 
up less of the screen or will be distorted, while an image that exceeds these 
dimensions might appear distorted. Avid recommends an image resolution 
of 72 pixels per inch.

For example, when you are using an application such as Adobe 
After Effects to process a sequence that you want to bring into the Avid 
application, use the values shown in the following tables when you render 
the sequence.

Table 53 provides information about the resolutions for interlaced media 
(30i NTSC and 25i PAL projects).

Table 54 provides information for progressive media (24p NTSC, 24p 
PAL, and 25p projects).

Table 53 Graphic Import Frame Sizes: Interlaced

Resolution
Frame Size 
(Pixels) Resolution

Frame Size 
(Pixels)

15:1s 352 x 243 (NTSC)
352 x 288 (PAL)

10:1 720 x 486 (NTSC)
720 x 576 (PAL)

4:1s 352 x 243 (NTSC)
352 x 288 (PAL)

3:1 720 x 486 (NTSC)
720 x 576 (PAL)

2:1s 352 x 243 (NTSC)
352 x 288 (PAL)

2:1 720 x 486 (NTSC)
720 x 576 (PAL)

20:1 720 x 486 (NTSC)
720 x 576 (PAL)

1:1 720 x 486 (NTSC)
720 x 576 (PAL)
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Table 55 provides information for interlaced and progressive multicamera 
media.

Table 56 provides information for DV media (30i and 25i projects).

Table 54 Graphic Import Frame Sizes: Progressive

Resolution
Frame Size 
(Pixels) Resolution

Frame Size 
(Pixels)

35:1 720 x 486 (NTSC)
720 x 576 (PAL)

3:1 720 x 486 (NTSC)
720 x 576 (PAL)

28:1 720 x 486 (NTSC)
720 x 576 (PAL)

2:1 720 x 486 (NTSC)
720 x 576 (PAL)

14:1 720 x 486 (NTSC)
720 x 576 (PAL)

1:1 720 x 486 (NTSC)
720 x 576 (PAL)

Table 55 Graphic Import Frame Sizes: MultiCamera

Interlaced
Resolution

Frame Size 
(Pixels)

Progressive
Resolution

Frame Size 
(Pixels)

4:1m 288 x 243 (NTSC)
288 x 288 (PAL)

3:1m 288 x 243 (NTSC)
288 x 288 (PAL)

10:1 288 x 243 (NTSC)
288 x 288 (PAL)

8:1m 288 x 243 (NTSC)
288 x 288 (PAL)

Table 56 Graphic Import Frame Sizes: DV

Resolution
Frame Size
(Pixels) Resolution

Frame Size
(Pixels)

DV 25 720 x 480 (NTSC)
720 x 576 (PAL)

DV 50 720 x 480 (NTSC)
720 x 576 (PAL)
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Animation Files

Your Avid system supports the following animation file formats:

• ERIMovie: Developed by Elastic Reality, Inc. (now a division of Avid 
Technology, Inc.) for quick playback of rendered movies on Silicon 
Graphics, Inc. platforms. 

• (Macintosh only) PICS: Developed by Apple Computer, Inc. A PICS 
file is a sequence of PICT images. Many applications that handle 
multiple image formats on the Macintosh platform also support PICS 
files.

• QuickTime: Developed by Apple Computer, Inc. for multimedia on 
multiple platforms.

• (Windows only) AVI (Audio Video Interleave): Developed by 
Microsoft for storing video and audio information as part of its Video 
for Windows standard.

Table 57 shows animation file import specifications. QuickTime import 
and export information appears in Table 58. AVI import and export 
information appears in Table 59.

n Your Avid system imports the file at the frame rate that is set in the project 
(29.97 fps, 25 fps, or 24 fps). Set the appropriate frame rate for the project 
when you export from a third-party application.

Table 57 shows animation file import specifications. 
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Table 58 shows the QuickTime file import and export specifications. 

Table 57 Animation File Import Specifications

Format

Default 
File 
Name
Exten-
sion

Bit Depth 
Support

Alpha 
Channel 
Support Notes

ERIMovie .mov or 
.eri

24-bit 
packed and 
32-bit raw 
movie files

Yes QuickTime for Windows also uses the .mov file 
name extension. However, QuickTime does not 
support ERIMovie, and double-clicking an 
ERIMovie file will cause an error.

n There is no player for ERIMovie on 
Windows or Macintosh platforms; the 
mview program supports ERIMovie on 
Silicon Graphics systems.

(Macintosh only) 
PICS Animation

.pcs 2-, 4-, 8-, 
16-, and 
32-bit

Yes Only uncompressed data can be stored in PICS 
format. PICS export does not allow PICS 
containers larger than 16 MB.

Sequenced image 
files

Various — Yes Name each file in the sequence NameN.ext, with 
Name identifying the animation, N indicating the 
file order, and .ext indicating the file type (for 
example, Image1.jpg, Image2.jpg, Image3.jpg). 
The numbering can start at any number except 0, 
or use any numbering format (for example, 
Image010.jpg, Image012.jpg, or Imagef28.jpg, 
Imagef29.jpg).
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Table 58 QuickTime File Import and 
Export Specifications

QuickTime File 
Import and Export 
Specifications Notes

QuickTime files QuickTime import and export requires QuickTime software. For supported 
versions of QuickTime, see the release notes for your Avid system.

• (Windows only) QuickTime software is installed when you install your 
Avid application.

• (Macintosh only) QuickTime software is automatically installed as part 
of the Mac OS operating system.

Avid Codec for 
QuickTime files

The Avid Codec for QuickTime enables you to import and export 
QuickTime files at a rate of three to four times real time. To use the codec 
in a third-party application, see “Exporting from a Third-Party QuickTime 
or AVI Application” in the Help.

Resolution Use Export settings to specify the video resolution of a QuickTime file for 
export. For more information, see “Export Settings Dialog Box Options” in 
the Help.

The video resolution of a QuickTime file is set at export time from a third-
party application equipped with the Avid Codec for QuickTime. The Avid 
system imports the file at this resolution. For more information on 
exporting from a third-party application, see “Exporting from a Third-Party 
QuickTime or AVI Application” in the Help.

Image size To take advantage of the Avid Codec for QuickTime speed, you must 
export the files from the QuickTime application at the following frame 
sizes in order to import to Media Composer v6.0 and later:

720 x 486 pixels for NTSC images (non-square pixels)
720 x 576 pixels for PAL images (non-square pixels)

File name extension After you import a QuickTime file, the file maintains the .mov file name 
extension, which is visible in a bin. The .mov file name extension is the 
default for export.
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Table 59 shows the AVI file import and export specifications. 

QuickTime alpha To save a QuickTime movie with alpha channel in a third-party QuickTime 
application, use the Avid Codec for QuickTime or a codec that supports a 
color depth or “millions +.” The Avid application does not support matte 
key or alpha channel for QuickTime export; it does import alpha channel 
when one exists.

Table 58 QuickTime File Import and 
Export Specifications (Continued)

QuickTime File 
Import and Export 
Specifications Notes

Table 59 AVI File Import and Export 
Specifications

AVI File Import and 
Export Specifications Notes

Resolution Use Export settings to specify the video resolution of an AVI file for 
export. For quick export of files using the Avid Codec for AVI, select the 
“Use Source Compression” option in the Export Settings dialog box. To 
control the resolution when using the Avid Codec for AVI, deselect the 
“Use Source Compression” option, click Compression Settings, and select 
the resolution you want from the Avid AVI Codec Configuration dialog 
box. For more information, click the dialog box and then press the F1 key 
(Windows) or Help key (Macintosh).

The resolution of an AVI file is set at export time from a third-party 
application equipped with the Avid Codec for AVI. The Avid system 
imports the file at this resolution. For more information on exporting from 
a third-party application, see the “Exporting from a Third-Party QuickTime 
or AVI Application” in the Help.

File size Avid AVI files can be quite large, especially at high video resolutions. 
They require adequate storage and transfer capabilities.
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Audio File Formats

This list briefly describes the supported audio file formats:

• Audio Interchange File Format (AIFF-C): Format for audio files 
developed by Apple Computer, Inc.

• (Macintosh only) Sound Designer II (SDII or SD2): Native format 
of the Sound Designer II application developed by Digidesign, Inc., a 
division of Avid Technology, Inc.

• Wave Format (WAVE): Format for audio files developed jointly by 
Microsoft and IBM. WAVE files are playable by nearly all Windows 
applications that support sound.

n You can capture, render, and edit audio in AIFF-C, Sound Designer II 
(Macintosh only), or WAVE file formats. 

MXF Files

Material Exchange Format (MXF) allows for easy exchange of material 
between file servers, tape streamers and digital archives. MXF is an ideal 
interchange format to enable workflow efficiencies in news broadcasting, 
post production, asset management, and archiving applications. For 
example, Avid|DS and ProTools support MXF files. 

File name extension After you import an AVI file, the file maintains the .avi file name 
extension, which is visible in a bin. The .avi file name extension is the 
default for export.

AVI alpha channel Media Composer does support alpha channel for AVI import or export.

Table 59 AVI File Import and Export 
Specifications (Continued)

AVI File Import and 
Export Specifications Notes
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You can select the MXF format when capturing, importing, creating titles, 
or rendering effects.

OMFI Files

OMFI was developed by Avid Technology, Inc. and many industry and 
standards partners for the interchange of digital media data between 
platforms and applications. For information about creating an OMFI file 
on a non-Avid application, see the documentation for the application.

The information in Table 60 applies to importing OMFI files.

Table 60 OMFI File Import Specifications

OMFI File
Import 
Specifications Notes

Resolution For optimum import speed and quality, export or render the file from the 
source application at the resolution you want, and then import the file into 
the Avid application at that resolution. For more information, see “Import 
Settings” in the Help.

Frame or Edit rate You must import sequences and clips to projects that have the same edit 
rate (29.97 fps or 23.976 fps for NTSC, 25 fps for PAL, 24 fps for film). If 
the edit rates do not match, you will receive an error message.

n cannot import an OMFI audio file that was produced with an edit 
rate equal to the audio sampling rate. Trying to import such a file 
results in an “Unrecognized file type” error message. Create the 
source file with an edit rate at the project edit rate (29.97 fps, 25 fps, 
24 fps, or 23.976 fps).
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OMFI version Media Composer recognizes and supports OMFI 1.0 composition and 
media files and OMFI 2.0 composition files. 

The following OMFI 2.0 effects are supported generally:

• Video effects: dissolves, wipes, freeze frame, film pulldown, slow 
motion, fade to black

• Audio effects: pan and volume, audio dissolves

Other effects can be imported from other Avid applications.

Film pulldown To import audio media, set the pulldown switch to 1.0.

Audio sample rate Audio media is imported at the sample rate that is set on the Avid system.

n Media Composer cannot import an OMFI audio file that was 
produced with an edit rate equal to the audio sampling rate. Trying 
to import such a file results in an “Unrecognized file type” error 
message. Set the edit rate to the project edit rate (29.97 fps, 25 fps, 
24 fps, or 23.976 fps).

Avid MCXpress™ for 
Windows NT® files

If you are importing OMFI compositions from Avid MCXpress for 
Windows NT, you might receive an error if the sequence includes video or 
audio effects. If this happens, create a cuts-only version of the sequence in 
Avid MCXpress and export it again. You cannot import video media from 
Avid MCXpress for Windows NT; if you import a composition, you must 
recapture the media.

File transfer If you are transferring an OMFI file over a network, transfer it as a binary 
file.

Reimporting Avid
media files

If you import OMFI files that contain media you exported from the same 
system, you need to delete the original media. Otherwise, the new media 
will not overwrite the original media. To learn how to find related media 
files for a sequence, see “Finding a Related Media File” in the Help.

Table 60 OMFI File Import Specifications (Continued)

OMFI File
Import 
Specifications Notes
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Field Ordering in Graphic Imports and Exports

Graphic images are composed of one or more image files, each of which 
contains a full frame. These frames contain fields (formed from the odd-
numbered and even-numbered lines of the image frame) that have three 
basic arrangements:

• Progressive or still frame: The upper and lower fields in the frame 
originated at the same instant of time, or are coherent with each other, 
as shown in the following illustration.

• Upper field is first: The upper field in the frame (odd-numbered lines, 
when the frame lines are numbered starting from 1) occurs temporally 
before the lower field, as shown in the following illustration. This 
arrangement is termed “upper field first” (or “lower field second”). 

• Lower field is first: The lower field in the frame (even-numbered 
lines) occurs temporally first, as shown in the following illustration. 
This arrangement is termed “lower field first” (or “upper field 
second”).

Field 1
&

Field 2

Time

f 1 f 2

Frame Unit

Dashed lines = Field 1
Solid lines = Field 2

Field 1 Field 2 Time

f 1 f 2

Frame Unit
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Field Ordering in Graphic Imports and Exports
Preventing a Spatial Field Mismatch on Import

Table 61 shows the proper spatial field position for each of the common 
video formats in Avid systems.

Field 1 Field 2 Time

f 1 f 2

Frame Unit

Table 61 Recommended Field Settings for Two-Field 
Import and Export

Avid Video 
Format

Import/Export
Frame Size

Upper/Lower Field 
Spatial Setting

Field Setting for 
Import and Exporta

AVR NTSC 720 x 243 x 2 Upper field is first. Odd Field 

AVR PAL 720 x 288 x 2 Upper field is first. Odd Field 

Meridien NTSC 720 x 243 x 2 Lower field is first. Even Field 

Meridien PAL 720 x 288 x 2 Upper field is first. Odd Field 

DV25 NTSC 720 x 240 x 2 Lower field is first Even Field

DV50 NTSC 720 x 240 x 2 Lower field is first Even Field

DV25 PAL 720 x 288 x 2 Lower field is first Even Field

DV50 PAL 720 x 288 x 2 Lower field is first Even Field

a. Odd Field or Even Field specifies whether the temporally first field in the frame has the odd or 
even numbered lines, starting from 1.
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Graphics utilities, such as Adobe After Effects, permit selection of either 
spatial relation for the fields when rendering a sequence of interlaced 
fields. If the rendering is performed as shown in Table 61, then the import 
will be correct.

If the spatial positions of the two fields are reversed (for example, the 
upper field should be a lower field), the import cannot be done without 
correcting the spatial relationship. In this spatial mismatch situation, the 
Avid system will convert the upper field to a lower field by deleting the top 
line of the upper field and replicating the bottom line. The field will thus be 
converted to a lower field relative to the other field. The import operation 
can now proceed.

n When exporting to DVD for TV playback, it is recommended to transcode 
any clips that do not match the field ordering of the majority of the clips. 
Not doing this will result in field ordering being swapped during playback.

Spatial Field Relationship on Export

The default export operation is automatically carried out as shown in 
Table 61. The fields will be properly interleaved in the export frames (one 
frame per file).

If an import comes in mismatched and the dropping of the top line and 
repeating of the bottom line is performed, you might decide to have the 
export operation performed to prevent a shift up or down by a line. The 
Export Settings dialog box permits you to select the spatial arrangement 
that is the opposite of what is otherwise recommended. This option should 
rarely be used.

24p and 25p Import and Export

The spatial field selection options do not apply for 24p and 25p projects 
because the frames in these projects are already in progressive or still-
image form. 
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Field Dominance

Editing in Avid systems is frame based. All timecode is expressed in frame 
numbers, and all cuts are at frame boundaries. A raw video stream has no 
concept of frames (ignoring color framing) until the frame unit is defined. 
Defining the dominant field for the system defines the “frameness” of the 
video stream, as shown in the following figure.

Avid editing systems all use field 1 as the dominant field. This means that 
the first field temporally in the edit frame will always be field 1. Field 2 
will always be the second frame in the edit frame. Cuts will always precede 
field 1.

Fields in Video

In the video signal, fields have a temporal position that is unambiguously 
and uniquely tied to the details of the video signal, regardless of whether 
the signal is analog or digital (SDI). This means that working around a 
field spatial mismatch should be done by correcting the spatial relation 
between the two fields rather than the temporal position. In some cases, it 
is possible to modify the field dominance of the input image files, but this 
is cumbersome, results in the loss of two fields, and is more difficult to 
carry out than either the workaround provided in Avid systems or 
rerendering properly to the other spatial relationship.

f2 f1 f1

Field-1
Dominant

Frame

f1 f1

Field-2
Dominant

Frame

f1f2 f2 f2 f2(Time)
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Chapter 7

Resolutions and Storage 
Requirements

This appendix describes the different resolutions and lists their 
specifications. It also explains how to estimate the drive space you will 
require to store your captured media. This appendix includes the following 
sections:

• Compression and Avid Editing Systems

• Screen Resolution

• Compression and Resolutions

• Storage Requirements

• Maximizing Drive Space

• Managing Storage to Improve Playback Performance

n The resolutions available on your Avid system depend on its model and 
options.

Compression and Avid Editing Systems

When an Avid editing system captures and stores video, it employs 
compression techniques that affect the size of the resulting files and the 
resolution of the images they contain. The less the data is compressed, the 
higher the image resolution, and the more drive space the file requires.



 Chapter 7 Resolutions and Storage Requirements
Large media files at high resolutions can use very large amounts of drive 
space. When you are choosing an image resolution for your project, you 
need to balance your requirements in terms of image quality with your 
available drive resources.

You can use lower resolutions when your work does not require very high 
image quality (for example, in offline work, or in CD-ROM or Web 
authoring projects), and higher resolutions when you need excellent image 
quality. You can also mix different resolutions within the same project as 
long as those resolutions are compatible with one another.

Your Avid application also supports the digitizing and storage of video that 
is not processed by a data compression scheme.

• Uncompressed video (1:1) conforms to ITU-R 601 standards. The 
image quality of uncompressed video is very high, but uncompressed 
files require very large amounts of drive space.

• DV (digital video) and MPEG video are compressed media formats. 
SMPTE standards specify how to take 601 video and convert it to the 
compressed formats. When recording through a 1394 connection 
(Windows only) or an MPEG SDTI-CP connection (Windows only), 
the Avid editing system records DV and MPEG media in their native 
formats, and does not compress them further.

Screen Resolution

The screen resolution for the Avid application is different for NTSC and 
for PAL:

• NTSC ITU-R 601 resolution is 720 x 486 non-square pixels covering 
all the active video. The stored media includes 10 lines of blanking or 
vertical interval timecode (VITC) per frame (5 lines per field).

• NTSC DV and MPEG resolutions are 720 x 480 non-square pixels 
covering all the active video.
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• PAL ITU-R 601 resolution is 720 x 576 non-square pixels covering all 
the active video. The stored media includes 16 lines of blanking or 
VITC per frame (8 lines per field).

• PAL DV and MPEG resolutions are 720 x 576 non-square pixels 
covering all the active video.

Compression and Resolutions

Avid resolutions use a simple notation — x:1 — to identify the level of 
compression. The value of x indicates the level of compression that is 
applied to the image data. For example, a 3:1 compression ratio 
compresses the original data to one-third of its uncompressed size. 

A lower compression ratio (a lower number to the left of the colon) results 
in better image quality but requires more drive space to store the captured 
media. A lower compression ratio might also require drive striping to keep 
up with the high volume of data.

n For information on resolutions to use when importing graphics or 
sequences from a third-party application, see “Screen Resolutions for 
Imported Graphics and Sequences” in the Help.

Mixing Resolutions

In a single sequence, you can mix resolutions, but you cannot mix 
interlaced with progressive resolutions.

Avid Resolutions

Table 62 lists the five groups of Avid resolutions.
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DV Resolutions

Table 63 lists the two groups of DV resolutions:

You can mix NTSC DV resolutions (DV 25 and DV 50), or you can mix 
PAL DV resolutions (DV 25 and DV 50). However, you cannot record a 
digital cut to a DV deck with mixed DV resolutions. You need to perform a 
mixdown first. You can record mixed DV resolutions to an SDI or to an 
analog deck.

Advantages to Mixing Resolutions

Mixing resolutions in a sequence saves time and effort in a variety of 
circumstances:

Table 62 Avid Resolution Groups

NTSC 30i and PAL 25i Projects 24p and 25p Projects

Single-Field Two-Field
Uncompressed
(Interlaced) Progressive

Uncompressed
(Progressive)

15:1s
4:1s
2:1s

20:1
10:1
3:1
2:1

1:1 35:1
28:1
14:1
3:1
2:1

1:1

Table 63 DV Resolution Groups

NTSC 30i Projects PAL 25i projects

DV 25 4:1:1 DV 25 4:1:1, DV 25 4:2:0

DV 50 4:2:2 DV 50 4:2:2
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• You can do most of your work at a resolution that can play back real-
time effects, digitizing only the most complex shots and graphics at a 
high-quality, single-stream resolution.

• For storage and playback efficiency, you can capture complex footage 
at the draft-quality online resolution and edit it along with other online 
resolutions.

• You can avoid some recapturing by importing complex graphics at a 
high-quality resolution and by digitizing the remaining footage at draft 
quality during the offline phase. 

• You can exchange material between projects with a minimum of 
recapturing.

• You can develop material among workstations at different resolutions 
and bring the material together for a final cut without recapturing.

n For information on resolutions to use when importing graphics or 
sequences from a third-party application, see “Screen Resolutions for 
Imported Graphics and Sequences” in the Help.

Resolution Groups and Image Quality

Although it is generally true that a lower compression ratio means higher 
image quality, the resolution group itself (single-field, two-field, 
progressive, or uncompressed) is also a factor in the quality of the final 
image.

Single-field resolutions work with smaller amounts of original image data 
than two-field or progressive resolutions. They use only half the image 
width of two-field resolutions, and they use only one of the two fields in 
the standard video signal.

For example, there is a 2:1 resolution for both single-field and two-field 
resolutions. In both cases, the image data is compressed to one-half of its 
original size. However, the image quality of these two resolutions is 
different. The single-field 2:1 resolution has lower image quality because it 
processes only one-quarter of the original image data used by the two-field 
2:1 resolution.
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Video Streams

Whenever you have more than one video track, or a transition effect on a 
single track, you have two streams of data (“dual streams”). Some effects 
create a second stream. When you render effects, you combine two streams 
into one. Two streams demand a significantly higher throughput than one 
stream. Sometimes, drive striping is required to accommodate two streams, 
even though a single stream at the same resolution would not require 
striping. 

Compression Specifications

The following tables provide information about the Avid resolutions, DV 
resolutions, and MPEG resolutions:

• “Resolution Specifications: Interlaced” on page 186

• “Resolution Specifications: Progressive” on page 188

Progressive media is stored as a full frame. For more information, see 
“How the Avid System Stores and Displays 24p and 25p Media” on 
page 152.

For information on drive striping requirements for different resolutions, 
see “Getting Information About Striped Drives” in the Help.

For detailed guidelines on estimating space requirements, see “Storage 
Requirements” on page 189.

Resolution Specifications: Interlaced

Table 64 provides information about the Avid resolutions for interlaced 
media (30i NTSC and 25i PAL projects).
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Table 64 Resolution Specifications: Interlaced

Resolution
Field Size 
(Pixels)

Fields 
Per 
Frame Quality

15:1s 352 x 248 (NTSC)
352 x 296 (PAL)

1 Offline

Maximum storage with enough image detail to make 
basic editing decisions (you can check lip sync on a 
medium shot)

4:1s 352 x 248 (NTSC)
352 x 296 (PAL)

1 Offline

A good storage resolution combined with a good offline 
image quality

2:1s 352 x 248 (NTSC)
352 x 296 (PAL)

1 Online

Provides enough detail for finishing multimedia jobs 
such as CD-ROM and Web authoring

20:1 720 x 248 (NTSC)
720 x 296 (PAL)

2 Offline

Useful for mixing storage-efficient offline footage with 
online-quality resolutions

10:1 720 x 248 (NTSC)
720 x 296 (PAL)

2 Offline/online

A good compromise for high-quality, two-field offline 
or low-quality online that saves drive space

3:1 720 x 248 (NTSC)
720 x 296 (PAL)

2 Online

A medium-quality online resolution that can sustain 
two-stream playback on 2-way striped drives

2:1 720 x 248 (NTSC)
720 x 296 (PAL)

2 Online

Provides the highest image quality of any compressed 
resolution and sustains two-stream playback on 4-way 
striped drives

1:1 720 x 248 (NTSC)
720 x 296 (PAL)

2 Online uncompressed

Provides the highest image quality possible
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Resolution Specifications: Progressive

Table 65 provides information about the Avid resolutions for progressive 
media (24p NTSC and 24p PAL projects). 

Table 65 Resolution Specifications: Progressive

Resolution
Frame Size 
(Pixels) Quality

35:1 720 x 496 (NTSC)
720 x 592 (PAL)

Offline

Maximum storage with enough image detail to make basic editing 
decisions

28:1 720 x 496 (NTSC)
720 x 592 (PAL)

Offline

Low storage requirements combined with a good offline image 
quality

14:1 720 x 496 (NTSC)
720 x 592 (PAL)

Offline

The best offline image quality

3:1 720 x 496 (NTSC)
720 x 592 (PAL)

Online

A medium-quality online resolution that can sustain two-stream 
playback on 2-way striped drives

2:1 720 x 496 (NTSC)
720 x 592 (PAL)

Online

Provides the highest image quality of any compressed resolution 
and sustains two-stream playback on 4-way striped drives

1:1 720 x 496 (NTSC)
720 x 592 (PAL)

Online uncompressed

Provides the highest image quality possible
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Storage Requirements

You should plan the use of drive volumes in advance, especially when you 
capture numerous reels. 

This section contains recommendations for achieving efficient storage for 
your digital media. It explains how playback performance can be affected 
by the way you set up the storage drives and target them when you capture. 

Estimating Drive Space Requirements

You need to select a resolution that provides adequate picture quality for 
your project. However, you might be limited by the amount of media drive 
space available. Before you capture, estimate your media drive space 
requirements. 

To estimate media drive space requirements:

1. Use the appropriate resolution specifications table (see “Compression 
Specifications” on page 186) and the information in your media drive 
documentation to select a resolution that is compatible with the drive 
and striping capacity on your system.

2. Open the Capture tool, select a resolution and target drive or drives, 
and note the time remaining on the selected drives (see “Interpreting 
the Time-Remaining Display” in the Help).

3. Get a total duration for all the clips to be captured. Use the Console 
and the Get Bin Info commands, as described in “Getting Information 
with the Console” in the Help.

4. Use the appropriate estimated storage requirements table (see 
“Estimated Storage Requirements” on page 190) to estimate your drive 
space requirements based on the resolution and the number of audio 
tracks. To get an estimate of the number of gigabytes needed, do one of 
the following:

t Calculate by dividing the duration of your material (number of 
minutes) by the estimated minutes per gigabyte.
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t Calculate by combining storage figures from the “Drive space 
Needed for x Minutes of Media” columns as necessary to match 
the number of minutes of material you have.

5. Compare the gigabytes available on your drives with the result of 
step 4. If your needs are greater than your drive space, select a lower 
resolution and recalculate.

Estimated Storage Requirements

The tables in the following topics show estimated drive space requirements 
for each resolution, including uncompressed. They show figures for 
estimated minutes per gigabyte and also figures for the drive space 
required for certain amounts of material. 

n The figures in the table represent drive space for video material that 
includes typical variations in image complexity. Actual drive space 
requirements might vary slightly from these estimates, depending on the 
overall complexity of the video you capture and store.

Consider the following when you interpret this information:

• For 30-fps media (NTSC) and 25-fps media (PAL), the minutes per 
gigabyte are approximately the same because PAL video contains 
approximately 17 percent fewer frames per second, but each frame 
contains approximately 16 percent more pixels.

For 24p media, which uses the same frame rate for both NTSC and 
PAL, 24p footage from a PAL transfer requires more storage space.

• Figures for audio storage in the table are based on the standard rates 
for audio sampling (16 bits per sample, 44.1 kHz). To calculate 
additional audio storage (for numbers of channels not listed in the 
table), add 88.2 KB per second (approximately 5.3 MB per minute) to 
your estimate for each additional audio channel.

• Storage requirements are affected by the number of channels of audio, 
not the frequency of the captured audio signal. The difference in 
storage requirements between 44.1-kHz and 48-kHz audio is 
negligible, while the difference between two or three channels is more 
significant, as reflected in the table.
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n Rolling titles add 1.4 MB (NTSC) or 1.6 MB (PAL) per second to storage 
requirements. If you are on the upper edge of the requirements for drive 
capacity or striping, adding a rolling title might prevent you from playing 
real-time material.

Estimated Storage Requirements: Interlaced

Before using Table 66, read the information in “Estimating Drive Space 
Requirements” on page 189 and “Estimated Storage Requirements” on 
page 190.

Table 66 Estimated Storage Requirements: Interlaced 

Resolution
Audio 
Tracks

Minutes 
Per 
Gigabyte 

Drive 
Space 
Needed for 
1 Minute of 
Media

Drive 
Space 
Needed for 
10 Minutes 
of Media

Drive Space 
Needed for 
30 Minutes 
of Media

15:1s 0 48.5 20.6 MB 206 MB 618 MB

1 38.6 25.9 MB 259 MB 777 MB

2 32.1 31.2 MB 312 MB 936 MB

3 28.2 35.5 MB 355 MB 1.07 GB

4 24.5 40.8 MB 408 MB 1.22 GB

8 16.1 62.0 MB 620 MB 1.86 GB

4:1s 0 11.6 85.8 MB 858 MB 2.57 GB

1 11.0 91.1 MB 911 MB 2.73 GB

2 10.5 95.4 MB 954 MB 2.86 GB

3 9.9 101 MB 1.01 GB 3.03 GB

4 9.4 106 MB 1.06 GB 3.18 GB
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8 7.9 127 MB 1.27 GB 3.81 GB

2:1s 0 5.8 172 MB 1.72 GB 5.16 GB

1 5.7 177 MB 1.77 GB 5.28 GB

2 5.5 182 MB 1.82 GB 5.46 GB

3 5.4 187 MB 1.87 GB 5.61 GB

4 5.2 193 MB 1.93 GB 5.79 GB

8 4.7 214 MB 2.14 GB 6.42 GB

20:1 0 16.6 60.1 MB 601 MB 1.80 GB

1 15.3 65.4 MB 654 MB 1.96 GB

2 14.1 70.7 MB 707 MB 2.12 GB

3 13.2 76.0 MB 760 MB 2.28 GB

4 12.3 81.3 MB 813 MB 2.44 GB

8 9.8 103 MB 1.03 GB 3.09 GB

10:1 0 8.3 120 MB 1.20 GB 3.60 GB

1 7.9 126 MB 1.26 GB 3.78 GB

2 7.6 131 MB 1.31 GB 3.93 GB

3 7.3 136 MB 1.36 GB 4.08 GB

4 7.2 140 MB 1.40 GB 4.20 GB

8 6.2 161 MB 1.61 GB 4.83 GB

Table 66 Estimated Storage Requirements: Interlaced 
 (Continued)

Resolution
Audio 
Tracks

Minutes 
Per 
Gigabyte 

Drive 
Space 
Needed for 
1 Minute of 
Media

Drive 
Space 
Needed for 
10 Minutes 
of Media

Drive Space 
Needed for 
30 Minutes 
of Media
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3:1 0 2.9 344 MB 3.44 GB 10.32 GB

1 2.9 349 MB 3.49 GB 10.47 GB

2 2.8 354 MB 3.54 GB 10.62 GB

3 2.8 360 MB 3.60 GB 10.80 GB

4 2.7 365 MB 3.65 GB 10.95 GB

8 2.6 386 MB 3.86 GB 11.58 GB

2:1 0 1.9 516 MB 5.16 GB 15.48 GB

1 1.9 521 MB 5.21 GB 15.63 GB

2 1.9 526 MB 5.26 GB 15.78 GB

3 1.9 531 MB 5.31 GB 15.94 GB

4 1.9 537 MB 5.37 GB 16.11 GB

8 1.8 558 MB 5.58 GB 16.74 GB

1:1
(Uncompressed)

0 0.8 1.22 GB 12.2 GB 36.6 GB

1 0.8 1.23 GB 12.3 GB 36.9 GB

2 0.8 1.23 GB 12.3 GB 36.9 GB

3 0.8 1.24 GB 12.4 GB 37.2 GB

4 0.8 1.24 GB 12.4 GB 37.2 GB

8 0.8 1.26 GB 12.6 GB 37.8 GB

Table 66 Estimated Storage Requirements: Interlaced 
 (Continued)

Resolution
Audio 
Tracks

Minutes 
Per 
Gigabyte 

Drive 
Space 
Needed for 
1 Minute of 
Media

Drive 
Space 
Needed for 
10 Minutes 
of Media

Drive Space 
Needed for 
30 Minutes 
of Media
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Estimated Storage Requirements: Progressive

Before using Table 67, read the information in “Estimating Drive Space 
Requirements” on page 189 and “Estimated Storage Requirements” on 
page 190.

Table 67 Estimated Storage Requirements: Progressive

Resolution
Audio 
Tracks

Minutes 
Per 
Gigabyte 

Drive 
Space 
Needed for 
1 Minute of 
Media

Drive 
Space 
Needed for 
10 Minutes 
of Media

Drive Space 
Needed for 
30 Minutes 
of Media

35:1 0 36.4 (NTSC)
30.3 (PAL)

27.5 MB
33.0 MB

275 MB
330 MB

824 MB
990 MB

1 30.5 (NTSC)
26.1 (PAL)

32.8 MB
38.3 MB

328 MB
383 MB

983 MB
1.14 GB

2 26.3 (NTSC)
22.9 (PAL)

38.1 MB
43.6 MB

381 MB
436 MB

1.14 GB
1.30 GB

3 23.1 (NTSC)
20.4 (PAL)

43.4 MB
48.9 MB

434 MB
489 MB

1.30 GB
1.47 GB

4 20.5 (NTSC)
18.4 (PAL)

48.7 MB
54.2 MB

487 MB
542 MB

1.46 GB
1.63 GB

8 14.3 (NTSC)
13.3 (PAL)

69.9 MB
75.4 MB

699 MB
754 MB

2.10 GB
2.26 GB

28:1 0 29.1 (NTSC)
24.3 (PAL)

34.4 MB
41.2 MB

344 MB
412 MB

1.03 GB
1.23 GB

1 25.2 (NTSC)
21.5 (PAL)

39.7 MB
46.5 MB

397 MB
465 MB

1.19 GB
1.39 GB

2 22.2 (NTSC)
19.3 (PAL)

45.0 MB
51.8 MB

450 MB
518 MB

1.35 GB
1.55 GB
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3 19.9 (NTSC)
17.5 (PAL)

50.3 MB
57.1 MB

503 MB
571 MB

1.51 GB
1.71 GB

4 18.0 (NTSC)
16.0 (PAL)

55.6 MB
62.4 MB

557 MB
624 MB

1.67 GB
1.87 GB

8 13.0 (NTSC)
12.0 (PAL)

76.8 MB
83.6 MB

768 MB
836 MB

2.30 GB
2.51 GB

14:1 0 14.6 (NTSC)
12.1 (PAL)

68.5 MB
82.6 MB

685 MB
826 MB

2.05 GB
2.48 GB

1 13.6 (NTSC)
11.4 (PAL)

73.8 MB
87.9 MB

738 MB
879 MB

2.21 GB
2.64 GB

2 12.6 (NTSC)
10.7 (PAL)

79.1 MB
93.2 MB

791 MB
932 MB

2.37 GB
2.80 GB

3 11.8 (NTSC)
10.1 (PAL)

84.4 MB
98.5 MB

844 MB
985 MB

2.53 GB
2.96 GB

4 11.1 (NTSC)
9.6 (PAL)

89.7 MB
103 MB

897 MB
1.04 GB

2.69 GB
3.12 GB

8 9.0 (NTSC)
8.0 (PAL)

111 MB
125 MB

1.11 GB
1.25 GB

3.33 GB
3.75 GB

3:1 0 3.6 (NTSC)
3.0 (PAL)

278 MB
333 MB

2.78 GB
3.33 GB

8.33 GB
10.0 GB

1 3.5 (NTSC)
3.0 (PAL)

283 MB
339 MB

2.83 GB
3.39 GB

8.49 GB
10.2 GB

2 3.5 (NTSC)
2.9 (PAL)

288 MB
344 MB

2.88 GB
3.44 GB

8.65 GB
10.3 GB

Table 67 Estimated Storage Requirements: Progressive
 (Continued)

Resolution
Audio 
Tracks

Minutes 
Per 
Gigabyte 

Drive 
Space 
Needed for 
1 Minute of 
Media

Drive 
Space 
Needed for 
10 Minutes 
of Media

Drive Space 
Needed for 
30 Minutes 
of Media
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3 3.4 (NTSC)
2.9 (PAL)

294 MB
349 MB

2.94 GB
3.49 GB

8.81 GB
10.5 GB

4 3.3 (NTSC)
2.8 (PAL)

299 MB
355 MB

2.99 GB
3.55 GB

8.97 GB
10.6 GB

8 3.1 (NTSC)
2.7 (PAL)

320 MB
376 MB

3.20 GB
3.76 GB

9.61 GB
11.3 GB

2:1 0 2.4 (NTSC)
2.0 (PAL)

417 MB
500 MB

4.17 GB
5.00 GB

12.5 GB
15.0 GB

1 2.4 (NTSC)
2.0 (PAL)

422 MB
505 MB

4.22 GB
5.05 GB

12.7 GB
15.2 GB

2 2.3 (NTSC)
2.0 (PAL)

427 MB
510 MB

4.27 GB
5.11 GB

12.8 GB
15.3 GB

3 2.3 (NTSC)
1.9 (PAL)

433 MB
516 MB

4.33 GB
5.16 GB

13.0 GB
15.5 GB

4 2.3 (NTSC)
1.9 (PAL)

438 MB
521 MB

4.38 GB
5.21 GB

13.1 GB
15.6 GB

8 2.2 (NTSC)
1.8 (PAL)

459 MB
542 MB

4.59 GB
5.42 GB

13.8 GB
16.3 GB

1:1
(Uncompressed)

0 1.0 (NTSC)
0.9 (PAL)

1.00 GB
1.15 GB

10.0 GB
11.5 GB

30.0 GB
34.5 GB

1 1.0 (NTSC)
0.9 (PAL)

1.01 GB
1.15 GB

10.1 GB
11.5 GB

30.3 GB
34.6 GB

2 1.0 (NTSC)
0.9 (PAL)

1.01 GB
1.16 GB

10.1 GB
11.6 GB

30.3 GB
34.8 GB

Table 67 Estimated Storage Requirements: Progressive
 (Continued)

Resolution
Audio 
Tracks

Minutes 
Per 
Gigabyte 

Drive 
Space 
Needed for 
1 Minute of 
Media

Drive 
Space 
Needed for 
10 Minutes 
of Media

Drive Space 
Needed for 
30 Minutes 
of Media
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Estimated Storage Requirements: DV

Table 68 provides information to help you estimate the storage 
requirements for DV media.

Before using this table, read the information in “Estimating Drive Space 
Requirements” on page 189 and “Estimated Storage Requirements” on 
page 190.

n Calculations are approximate. They are based on dual-stream playback 
with four channels of audio, and include a 10 percent system overhead 
factor.

3 1.0 (NTSC)
0.9 (PAL)

1.02 GB
1.17 GB

10.2 GB
11.7 GB

30.6 GB
35.1 GB

4 1.0 (NTSC)
0.9 (PAL)

1.02 GB
11.7 GB

10.2 GB
11.7 GB

30.6 GB
35.1 GB

8 1.0 (NTSC)
0.8 (PAL)

1.04 GB
1.19 GB

10.4 GB
11.9 GB

31.3 GB
35.8 GB

Table 67 Estimated Storage Requirements: Progressive
 (Continued)

Resolution
Audio 
Tracks

Minutes 
Per 
Gigabyte 

Drive 
Space 
Needed for 
1 Minute of 
Media

Drive 
Space 
Needed for 
10 Minutes 
of Media

Drive Space 
Needed for 
30 Minutes 
of Media

Table 68 Estimated Storage Requirements: DV

Resolution
Minutes Per 
Gigabyte

Drive Space 
Needed for 
1 Minute of 
Media

Drive Space 
Needed for 
10 Minutes 
of Media

Drive Space 
Needed for 
30 Minutes 
of Media

DV 25 (NTSC) 2.1 480 MB 4.8 GB 14.4 GB
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Maximizing Drive Space

If your media drive space is limited or you are digitizing a large amount of 
source material, follow these suggestions to maximize your usage of the 
media drive space:

For more information 
on batch digitizing and 
recapturing, see “Batch 
Capturing” in the Help.

• Capture only the audio channels required for the edit.

• Log in advance. Batch capture only the footage required for the edit.

• Capture at a lower resolution for editing. Recapture only the clips 
included in the final cut at a higher resolution.

DV 25 (PAL) 2.7 384 MB 3.8 GB 11.5 GB

DV 50 (NTSC) 1.1 930 MB 9.3 GB 27.9 GB

DV 50 (PAL) 1.4 744 MB 7.4 GB 22.3 GB

Table 68 Estimated Storage Requirements: DV

Resolution
Minutes Per 
Gigabyte

Drive Space 
Needed for 
1 Minute of 
Media

Drive Space 
Needed for 
10 Minutes 
of Media

Drive Space 
Needed for 
30 Minutes 
of Media
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Managing Storage to Improve Playback Performance

The way you set up the media drives and target them when you capture can 
affect playback performance. Here are some suggestions for working with 
complex video images at high resolution, multiple video layers, or 
multicamera material:

• For more effective playback of multiple streams of video at higher 
resolutions, stripe the media drives. Some resolutions require drive 
striping; see “Getting Information About Striped Drives” in the Help.

• For more effective playback of multiple streams of video at higher 
resolutions without drive striping, distribute the video tracks as evenly 
as possible among available drives, and target separate drives for audio 
and video.

• Try to target one volume per reel.
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Chapter 8

Avid Log Specifications

This section explains the Avid log file format. The Avid editing system can 
import logs that meet Avid log specifications. These logs must follow the 
formatting requirements described in this appendix.

Understanding Avid Log Specifications

You can prepare an Avid log on any type of IBM-compatible or Macintosh 
computer by using a word processing application or a text editor. You can 
use the file name extension .txt, but it is not required.

To ensure accuracy, you must follow the Avid log specifications described 
in this appendix.

An Avid log is composed of three sections, in this order:

• Global headings

• Standard and custom column headings

• Data headings

When you create an Avid log, you must follow the order precisely. The 
tables in this section follow this order.

For an example of a simple log file, see “Sample Avid Log” on page 210.
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Avid Log Specifications

This section contains tables that show how to enter headings and data to 
create an Avid log. The tables use the following conventions:

• A heading appears in the first column, without angle brackets or 
standard brackets. For example, FIELD_DELIM is the first global 
heading.

• A <supported value> is surrounded by angle brackets. <Alternative 
supported values> appear underneath, also in angle brackets. You must 
enter exactly one of these values. For example, <29.97> is one of the 
supported values for the FPS heading; to specify that value, type 
29.97.

• <A variable data value> is also surrounded by angle brackets, but it is 
italicized. For example, <timecode> is the data entry for the Start 
heading; type the correct timecode, in the format 08:19:10:00 (or 
08;19;10;00, for drop-frame timecode).

• [Tab] and [Enter] (Windows) or [Return] (Macintosh) keys are 
surrounded by standard brackets.

• A column contains the word “Required” if the heading must be 
included in the log.

• The final column contains notes about the heading or values.

You can decide not to display a defined heading (including a required 
heading), except for Name. Name must always be displayed.

The maximum number of combined global, standard, and custom headings 
in a log file is 64. 
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Global Headings

The global headings must come first in an Avid log file, and you must enter 
one value for each heading.

Table 69 shows the format for the global headings and the supported values 
for each heading.

Table 69 Avid Log Global Headings

GLOBAL HEADINGS: Global headings are case sensitive and must be spelled exactly as shown. 
Include all required headings. Other headings are optional but might be necessary for your project. The 
maximum number of combined global, standard, and custom headings in a log file is 64.

Heading [Enter] 
or 
[Return]

Required This marks the start of the 
global headings.

FIELD_DELIM [Tab] <TABS> [Enter] 
or 
[Return]

Required Enter TABS to show that the 
file is Tab delimited.

VIDEO_FORMAT [Tab] <NTSC>
<PAL>

[Enter] 
or 
[Return]

Required

FILM_FORMAT [Tab] <16mm>
<35mm,3perf>
<35mm,4perf>

[Enter] 
or 
[Return]

AUDIO_FORMAT [Tab] <22kHz>
<24kHz>
<44kHz>
<48kHz>

[Enter] 
or 
[Return]

Audio sampling rate for 
digitizing. You can override 
this for individual clips.

TAPE [Tab] <tape name> [Enter] 
or 
[Return]

Required Name of the videotape reel 
you are logging. If you omit 
this heading, the file name 
becomes the global tape 
name. You can override this 
for individual clips.
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Column Headings

The standard column headings appear after the global headings in the Avid 
log file.

You do not enter the data for a column heading along with the heading. 
You enter the data later, in a separate data section.

You must include the five required standard column headings; they are 
listed first in Table 70.

You can create your own custom column headings. Enter them after the 
standard headings (see the last heading in Table 70). To create a custom 
heading, substitute the custom heading name for <Your_heading>. You can 
create several custom headings, as long as the total of global, standard, and 
custom headings does not exceed 64.

FPS [Tab] <23.98>
<24>
<25>
<29.97>

[Enter] 
or 
[Return]

Required Capture rate is 23.98 fps 
(23.978 fps) for NTSC, 
24 fps for NTSC or PAL, 
25 fps for PAL, or 29.97 fps 
for NTSC. 

[Enter]
or 
[Return]

Press Enter (Windows) or 
Return (Macintosh) a 
second time after entering 
the FPS value. This marks 
the end of the global 
headings.

Table 69 Avid Log Global Headings (Continued)

Table 70 Avid Log Column Headings

COLUMN HEADINGS: Column headings are case sensitive and must be spelled exactly as shown. 
Note that the first five headings are required. Other headings are optional but might be necessary for 
your project. This table lists only the column headings that are relevant to shot log files. Some data, 
such as Creation Date, is gathered by the system. The following table does not include headings for 
such data. The maximum number of combined global, standard, and custom headings in a log file is 
64.
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Column [Enter] 
or 
[Return]

Required Indicates the start of the column headings.

Name [Tab] Required Heading for clip name. 

Tracks [Tab] Required Heading for tracks you select for digitizing. 

Start [Tab] Required Heading for video timecode of sync point — the 
timecode IN for clip. From address track of video. 

End [Tab] Required Heading for timecode OUT for clip. From address 
track of video.

Audio [Tab] Heading for the audio resolution (sample rate). If 
omitted, the global entry for AUDIO_FORMAT 
applies.

Auxiliary Ink [Tab] Heading for a second ink number used for the clip.

Auxiliary TC1 [Tab] Heading for auxiliary timecode.

Auxiliary TC2 [Tab] Heading for auxiliary timecode.

Auxiliary TC3 [Tab] Heading for auxiliary timecode.

Auxiliary TC4 [Tab] Heading for auxiliary timecode.

Auxiliary TC5 [Tab] Heading for auxiliary timecode.

Camera [Tab] Heading for the camera used to film this clip. This 
feature is used in multicamera shoots.

Camroll [Tab] Heading for the camera roll ID containing this clip.

Duration [Tab] Heading for timecode Start to timecode End, the 
length of the video clip.

FPS [Tab] Heading for video frames per second rate for 
digitizing the individual clip. If omitted, the global 
entry applies.

Film TC [Tab] Heading for the timecode used on the film.

Ink Number [Tab] Heading for the ink number used for the clip.

Table 70 Avid Log Column Headings (Continued)
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KN Duration [Tab] Heading for the length of the clip, expressed in feet 
and frames.

KN End [Tab] Heading for the ending key number for the clip.

KN Start [Tab] Heading for the starting key number for the clip.

Labroll [Tab] Heading for the lab roll ID for the clip. Lab rolls are a 
combination of several camera rolls.

Perf [Tab] Heading for the film-edge perforations format used 
for 3-perf projects.

Pullin [Tab] Heading for the telecine pulldown of the first frame of 
the clip (pulldown phase). Pullin can have the values 
A, B, C, or D.

Pullout [Tab] Heading for the telecine pulldown of the last frame of 
the clip (pulldown phase). Pullout can have the values 
A, B, C, or D.

Reel # [Tab] Heading for the source reel number.

Scene [Tab] Heading for the scene number of the clip.

Shoot date [Tab] Heading for the date the footage was shot.

Sound TC [Tab] Heading for Nagra timecode, Arri code, and so on, at 
the sync point. Syncs with the Start timecode. 
Required if tracking the sync sound. Capture rate can 
be 25 or 30 fps.

Soundroll [Tab] Heading for sound roll ID for clip.

TC 24 [Tab] Heading for 24-fps timecode.

TC 25P [Tab] Heading for 25-fps timecode with pulldown.

TC 25 [Tab] Heading for 25-fps timecode.

TC 30 [Tab] Heading for 30-fps timecode.

Take [Tab] Heading for take ID for clip. 

Tape [Tab] Heading for source tape ID for the individual clip. If 
omitted, the global entry applies.

Table 70 Avid Log Column Headings (Continued)
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Data Entries

The data entries come after the Custom column headings. Table 71 shows 
the format for entering data. Enter a line of data in this format for every 
clip. Be sure to start the data section for each clip with the word Data 
[Enter] (Windows) or Data [Return] (Macintosh).

DESCRIPT [Tab] Heading for description of clip.

COMMENTS [Tab] Heading for comments about clip.

<Your_heading> [Tab] Add any category of information you want. Add as 
many headings as you want, but do not use more than 
a total of 64 global and column headings in the file. 
Press the Tab key between each heading. Do not press 
the Tab key after the last heading. 

[Enter] 
or 
[Return]

[Enter] 
or 
[Return]

Press [Enter] (Windows) or [Return] (Macintosh) 
twice (do not press Tab) after the last heading.

Table 70 Avid Log Column Headings (Continued)

Table 71 Avid Log Data Headings

DATA HEADINGS: The word Data marks the start of the data for each clip.

Data [Enter]
or 
[Return]

Required Enter the word Data to mark the start of the logged clip 
entries.

DATA FOR EACH CLIP: Enter a line of data for each clip. Enter the data so it aligns with its column 
heading. (The data that goes with the ninth column heading must be the ninth data entry.) Be sure to 
enter data for all the required values. To leave a data position unfilled, press the Tab key instead of 
typing data. Press Enter (Windows) or Return (Macintosh) at the end of each line. Your Avid system 
supports up to four audio tracks in imported and exported logs.

<clip name> [Tab] Required Under Name heading. Enter a clip identifier 
(32 characters maximum). 
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<V>
<VA1>
<VA2>
<VA1A2>
<A1A2>
<A1>
<A2>

[Tab] Required Under Tracks heading. Enter the tracks you want 
captured for the clip. Enter V for MOS takes. Enter A1, 
A2, or A1A2 for wild sound.

<timecode> [Tab] Required Under Start heading. Enter the video timecode for the 
sync point, the first frame of the clip. Use colons for 
non-drop-frame (for example, 01:00:12:20). Use one or 
more semicolons for drop-frame (for example, 
01;18;00;02).

<timecode> [Tab] Required Under End heading. Enter the video timecode for the 
last frame of the clip.

<22kHz>
<24kHz>
<44kHz> 
<48kHz>

[Tab] Under Audio heading. Enter the audio sampling rate for 
this clip only. If omitted, global entry applies.

<inknumber> [Tab] Under Auxiliary Ink Number heading. Identify a 
second ink number for the start of the clip.

<timecode> [Tab] Under Auxiliary TC heading. Enter a Nagra timecode, 
Arri code, and so on, for the sync point. Syncs with the 
Start timecode.

<camera ID> [Tab] Under Camera heading. Identify the camera, using 
letters or numbers. For multicamera shoots.

<camera roll ID> [Tab] Under Camroll heading. Identify the camera roll, using 
letters and numbers.

<timecode> [Tab] Under Duration heading. Enter the length of the video 
clip, Start to End.

<23.98>
<24>
<25>
<29.97>

[Tab] Under FPS heading. Enter the video capture rate for this 
clip only. If omitted, the global entry applies. Use 
23.98 fps (23.978 fps) for NTSC, 24 fps for NTSC or 
PAL, 25 fps for PAL, or 29.97 fps for NTSC. 

<timecode> [Tab] Under Film TC heading. Identify the timecode used for 
the film, usually at 24 fps.

Table 71 Avid Log Data Headings (Continued)
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<inknumber> [Tab] Under Ink Number heading. Identify the ink number 
for the start of the clip.

<keynumber> [Tab] Under KN Start heading. Identify the complete key 
number for the start of the clip, for example, KU 31 
2636-8903&12.

<keynumber> [Tab] Under KN End heading. Identify the key number for the 
end of the clip. You need to identify only feet and 
frames, for example, 0342&07.

<keynumber> [Tab] Under KN Duration heading. Identify the length of the 
clip, in feet and frames.

<lab roll ID> [Tab] Under Labroll heading. Identify the lab roll, using 
letters and numbers.

<1>
<2>
<3>

[Tab] Under Perf heading. Edit the perf for this clip only.

<A>
<B>
<X> (matchback only)
<C>
<D>

[Tab] Under Pullin heading. Identify the telecine pulldown of 
the first frame of the clip (pulldown phase). NTSC only.

<A>
<B>
<X> (matchback only)
<C>
<D>

[Tab] Under Pullout heading. Identify the telecine pulldown 
of the last frame of the clip. NTSC only.

<reel ID> [Tab] Under Reel # heading. Identify the reel, using numbers.

<scene ID> [Tab] Under Scene heading. Identify the scene, using letters 
and numbers.

<shoot date> [Tab] Under Shoot Date heading. Identify the date the footage 
was shot, in numbers or in letters and numbers.

<timecode> [Tab] Under Sound TC heading. Identify the sound timecode 
at the sync point. Syncs with the Start timecode.

Table 71 Avid Log Data Headings (Continued)
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Sample Avid Log

This section contains a sample Avid log for an NTSC video project, in 
Windows and Macintosh formats.

Formatting keys (such as [Tab] and [Enter] (Windows) or [Return] 
(Macintosh)) are shown in brackets.

<sound roll ID> [Tab] Under Soundroll heading. Identify the sound roll, using 
letters and numbers.

<timecode> [Tab] Under TC 24 heading. Identify the start of the clip for 
24p timecode.

<timecode> [Tab] Under TC 25p heading. Identify the start of the clip for 
25p timecode (PAL pulldown).

<timecode> [Tab] Under TC 25 heading. Identify the start of the clip for 
25-fps timecode (PAL).

<timecode> [Tab] Under TC 30 heading. Identify the start of the clip for 
30-fps timecode.

<take ID> [Tab] Under Take heading. Identify the take, using letters and 
numbers.

<source tape ID> [Tab] Under Tape heading. Enter the source videotape ID for 
this clip only.

<clip description> [Tab] Under DESCRIPT heading. Describe the clip.

<clip comments> [Tab] Under COMMENTS heading. Comment on the clip.

<information> [Tab] Under the headings you created yourself, type the 
appropriate information.

[Enter] or [Return] Press Enter (Windows) or Return (Macintosh) after the 
last entry for the clip. 

Do not press Tab after the last entry for the clip.

Enter an additional line of data for each remaining clip.

Table 71 Avid Log Data Headings (Continued)
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Heading [Enter]

FIELD_DELIM [Tab] TABS [Enter]

VIDEO_FORMAT [Tab] NTSC [Enter]

AUDIO_FORMAT [Tab] 44kHz [Enter]

TAPE [Tab] 001 [Enter]

FPS [Tab] 29.97 [Enter]

[Enter]

Column [Enter]

Name [Tab] Tracks [Tab] Start [Tab] End [Enter]

[Enter]

Data [Enter]

CU Josh & Mary [Tab] V [Tab] 01:00:00:00 [Tab] 01:15:05:00 [Enter]

Windows

Heading [Return]

FIELD_DELIM [Tab] TABS [Return]

VIDEO_FORMAT [Tab] NTSC [Return]

AUDIO_FORMAT [Tab] 44kHz [Return]

TAPE [Tab] 001 [Return]

FPS [Tab] 29.97 [Return]

[Return]

Column [Return]

Name [Tab] Tracks [Tab] Start [Tab] End [Return]

[Return]

Data [Return]

CU Josh & Mary [Tab] V [Tab] 01:00:00:00 [Tab] 01:15:05:00 [Return]

Macintosh
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International Character 
Support

This document describes how to take advantage of international character 
support (ICS) on your Avid® editing system.

ICS allows you to display and input characters in languages other than 
English. There are two basic methods for using ICS:

• (Windows® only) Install the local language operating system, and 
work within the operating system.

• (Macintosh® or Windows) Use the standard English language 
operating system, install the language pack, and set the locale to your 
local language.

n Avid Unity™ MediaNetwork v3.2 or later also supports ICS. For more 
information, see the MediaNetwork documentation.

Using a Local Language Operating System 
(Windows Only)

If you use a local language operating system, consider the following items:

• When you start the Avid editing application for the first time, it 
automatically creates a keyboard setting for that language. You can 
view the keyboard mapping by clicking the appropriate Keyboard 
setting in the Settings scroll list. If you are using a language other than 
English, French, Italian, German, or Spanish, you might need to adjust 
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the mapping for the keyboard so the keys in the Keyboard palette 
match the keys on your physical keyboard. See “Using Foreign 
Keyboard Mapping” on page 221.

• If you are bringing older projects and bins forward to this version, you 
might need to use the CleanEncode utility to convert the file names so 
they can be viewed correctly in Windows Explorer and in the Avid 
editing application. See “Moving Older Projects to this Version on 
Windows” on page 222.

Choosing a Locale on an English Language 
Operating System (Windows and Macintosh)

This method is common on Windows systems, and it is the only option on 
Mac OS® X systems. When you use this method, you typically instruct 
your operating system to allow you to choose between English and a 
specific locale such as French, German, Chinese, or Japanese. This allows 
you to input and display characters in your chosen language even though 
you are using the basic English language operating system.

To take advantage of ICS on an English language operating system:

• Instruct your operating system to display the appropriate language in 
menus and dialog boxes and specify the language you want to use for 
keyboard layouts. Follow the instructions in one of the following 
sections:

- “Non-English Character Support (Macintosh)” on page 215

- “Non-English Character Support (Windows 2000)” on page 218

• (Windows only) If you are using a language other than English, 
French, Italian, German, or Spanish, you might need to adjust the 
mapping for the keyboard so the keys in the Keyboard palette match 
the keys on your physical keyboard. See “Using Foreign Keyboard 
Mapping” on page 221.
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• (Windows only) If you are bringing older projects and bins forward to 
this version, you might need to use the CleanEncode utility to convert 
the file names so they can be viewed correctly in Windows Explorer 
and in the Avid editing application. See “Moving Older Projects to this 
Version on Windows” on page 222.

Non-English Character Support (Macintosh)

You can instruct the Mac OS X operating system to allow you to choose 
between English and a specific locale such as French, German, Chinese, or 
Japanese. This allows you to input and display characters in your chosen 
language even though you are using the basic English language operating 
system.

You need to specify the language in System Preferences and in the Get 
Info dialog box.

Setting the Language in System Preferences

In System Preferences, you need to specify which language should appear 
in operating system menus and dialog boxes. You can also add the 
language in which you want keyboard layouts and input methods to 
function.

To set the language in the International window:

1. Select Apple P menu > System Preferences > International.

The International window opens.
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2. Click the Language tab.

3. In the Languages list, click the language you want, and drag it to the 
top of the list. If you do not see the language you want in the list, click 
Edit, select the language, and click OK.

4. In the Script list, select the Script you want.

5. Click the Behaviors pop-up menu, and select the text behavior you 
want to be associated with your script.

6. (Option) Select options in the other International dialog box tabs.
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To add your language’s keyboard layouts and character set to the 
operating system’s Input menu:

1. Click the Input Menu tab.

2. Select the language or languages in which you want to type.

If you select more than one language, they appear in the Input menu.

3. Click the Close button.

4. In the Finder™ title bar, select Input > language.

n The Input menu is not labeled in the title bar. Look for the Flag icon in the 
title bar.

Specifying the Language in the Get Info Dialog Box

If you are attempting to enter text within your Avid application and you are 
not seeing characters from your language, you need to specify the language 
in the application’s Resources folder.

n You do not need to perform this procedure if all of your language’s 
characters appear correctly in the Avid application.
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To specify the languages in the Get Info dialog box:

1. Locate the Avid editing application on your Macintosh HD. For 
example:

Applications/Avid Media Composer Adrenaline/MediaComposer 
Adrenaline

2. Click the application icon, and select File > Get Info.

The Get application Info dialog box opens.

3. Click the triangular opener for Languages.

4. Locate your language in the list and select it if it is not already 
selected.

5. Close the Get application Info dialog box.

The next time you start the application, you will be using the language that 
you specified in the International window. System menus and dialog boxes 
appear in your selected language. The Avid menus and buttons still appear 
in English. You can now enter characters in your selected language.

The Get Info dialog box makes use of files known as language resource 
files to specify the language and regional code to use. The Avid software 
installation program automatically installs a set of language resource files 
for supported languages.

n For more information about language and region codes, see the following 
Web sites:

www.loc.gov/standards/iso639-2/englangn.html

www.iso.ch/iso/en/prods-services/iso3166ma/02iso-3166-code-
lists/list-en1.html

Non-English Character Support (Windows 2000)

You can specify a non-English keyboard layout and text entry format for 
the language in which you want to type.
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Choosing a Locale on an English Language Operating System (Windows and Macintosh)
n The operating system does not need to be in the same language as that in 
which you are typing.

To specify a language in which to type:

1. (Option) Plug in a regional keyboard.

2. Click the Start button, and select Settings > Control Panel.

3. Double-click Regional Options.

The Regional Options dialog box opens.

4. In the General tab, do the following:

a. Click the “Your locale (location)” pop-up menu, and select a 
locale.

b. In the “Language settings for the system” area, select a language.
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c. Click “Set default.”

5. (Option) Select options in the other Regional Options dialog box tabs.

6. Click the Input Locales tab.

7. In the “Installed input locales” area, select an input language.

8. If the language you want is not in the list, click Add, and select an 
input locale and a keyboard layout for the language.

9. Click Set as Default.

10. Click Apply. If you need to install additional files, the Insert CD-ROM 
dialog box opens. 

11. Click OK.

The Files Needed dialog box opens. 
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12. Follow the instructions, and then click OK.

13. To have your selected language appear on the taskbar, select “Enable 
indicator on taskbar.”

14. Click OK.

15. Restart the system.

Using Foreign Keyboard Mapping

When you start the Avid editing application under a new locale, the 
application automatically creates a Keyboard setting for your language. 
You can view the keyboard layout by clicking the appropriate Keyboard 
setting in the Settings scroll list. 

The default Avid keyboard layouts for English, French, Italian, German, 
and Spanish languages map correctly to the characters on the physical 
keyboard. However, if you are using a different language, the display in 
the Keyboard palette might not match your physical keyboard layout. You 
can use the Foreign Keyboard Mapping button in the Keyboard palette to 
display the correct character in the Keyboard palette.

n The Foreign Keyboard Mapping function is not needed for English, 
French, Italian, German, or Spanish.

To set the keyboard mapping for a key:

1. Double-click Keyboard in the Settings scroll list in the Project 
window.

The Keyboard palette opens.

2. Compare the layout to your physical keyboard. 

If some of the letters do not match, you can change the characters 
displayed in the Keyboard palette.

3. Click the Foreign Keyboard Mapping button.

4. Click the key that you want to change in the Keyboard palette.

The key changes to blue.

5. Press the corresponding key on your keyboard.
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The image in the Keyboard palette changes to match your keyboard, 
and the mapped key remains blue.

n Each language has a certain number of keys that do not map to functions 
in the Avid editing application. These are referred to as “dead” keys. You 
cannot map functions to these dead keys. If you try to do so, the system 
displays an error message.

Moving Older Projects to this Version on Windows

CleanEncode is a utility that changes the character encoding method for a 
file name from MacRoman to ANSI or vice versa. If you are moving older 
projects to this version on Windows, you might need to use CleanEncode 
to convert the older MacRoman encoding to ANSI encoding.

CleanEncode is intended for customers on Windows systems that meet the 
following criteria:

• If you use special characters to name projects, bins, tapes, or other 
Avid metadata. Specifically, this includes characters with a value 
greater than 127 in the ASCII character set. Such characters are 
common in Western European languages and include accented 
characters (for example, â or ê).

• If you plan to move projects from one of the following Avid editing 
applications (Windows only) to the current version:

- Avid Media Composer or Film Composer v11.5 or earlier

- Avid Symphony releases v4.5 or earlier

- Avid Xpress v5.5 or earlier

- Avid NewsCutter v3.5 or earlier

- Avid Xpress DV 3.5 or earlier

- MediaManager Release 3.5 or earlier

- TransferManager Release 2.0.5 or earlier

Complete instructions for using CleanEncode can be found in the 
CleanEncodeGuide.pdf file. This file is available in the CleanEncode 
folder in the Utilities folder.
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n If you use CleanEncode to process the files in your OMFI MediaFiles 
folder, delete the .pmr and .mbd database files after you run CleanEncode 
and restart the Avid editing application. This will ensure that the Avid 
application recognizes the newly converted names.

n When you upgrade an Avid Unity MediaNetwork workgroup to 
MediaNetwork v3.2, MediaNetwork automatically converts file names to 
file names with characters in Unicode™. If you plan to move Avid files from 
a the versions listed above onto an existing MediaNetwork v3.2 system, use 
CleanEncode on the files before you move them onto the network.

Recommendations and Restrictions

This section describes recommendations and restrictions for using 
international character support on your Avid system.

Avid Supports English Plus One Locale

Make sure that your projects do not contain characters from more than one 
locale. String compare searches might not work correctly if you combine 
file names from different locales. 

n On MediaNetwork, all the systems on the network must be either English 
or one specific locale.

Entering ASCII Characters in Double-Byte Systems

The following restriction applies to customers who work on double-byte 
(two-byte) operating systems: If you use ASCII characters to name bins, 
projects, tapes, or other Avid elements, use single-byte characters. If 
you use double-byte characters, the characters might appear with extra 
space between them and the names might not be recognizable by other 
systems.
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Operating systems that use a double-byte character system usually allow 
the user to choose between single-byte ASCII or double-byte ASCII 
characters. If you have a choice, use single-byte characters when entering 
ASCII text.

Characters to Avoid When Naming Avid Elements

Do not use the Japanese yen symbol in the ASCII character set. The system 
converts the symbol to a backslash, and this can cause problems with 
pathnames.

Do not use the Y-acute and Y-diaeresis characters. The system does not 
recognize the Y-acute character, and it can cause problems with file 
recognition. The system might not display the Y-diaeresis character 
correctly.

When you name a Mac OS X computer, use single-byte ASCII characters 
without spaces. The system uses the name in pathnames, and non-ASCII 
characters and spaces can cause problems with pathnames.

If you plan to move projects between Macintosh and Windows systems, 
avoid using characters that are not in both the MacRoman and Latin1 
(ANSI) character sets. The following two files on the Knowledge Center 
list the characters you should stop using:

• MacRoman Characters not in ANSI Encoding

• ANSI Characters not in MacRoman Encoding

To access the files on the Knowledge Center:

1. Go to www.avid.com.

2. Click Support, and then click Online Support.

3. Under the Avid Knowledge Center heading, click Documentation.

The Knowledge Center opens to the Documentation tab.

4. Select your products from the Current Product list at the top of the 
Web page.

5. Click Tech Notes
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6. Select your Release number.

7. Click “MacRoman Latin-1 Character Differences.”

8. Click the HTML files to display the contents.

n The files are the same for each product.

To display the characters in the HTML files correctly, you might have to 
set your Web browser to display characters in Unicode format.

To display characters in Unicode format on Internet Explorer:

t Select View > Encoding > More > Unicode (UTF-8).
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Chapter 10

Planning a Film Project

This chapter presents suggested workflows and other information that can 
help you plan your film-originated project. This chapter includes the 
following topics:

• Working with 24p Media

• Working with 25p Media

• Planning a 24p or 25p Project

• Planning a 23.976p NTSC Project

• Film Project Considerations

Working with 24p Media

With new DTV (digital television) formats expanding the options for 
content distribution, there is renewed interest in the oldest format in the 
industry: 24-fps film. In addition to its common, worldwide format, film 
provides the highest resolution master for archiving purposes. Through a 
telecine transfer and the digitizing process, the Avid system captures and 
stores film frames as 24-fps progressive media, or 24p.

Progressive media is composed of single frames, each of which is 
vertically scanned as one pass. The Avid system creates 24p media by 
combining (deinterlacing) two video fields into a single full, reconstructed 
frame. For NTSC film-to-tape transfers, the system creates 24p media by 
removing the extra fields inserted by the 2:3 pulldown process and by 
creating progressive frames.
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Working in 24p simplifies digital editing of film or other 24-fps-originated 
content, such as HDTV video that has been downconverted to ITU-R 601 
digital video. In addition, 24p media requires less storage and processing 
power than 30-fps media. Because 24p provides a common production 
format for multiversion, multiformat delivery; it promises to become the 
new universal format for all film and video content.

An important aspect of the 24p format is that it allows you to output either 
NTSC or PAL video from the same project.

For more information, see “How the Avid System Stores and Displays 24p 
and 25p Media” in the Help.

Working with 25p Media

The 25p format is primarily for use in countries where PAL video is 
standard. When you transfer 25-fps film footage to 25-fps PAL video, no 
modifications are necessary due to matching frame rates.

The 25-fps feature provides the following advantages:

• Simultaneous input of video and audio in sync

• Frame-accurate ink number tracking

• Digital cut recording directly to videotape 

• Frame-accurate cut lists and change lists

• Frame-accurate audio EDLs for online editing of audio tracks

• Frame-accurate EDLs for assembling footage from the transfer or for 
preparing an online show master

The source for 25p is typically 25-fps film or 25-fps HDTV format. The 
methods for creating and storing 25p media are the same as for 24p. For an 
example of a 25p project workflow, see “25-fps Film or HD Video Source, 
SDTV Downconversion, Multiformat Output” on page 236.

n You can capture the audio directly from the original Nagra reels or DAT 
tapes, and sync within the Avid system. For more information, see “Audio 
Transfer Options for 24p PAL Projects” on page 239.
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Planning a 24p or 25p Project

A 24p or 25p project is one that uses 24p or 25p media, which is created 
and stored in the Avid system. In most cases, the source footage is film 
shot at 24 fps (for 24p) or 25 fps (for 25p), but new technology is 
introducing 24p and 25p videotape formats, both for cameras and VTRs. 
For 24p or 25p videotape, you need to use a 24p VTR to downconvert the 
high-definition format of HDTV to SDTV digital video for digitizing by 
the Avid system.

n The 24p cameras and VTRs can typically work with either 24p or 25p 
footage.

Two possible workflows for 24p projects are:

• “24-fps Film Source, SDTV Transfer, Multiformat Output” on 
page 230

• “24-fps Film or HD Video Source, SDTV Downconversion, 
Multiformat Output” on page 233

For information about a typical 25p workflow, see “25-fps Film or HD 
Video Source, SDTV Downconversion, Multiformat Output” on page 236.

For film productions that screen dailies, the paths might be somewhat 
different. For more information, see “Viewing Dailies” on page 248.

Alternatively, you can use a Media Station XL system to capture footage or 
output a finished master. For more information, see the Avid Media Station 
XL Workflow Guide. For information about the Media Station XL product, 
contact your Avid representative or visit the Avid Web site.
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24-fps Film Source, SDTV Transfer, Multiformat Output

The workflow shown in Figure 1 and Figure 2 illustrates a possible path 
for film footage shot at the standard 24 fps, transferred to SDTV (standard 
definition television or ITU-R 601) video, and captured at 24 fps. Figure 1 
shows the offline stage of the workflow, using a Media Composer or 
Film Composer system with Universal Offline Editing. Figure 2 shows the 
online stage, using a Symphony system, film-tape-film-tape relinking 
(FTFT), and multiple output formats.

With this workflow, the sound recording is synchronized as part of the 
telecine transfer. For alternative audio workflows, see “Audio Transfer 
Options for 24p PAL Projects” on page 239.

For details on the telecine transfer process, see Chapter 5.
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Planning a 24p or 25p Project
1. The telecine process 
uses one-light or best-
light transfer and syncs 
picture and sound to 
create ITU-R 601 
video. The process 
adds 2:3 pulldown to 
film footage to create 
an NTSC videotape, or 
uses 4.1% speedup for 
PAL videotape. The 
telecine process also 
creates a shot log (for 
example, a FLEX file).

2. Convert the shot log 
file with Avid Log 
Exchange (ALE), then 
import the shot log file 
into Media Composer 
or Film Composer to 
create a bin or bins.

3. Batch capture the 
footage in an offline 
resolution, based on the 
shot log. The Avid 
system removes the 2:3 
pulldown and creates 
24p media.

4. Edit at 24 fps, apply 
Pan and Scan and other 
effects, and create a 
final sequence.

5. Create a floppy disk 
with project 
information for transfer 
to the Symphony online 
system. Create a 24p 
pull list for another 
telecine process, to 
retransfer footage used 
in the final edit.

Figure 1 Offline Workflow: 24-fps Film Source, SDTV Transfer
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 Chapter 10 Planning a Film Project
6. The telecine process 
uses the pull list and a 
full color-corrected 
transfer to create NTSC 
or PAL videotape with 
selects from the 
original negative 
(picture only). The 
process also creates a 
new shot log file.

7. Copy the project 
information from the 
floppy disk to the 
Symphony online 
system.

8. Convert the new shot 
log with ALE and 
import it into the 
Symphony system.

9. Batch capture in an 
online resolution, based 
on the new shot log file.

10. Relink the sequence 
and clips by key 
numbers (FTFT) and
complete any other
finishing.

11. Generate multiple 
formats. For NTSC and 
PAL, the system 
reinserts the pulldown 
or re-creates the 
speedup. For 
conforming film, it 
creates a 24p cut list. 

Figure 2 Online Workflow: 24-fps Film Source, SDTV Transfer, 
Multiformat Output
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24-fps Film or HD Video Source, SDTV Downconversion, 
Multiformat Output

This workflow is based on film or video footage shot at 24 fps and planned 
for HDTV (high-definition television). Different workflows are being 
developed for this new technology, which includes 24p tape formats, 
VTRs, and cameras. This workflow presents one possible path.

Figure 3 shows the offline stage of the workflow, using a Media Composer 
or Film Composer system with Universal Offline Editing. Figure 4 shows 
the online stage, using a Symphony system with Universal Mastering and 
multiple output formats.

With this workflow, the sound recording is synchronized as part of the 
telecine transfer. For alternative audio workflows, see “Audio Transfer 
Options for 24p PAL Projects” on page 239.

For details on the telecine transfer process, see Chapter 5.
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1. Source videotape 
comes either from a 
telecine transfer or a 
24-fps video camera. 
The telecine process 
transfers 24-fps film 
footage at 1:1 (no 
pulldown). It also 
creates a shot log (for 
example, a FLEX file).

2. For telecine transfer 
projects, convert the 
shot log file with ALE 
and import it into 
Media Composer or 
Film Composer to 
create a bin or bins.

3. Batch capture the 
footage in an offline 
resolution, based on the 
shot log. Use a 24p 
deck to downconvert 
HDTV to ITU-R 601 
video. The deck adds 
2:3 pulldown (NTSC) 
or 4.1% speedup 
(PAL). The Avid 
system removes the 
extra pulldown fields 
and creates 24p media.

4. Edit at 24 fps, apply 
Pan and Scan or other 
effects, and create a 
final sequence.

5. Create a 24p pull list 
for another telecine 
process, to retransfer 
footage used in the 
final edit. Create a 
floppy disk with project 
information for transfer 
to the Symphony online 
system.

Figure 3 Offline Workflow: 24-fps Film or HDTV Source, 
SDTV Downconversion
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6. For film-originated 
projects, the telecine 
process uses the pull 
list and full color-
corrected transfer to 
create HDTV videotape 
with selects from the 
original negative 
(picture only). The 
process also creates a 
new shot log file.

7. Copy the project 
information to the 
Symphony online 
system.

8. For telecine transfer 
projects, convert the 
new shot log file with 
ALE and import it into 
the Symphony system.

9. Batch capture in an 
online resolution, based 
on the new shot log file. 
Downconvert either the 
telecine transfer tape or 
HDTV source tape.

10. Relink the sequence 
and clips by key 
numbers (FTFT) and
complete any other
finishing.

11. Generate multiple 
formats for output. For 
NTSC and PAL, the 
Symphony system 
reinserts pulldown or 
re-creates the speedup. 
For conforming film, it 
creates a 24p cut list. 
For HDTV, it creates a 
24p EDL for use in an 
online suite.

Figure 4 Online Workflow: 24-fps Film or HDTV Source, SDTV 
Downconversion, Multiformat Output

 

oror

HD 24
HD 24

or

(Step 6)

(Step 9)

(Step 7)

(Step 8)

(Step 10)

(Step 11)

From the
offline 
system

From the 
offline
system

Film shot 
at 24 fps

Telecine transfer process (picture only)

Video shot by 
24-fps camera

Symphony 
online
system

NTSC 29.97 fps 
4:3 or 16:9

PAL 25 fps 
4:3 or 16:9

Conformed 
film cut

Conformed 
HDTV master

Beta-
cam

Beta-
cam

Log

HD

EDL

Pull list

Cut list 24p EDL

Proj
235



 Chapter 10 Planning a Film Project
25-fps Film or HD Video Source, SDTV Downconversion, 
Multiformat Output

This workflow is based on film or video footage shot at 25 fps and planned 
for HDTV (high-definition television). Different workflows are being 
developed for this new technology, which includes 25p tape formats, 
VTRs, and cameras. This workflow presents one possible path.

Figure 5 shows the offline stage of the workflow, using a Media Composer 
or Film Composer system with Universal Offline Editing. Figure 6 shows 
the online stage, using a Symphony system with Universal Mastering and 
multiple output formats.

With this workflow, the sound recording is synchronized as part of the 
telecine transfer. For more information about digitizing and synchronizing 
audio, see “Audio Transfer Options for 24p PAL Projects” on page 239.

n For NTSC output this method slows the audio by 4 percent. If you plan to 
output to both NTSC and PAL, you might want to shoot at 24 fps and use 
24p instead of 25p.

For details on the telecine transfer process, see Chapter 5.
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Planning a 24p or 25p Project
1. Source videotape 
comes either from a 
telecine transfer or a 
25-fps video camera. 
The telecine process 
transfers 25-fps film 
footage at 1:1 (no 
pulldown). It also 
creates a shot log (for 
example, a FLEX file).

2. For telecine transfer 
projects, convert the 
shot log file with ALE 
and import it into 
Media Composer or 
Film Composer to 
create a bin or bins.

3. Batch capture the 
footage in an offline 
resolution, based on the 
shot log. Use a 25p 
deck to downconvert 
HDTV to ITU-R 601 
video. The deck does 
not need to add 
pulldown or speed up 
the audio since the 
footage will remain at 
25 fps. The Avid 
system creates 25p 
media.

4. Edit at 25 fps, apply 
Pan and Scan or other 
effects, and create a 
final sequence.

5. Create a 25p pull list 
for another telecine 
process, to retransfer 
footage used in the 
final edit. Create a 
floppy disk with project 
information for transfer 
to the Symphony online 
system.

Figure 5 Offline Workflow: 25-fps Film or HDTV Source, 
SDTV Downconversion
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6. For film-originated 
projects, the telecine 
process uses the pull 
list and full color-
corrected transfer to 
create HDTV videotape 
with selects from the 
original negative 
(picture only). The 
process also creates a 
new shot log file.

7. Copy the project 
information to the 
Symphony system.

8. For telecine transfer 
projects, convert the 
new shot log file with 
ALE and import it into 
the Symphony system.

9. Batch capture in an 
online resolution, based 
on the new shot log file. 
Downconvert either the 
telecine transfer tape or 
HDTV source tape.

10. Relink the sequence 
and clips by key 
numbers (FTFT) and
complete any other
finishing.

11. Generate multiple 
formats for output. For 
NTSC, the system 
inserts 2:3 pulldown 
and slows down the 
audio by 4%. No 
adjustment is needed 
for PAL. For film, it 
creates a 25p cut list. 
For HDTV, it creates a 
25p EDL for use in an 
online suite.

Figure 6 Online Workflow: 25-fps Film or HDTV Source, SDTV 
Downconversion, Multiformat Output
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Audio Transfer Options for 24p PAL Projects

When you create a 24p PAL project, you must specify the appropriate 
audio transfer rate for the project. (This is not necessary for a 25p PAL 
project because there is no film speedup during the transfer.) The New 
Project dialog box provides Audio Transfer options that allow you to select 
either Film Rate or Video Rate. This value is project specific and should 
not be changed after you create the project unless you have a specific 
element that you need to transfer at a different rate.

n The Audio Transfer options are also located in the Film Settings dialog box 
and can be changed after the project is created. See “Transfer Settings for 
Film Projects” in the Help.

The Audio Transfer options are:

• Film Rate (100%): Select this option when your 24-fps film footage 
has been transferred MOS (roughly translated as “without sound”) to 
25 fps by speeding up the film, and the audio comes in separately at 
100 percent of the actual speed (PAL Method 2).

• Video Rate (100%+): Select this option when your 24-fps film 
footage has been transferred to 25 fps by speeding up the film, and the 
audio is synchronized to the video picture. This means that the audio 
speed is increased by 4.1 percent (PAL Method 1).

n The Info tab in the Project window allows you to view the audio transfer 
rate you selected when you created the project. The actual audio transfer 
rate might be different from the display if you used the Film Settings dialog 
box to change the audio transfer rate.
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Planning a 23.976p NTSC Project

Avid editing systems that include 24p support include a 23.976p NTSC 
project type. This project type is especially designed for capture and output 
of digital audio that has been transferred or recorded at 48 kHz, in sync 
with picture at 23.976 fps. A 23.976p project lets you maintain digital 
standards for all NTSC input and output at 23.976 fps.

Select this project type for one of the following reasons:

• Your film and audio sources have been synced in the telecine process 
and transferred to Digital Betacam® or other digital videotape formats. 
Audio from digital videotapes can now be directly input and output 
through the AES/EBU connections on the Gryphon I/O box. 

• Your audio and video sources have been shot at a camera rate of 
23.976 fps. This rate is used for film (film-based television) or 24p HD 
video (television or feature film). These sources can be downconverted 
to standard NTSC without further audio slowdown. Audio recorded at 
48 kHz can remain at 48 kHz throughout the project.

n The 23.976 fps frame rate is sometimes referred to as 23.97 fps or 
23.98 fps.

n The 23.976 fps frame rate is in direct proportion to the NTSC broadcast 
frame rate of 29.97 fps, which is used for film-to-tape transfer to the Avid 
editing system. For more information, see “Transferring 24-fps Film to 
NTSC Video” in the Help.
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Working in a 23.976p NTSC Project

The following sections describe how working in a 23.976p project affects 
tools and settings.

Creating a 23.976p Project

To create a 23.976p project:

1. Click New Project in the Select User and Project dialog box.

2. Type the name of your new project in the text box.

3. Click the Format pop-up menu, and select 23.976p NTSC.

4. Click the Film Type pop-up menu, and select a film-gauge tracking 
format.

If the source tapes were shot as video (such as 1080p/24 HD recorded 
at 23.976 fps), ignore the Film Type pop-up menu.

5. Click OK.

Film Settings

The Edit Play Rate and Audio Source Tape TC Rate options do not appear 
in the Film Settings dialog box. Edit Play Rate is automatically set at 
23.976 fps. The Audio Source Tape TC Rate does not apply to 23.976p 
projects because you cannot capture 30 fps audio in a 23.976p project.

Digitizing

Audio from digital videotapes can now be directly input and output 
through the AES/EBU connections on the Gryphon I/O box.

The pulldown indicator on the Gryphon I/O box never lights when working 
in a 23.976p project.

The pulldown switch in the Capture tool is not used and does not appear.

Bins

The FPS column displays 23.976 rounded up to 23.98.
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Import

Audio you import must be in sync with picture at 23.976 fps.

Digital Cut Tool

All output play rates are available, but only 23.976 NTSC maintains the 
original audio quality. For 23.976 NTSC, the audio rate is not slowed down 
for output and remains at 48 kHz. For 29.97 NTSC, the audio rate is sped 
up 25 percent and is not usable. Use this output rate for animations and 
other special applications. 24 fps NTSC, 24 fps PAL, and 25 fps PAL all 
require a sample-rate conversion, so high-quality audio is not guaranteed. 
For more information about output audio rates, see “Selecting Output 
Formats for 23.976p Projects” in the Help.

23.976-fps Film Transfer or HD Video Source, SDTV 
Downconversion, Multiformat Output

This workflow is based on film transferred at 23.976 or video footage shot 
at 23.976 fps and planned for HDTV (high-definition television). This 
workflow presents one possible path.

Figure 7 shows the offline stage of the workflow, using a Media Composer 
or Film Composer system with Universal Offline Editing. Figure 8 shows 
the online stage, using a Symphony system with Universal Mastering and 
multiple output formats.

With this workflow, the sound recording is synchronized as part of the 
telecine transfer. For a workflow in which video and audio are captured 
separately, see Figure 9.

For details on the telecine transfer process, see Chapter 5.
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Planning a 23.976p NTSC Project
1. Source videotape 
comes either from a 
telecine transfer or 
video shot at 23.976. 
The telecine process 
syncs audio and 
transfers film footage at 
1:1 (no pulldown). It 
also creates a shot log. 

2. For telecine transfer 
projects, convert the 
shot log file with ALE 
and import it into 
Media Composer or 
Film Composer to 
create a bin or bins.

3. Batch capture the 
footage in an offline 
resolution. Use a 24p 
deck to downconvert 
HDTV to ITU-R 601 
video. The deck adds 
2:3 pulldown for video 
but maintains audio at 
48 kHz. The Avid 
system removes the 
extra video pulldown 
fields, maintains audio 
at 48 kHz, and creates 
23.976p media.

4. Edit at 23.976 fps, 
apply Pan and Scan or 
other effects, and create 
a final sequence.

5. For film, create a 
pull list for another 
telecine process, to 
retransfer footage used 
in the final edit. Create 
a floppy disk with 
project information for 
transfer to the 
Symphony online 
system.

Figure 7 Offline Workflow: 23.976-fps Film Transfer or HDTV 
Source, SDTV Downconversion
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6. For film-originated 
projects, the telecine 
process uses the pull 
list and full color-
corrected transfer to 
create videotape with 
selects from the 
original negative 
(picture only). The 
process also creates a 
new shot log file.

7. Copy the project 
information to the 
Symphony online 
system.

8. For telecine transfer 
projects, convert the 
new shot log file with 
ALE and import it into 
the Symphony system.

9. Batch capture in an 
online resolution, based 
on the new shot log file. 
Downconvert either the 
telecine transfer tape or 
HDTV source tape.

10. For film, relink the 
sequence and clips by 
key numbers and 
complete any other
finishing.

11. Generate multiple 
formats for output. For 
NTSC video, the 
Symphony system 
reinserts pulldown. For 
conforming film, it 
creates a 24p cut list. 
For HDTV, it creates a 
24p EDL for use in an 
online suite.

Figure 8 Online Workflow: 23.976-fps Film Transfer or HDTV 
Source, SDTV Downconversion, Multiformat Output
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Planning a 23.976p NTSC Project
Figure 9 illustrates a workflow in which you capture audio and video 
separately, and then synchronize them in the Avid system.

1. The telecine process 
transfers film footage at 
1:1 (no pulldown). For 
film shot at 24 fps, the 
process slows the film 
speed to 23.976 fps 
(labeled 24 fps).

2. Capture the audio 
into the Avid system 
(no pulldown). Field 
audio should be 
recorded at 48 kHz. If 
shot at 48.048 kHz, it 
must be referenced to 
48 kHz outside of the 
Avid system.

3. Capture the picture 
footage in the Avid 
system. Use a 24p deck 
to downconvert to 
ITU-R 601 video. The 
deck adds 2:3 pulldown 
for video. The Avid 
system removes the 
extra video pulldown 
fields and creates 
23.976p media. 

4. Use the AutoSync 
feature to sync picture 
and sound. Edit and 
finish at 23.976p. 

5. Select one or more 
outputs, depending on 
your project needs. Figure 9 NTSC Audio and Video Captured Separately 
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Limitations for 23.976p Projects

Be aware of the following limitations:

• For film projects shot at 24 fps, audio must be “pulled down” or 
“slowed down” before it can be captured into a 23.976p project. The 
user does not have the choice of capturing non-pulled-down audio. 
Unlike 24p NTSC projects, where the audio pulldown switch can be 
set to 1.0 or 0.99 to support either 24 fps or 23.976 fps, 23.976p 
projects do not use the audio pulldown switch. These 23.976p projects 
can only support 48 kHz audio that is in sync with 23.976-fps picture 
on a 29.97-fps transfer tape.

• Media created in 24p projects and media created in 23.976p projects 
are not compatible. If you start working in one type of project and then 
decide to switch to the other, you need to recapture all video and audio 
media. You cannot relink video media or audio media across the two 
project types.

• OMF and AAF files that are output from a 23.976p project look 
slightly different from those from a 24p project. The edit rates will 
show up as 23.976 fps in these files. 

c Because of the way project information is stored, previous versions of 
Avid editing systems do not recognize 23.976p projects as being 
different from 24p projects. You can open 23.976p projects in previous 
versions, however, none of the media can play because of the different 
internal edit rates. Projects are not corrupted by opening them in 
older versions of the software (unless you try to modify clips or edit 
sequences). If necessary, you can recapture the media in the 24p 
project.

Film Project Considerations

This section presents information that could be useful when planning film 
projects that you will edit on an Avid system.
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Film Project Considerations
Film Shoot Specifications

Use the guidelines in Table 72 to help you plan for film shoots.

Table 72 Film Shoot Specifications

Element Supported Formats Notes

Film type 16mm Use Standard 16mm or Super 16mm.
Super 16’s aspect ratio closely matches 16:9.

35mm: 2, 3, 4, and 8 perf

65mm: 5, 8, 10, and 15 perf

16mm, 35mm 4 perf, and 35mm 3 perf are 
supported as projects in the Avid system. The 
remaining formats are supported through ink 
numbers and auxiliary ink numbers, which 
you select in the Film Settings dialog box. 
For more information, see the editing guide 
or Help for your Avid system.

Film wind B-wind Always use camera rolls with key numbers in 
ascending order.

Audio media 1/4-inch audiotape (Nagra) Use to record analog audio.

DAT or DA88 (digital audiotape) Use to record digital audio.

Audio timecodes 30-fps drop-frame or non-drop-
frame

Use for NTSC transfer projects, and for 
generating audio EDLs.

25-fps timecode Use for PAL transfer projects, and for 
generating audio EDLs in the PAL format.

Audio sync to in-camera timecode 
(Arri® 24-fps timecode)

Use for automatic syncing of sound with 
picture in the Avid system.

Sync methods Clapsticks Use for manual syncing of sound with 
picture.

Electronic slate (smart slate) Use for semiautomatic syncing.

In-camera timecode, with audio 
sync

Use for automatic, “slateless” syncing in the 
telecine.
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 Chapter 10 Planning a Film Project
Viewing Dailies

Viewing dailies is a critical part of the film production process. With an 
Avid system, there are two different ways to produce dailies.

• The film dailies method relies on work print for screening, transferring, 
and creating conformed cuts during editing. 

• The video dailies method relies on videotape transfers from negative 
for screening, transferring, and creating conformed cuts during editing. 

Slate information Camera roll, scene and take, shoot 
date, sound-roll ID

Mark sound-roll ID as a backup.

Sound-roll cues Sound-roll ID, date, start and end 
time-of-day timecode

Include verbal time-of-day cues as a backup.

Table 72 Film Shoot Specifications (Continued)

Element Supported Formats Notes
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Film Project Considerations
Film Dailies Method

The film dailies method involves the procedures shown in Figure 10. 
Specifics, such as tape formats, vary depending on facilities and needs.

1. Prepare work print 
for the circled 
(selected) takes.

2. Sync work print with 
audio mag track, and 
assemble each take on a 
roll with ink numbers.

3. Screen the film 
dailies before telecine 
transfer.

4. Mount and transfer 
the rolls to tape in 
telecine.

5. (Option) Enter ink 
numbers manually into 
the Avid system after 
you capture, to match 
the ink number on the 
work print.

6. Generate ink-number 
lists for preparing cuts 
from the work print, 
and key-number lists 
for conforming the 
negative. Figure 10 Film Dailies Method

When you work with film dailies and work print, the advantages are: 

• You can screen the dailies immediately after the lab work.

• You can use work print previews to view the full film aspect ratios, 
resolutions, and contrast ranges. For this reason, film dailies are often 
preferred for feature film projects.

The disadvantage is that the magnetic track and work print require 
additional facilities, procedures, and costs.
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.....................

....................

....................

....................

Transfer

Conformed cut

(Step 5)

(Step 4)

(Step 6)
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cam
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Negative Work print
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Mag track KEM roll

Screening
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 Chapter 10 Planning a Film Project
Video Dailies Method

The video dailies method involves the procedures shown in Figure 11. 
Specifics, such as tape formats, vary depending on facilities and needs.

1. Prepare film negative 
for the circled 
(selected) takes.

2. Transfer reels of 
negative synced to 
audio in telecine. 
Generate a
simultaneous online 
transfer, or create the 
online transfer from 
selects after editing the 
sequence.

3. Screen the videotape 
dailies after the 
transfer.

4. Import existing key 
numbers and timecode 
information into the 
Avid system, then 
capture.

5. Edit using the Avid 
system.

6. Record a digital cut 
to preview the 
sequence with effects, 
or generate EDLs for 
editing the videotape 
transfers.

Alternatively, generate 
a matchback list of 
selects for printing 
selects and conforming 
negative.

Figure 11 Video Dailies Method
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Film Project Considerations
The advantage of working with video dailies and film negative is that you 
can avoid the cost of work print until the finishing stages, or altogether. 
The disadvantage is you are limited to the aspect ratio, resolution, and 
contrast range of video previews. For this reason, video dailies are 
preferred for television projects, but you can also use this method to 
economize on a feature film production.
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